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Preface
The curriculum and curricular materials have been developed and revised on a regular basis 
with the aim of making education objective-oriented, practical, relevant and job oriented. 
It is necessary to instill the feelings of nationalism, national integrity and democratic 
spirit in students and equip them with morality, discipline, self-reliance, creativity and 
thoughtfulness. It is essential to develop linguistic and mathematical skills, knowledge of 
science, information and communication technology, environment, health and population 
and life skills in students. It is also necessary to bring the feeling of preserving and promoting 
arts and aesthetics, humanistic norms, values and ideals. It has become the need of the 
present time to make them aware of respect for ethnicity, gender, disabilities, languages, 
religions, cultures, regional diversity, human rights and social values to make them 
capable of playing the role of responsible citizens with applied technical and vocational 
knowledge and skills. This learning resource material for Electrical engineering has been 
developed in line with the Secondary Level Electrical engineering Curriculum with an 
aim to facilitate the students in their study and learning on the subject by incorporating the 
recommendations and feedback obtained from various schools, workshops, seminars and 
interaction programs attended by teachers, students, parents and concerned stakeholders.

In bringing out the learning resource material in this form, the contribution of the Director 
General of CDC Mr. Yubaraj Paudel and members of the subject committee Dr. Nandabikram 
Adhikari, Er. Chitra Bahadur Khadka, Mr. Damberdhwaj Angdembe, Er. Sanju Shrestha 
is highly acknowledged. This learning resource material is compiled and prepared by  
Er. Rupesh Maharjan, Er. Jaya Prakash Maharjan, Er. Uddav Giri. The subject matter of 
this material is edited by Mr. Badrinath Timsina and Mr. Khilanath Dhamala. Similarly, the 
language is edited by Mr. Bijay Kumar Ranabhat. CDC extends sincere thanks to all those 
who have contributed to developing this material in this form.

This learning resource material contains a wide coverage of subject matters and sample 
exercises which will help the learners to achieve the competencies and learning outcomes 
set in the curriculum. Each chapter in the material clearly and concisely deals with the 
subject matters required for the accomplishment of the learning outcomes. The Curriculum 
Development Centre always welcomes creative and constructive feedback for the further 
improvement of the material.

2082 BS	 Curriculum Development Centre
	 Sanothimi, Bhaktapur
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Guidelines to Teachers

A.	 Facilitation Methods

The goal of this course is to combine the theoretical and practical aspects of the contents 
needed for the subject. The nature of contents included in this course demands the use 
of practical or learner focused facilitation processes. Therefore, the practical side of the 
facilitation process has been focused much. The instructor is expected to design and conduct 
a variety of practical methods, strategies or techniques which encourage students engage 
in the process of reflection, sharing, collaboration, exploration and innovation new ideas or 
learning.  For this, the following teaching methods, strategies or techniques are suggested 
to adopt as per the course content nature and context.  

Brainstorming

Brainstorming is a technique of teaching which is creative thinking process. In this 
technique, students freely speak or share their ideas on a given topic. The instructor does 
not judge students’ ideas as being right or wrong, but rather encourages them to think and 
speak creatively and innovatively. In brainstorming time, the instructor expects students 
to generate their tentative and rough ideas on a given topic which are not judgmental. 
It is, therefore, brainstorming is free-wheeling, non-judgmental and unstructured in 
nature. Students or participants are encouraged to freely express their ideas throughout 
the brainstorming time. Whiteboard and other visual aids can be used to help organize the 
ideas as they are developed. Following the brainstorming session, concepts are examined 
and ranked in order of importance, opening the door for more development and execution. 
Brainstorming is an effective technique for problem-solving, invention, and decision-
making because it taps into the group's combined knowledge and creative ideas.

Demonstration

Demonstration is a practical method of teaching in which the instructor shows or demonstrates 
the actions, materials, or processes. While demonstrating something the students in the 
class see, observe, discuss and share ideas on a given topic. Most importantly, abstract 
and complicated concepts can be presented into visible form through demonstration. 
Visualization bridges the gap between abstract ideas and concrete manifestations by 
utilizing the innate human ability to think visually. This enables students to make better 
decisions, develop their creative potential, and obtain deeper insights across a variety of 
subject areas. 
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Peer Discussion

Peer conversation is a cooperative process where students converse with their peers to 
exchange viewpoints, share ideas, and jointly investigate subjects that are relevant or of 
mutual interest. Peer discussion is an effective teaching strategy used in the classroom to 
encourage critical thinking, active learning, and knowledge development. Peer discussions 
encourage students to express their ideas clearly, listen to opposing points of view, and 
participate in debate or dialogue, all of which contribute to a deeper comprehension and 
memory of the course material. Peer discussions also help participants develop critical 
communication and teamwork skills by teaching them how to effectively articulate their 
views, persuasively defend their positions, and constructively respond to criticism. 

Peer conversation is essential for professional growth and community building outside 
of the classroom because it allows practitioners to share best practices, work together, 
and solve problems as a group. In addition to expanding their knowledge horizon and 
deepening their understanding, peer discussions help students build lasting relationships 
and a feeling of community within their peer networks.

Group Work

Group work is a technique of teaching where more than two students or participants work 
together to complete a task, solve a problem or discuss on a given topic collaboratively. 
Group work is also a cooperative working process where students join and share their 
perspectives, abilities, and knowledge to take on challenging job or project. Group work 
in academic contexts promotes active learning, peer teaching, and the development of 
collaboration and communication skills. Group work helps individuals to do more together 
than they might individually do or achieve.

Gallery Walk 

Gallery walk is a critical thinking strategy. It creates interactive learning environment in 
the classroom. It offers participants or students a structured way to observe exhibition 
or presentation and also provides opportunity to share ideas. It promotes peer-to-peer 
or group-to-group engagement by encouraging participants to observe, evaluate and 
comment on each other’s work or ideas. Students who engage in this process improve their 
communication and critical thinking abilities in addition to their comprehension of the 
subject matter, which leads to a deeper and more sophisticated investigation of the subjects 
at hand.
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Interaction

The dynamic sharing of ideas, knowledge, and experiences between people or things is 
referred to as interaction, and it frequently takes place in social, academic, or professional 
settings. It includes a broad range of activities such as dialogue, collaboration or team 
work, negotiation, problem solving, etc.  Mutual understanding, knowledge sharing, and 
interpersonal relationships are all facilitated by effective interaction. Interaction is essential 
for building relationships, encouraging learning, and stimulating creativity in both in-
person and virtual contexts. Students can broaden their viewpoints, hone their abilities, and 
jointly achieve solutions to difficult problems by actively interacting with others.

Project Work

Project work is a special kind of work that consists of a problematic situation which 
requires systematic investigation to explore innovative ideas and solutions. Project work 
can be used in two senses. First, it is a method of teaching in regular class. The next is: it is 
a research work that requires planned investigation to explore something new. This concept 
can be presented in the following figure.

Project work

Method of teaching Research based work

Project work entails individuals or teams working together to achieve particular educational 
objectives. It consists of a number of organized tasks, activities, and deliverables. The end 
product is important for project work. Generally, project work will be carried out in three 
stages. They are:

•	 Planning

•	 Investigation

•	 Reporting

B.	 Instructional Materials 

Instructional materials are the tools and resources that teachers use to help students. 
These resources/materials engage students, strengthen learning, and improve conceptual 
comprehension while supporting the educational goals of a course or program. Different 
learning styles and preferences can be accommodated by the variety of instructional 
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resources available. Here are a few examples of typical educational resource types:

•	 Daily used materials

•	 Related Pictures

•	 Reference books

•	 Slides and presentation: PowerPoint slides, keynote presentations, or other 
visual aids that help convey information in a visually appealing and organized 
manner.

•	 Audiovisual materials: Videos, animations, podcasts, and other multimedia 
resources that bring concepts to life and cater to auditory and visual learners.

•	 Online Resources: Websites, online articles, e-books, and other web-based 
materials that can be accessed for further reading and research.

Maps, charts, and graphs: Visual representations that help learners understand 
relationships, patterns, and trends in different subjects.

Real-life examples and Case Studies: Stories, examples, or case studies that illustrate the 
practical application of theoretical concepts and principles.

C.	 Assessment

Formative Test

Classroom discussions: Engage students in discussions to assess their understanding of 
concepts.

Quizzes and polls: Use short quizzes or polls to check comprehension during or after a 
lesson.
Homework exercises: Assign tasks that provide ongoing feedback on individual progress.
Peer review: Have students review and provide feedback on each other's work.

Summative Test

Exams: Conduct comprehensive exams at the end of a unit or semester.

Final Projects: Assign projects that demonstrate overall understanding of the subject.

Peer Assessment

Group projects: Evaluate individual contributions within a group project.

Peer feedback forms: Provide structured forms for students to assess their peers.

Classroom Presentations: Have students assess each other's presentations.
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Objective Test

Multiple-choice tests: Use multiple-choice questions to assess knowledge.

True/False questions: Assess factual understanding with true/false questions.

Matching exercises: Evaluate associations between concepts or terms.

Portfolio Assessment

Compilation of work: Collect and assess a variety of student work samples.

Reflection statements: Ask students to write reflective statements about their work.

Showcase events: Organize events where students present their portfolios to peers or 
instructors.

Observational Assessment

Classroom observations: Observe students' behavior and engagement during class.

Performance observations: Assess practical skills through direct observation.

Field Trips: Evaluate students' ability to apply knowledge in real-world settings.
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1.1	 The Concept of Computer
Today’s world is an information-rich world and it has become a necessity for 
everyone to know about computers. Computer is an advanced electronic device that 
takes raw data as an input from the user and processes it under the control of a set 
of instructions (called program), produces a result (output), and saves it for future 
use. This unit explains the foundational concepts of computer hardware, software, 
operating systems, peripherals, etc. along with how to get the most value and impact 
from computer technology.

A computer is an electronic data processing device, that accepts and stores data input, 
processes the data input, and generates the output in a required format.

Personal Computer

Introduction to Computer Unit 1
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If we look at it in a very broad sense, any digital computer carries out the following five 
functions −

Step 1 − Takes data as input.

Step 2 − Stores the data/instructions in its memory and uses them as required.

Step 3 − Processes the data and converts it into useful information.

Step 4 − Generates the output.

Step 5 − Controls all four steps mentioned above.

Computer processing
1.2	 History of Computers

If we see the computer from the past to present, we can see that they don’t have 
similar technology, shape, size, functionality etc. So, the present computer that we 
use differs from the past computer. The origin of computer starts from counting. A 
short description about the development process of computer is described below:

1.	 Abacus

Many centuries ago when men started to count the numbers, they thought of a device 
which can trace the numbers and thus, came the existence of Abacus. It was the 
first counting device which was developed in China more than 3000 years ago. The 
name Abacus was obtained from Greek word Abax which means slab. This device 
basically consists of a rectangular wooden frame and beads. The frame is divided 
into two parts and beam separates these parts. The upper part is called heaven and 
the lower part is called earth.

Abacus
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The frame contains horizontal rods and the beads which have holes are passed 
through the rods. Counting was done by moving the beads from one end of the frame 
to the other.

2.	 Napier’s Bones

It is a device which contains a set of rods made of bones. It was developed by John 
Napier in 1617 A.D., a Scottish Mathematician and hence the device was named as 
Napier’s bones. The device was mainly developed for performing multiplication and 
division. In 1614 A.D., he also introduced logarithms.

Napier’s bones

3.	 Slide Rule

Slide Rule was an analog device invented by William Oughtred in 1620. The slide 
rule is used mainly for multiplication and division, and also for "scientific" functions 
such as roots, logarithms and trigonometry, but usually not for addition or subtraction. 
The slide rule is based on the work on logarithm. A simple slide rule consists of two 
movable marked scales in which one scale slips upon the other.

Slide Rule
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4.	 Pascaline

Pascaline is a calculating machine developed by Blaise Pascal in 1642, a French 
mathematician. It was the first device with an ability to perform additions and 
subtractions on whole numbers. The device is made up of interlocked cog wheels 
which contains numbers 0 to 9 on its circumference. When one wheel completes its 
rotation the other wheel moves by one segment. Pascal patented this device in 1647 
and produced it on mass scale and earned a handful of money.

Pascaline

5.	 Stepped Reckoner

Stepped reckoner a calculating machine designed (1671) and built (1673) by the 
German mathematician-philosopher Gottfried Wilhelm von Leibniz. The Stepped 
Reckoner expanded on the French mathematician-philosopher Blaise Pascal’s ideas 
and did multiplication by repeated addition and shifting. It was the first calculator 
that could perform- addition, subtraction, multiplication and division. Even square 
roots could be calculated by a series of stepped additions.

Stepped Reckoner

6. 	 Jacquard’s Loom

Jacquard's loom was invented by Joseph Jacquard and first demonstrated in 1801. 
This device is an attachment for powered looms that uses a chain of punch cards to 



Computer Application/Grade 9
5

instruct the loom on how to make intricate textiles. For example, a loom could have 
hundreds of cards with holes in each of them that correspond to hooks that can be 
raised or lowered to make a textile brocade. Below is an illustration of the Jacquard 
Loom attachment on top of a textile loom.

Jacquard's Loom

7.	 Charles Babbage and His Engines

Charles Babbage was born on December 26, 1791 in London, England. He designed 
the first mechanical computer, which he called the "Difference Engine" a machine 
that could solve polynomial equations without using multiplication or division. He 
began developing the machine in 1822, and worked on it for over ten years, but its 
construction was never completed.

	He also invented and developed his analytical engine in the late 1833. This was 
the first general purpose fully programmable mechanical machine. This device 
could perform complex calculations and store the result.

	This analytical engine was based on input, process and output principle. The 
modern computers are based on Babbage's idea and principle. Therefore, Charles 
Babbage is also known as the father of modern computer science.
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	 Analytical Engine	 Difference Engines

8.	 Lady Augusta Ada Lovelace

Lady Augusta Ada Lovelace was an English writer as well daughter of famous 
English poet Lord Byron. She suggested Charsles Babbage to use binary number 
system for programs and data to be fed into the analytical engine. That was the first 
programming concept. So, she is regarded as the world's first computer programmer. 
In 1979, the US Department of Defense developed a programming language and 
named 'ADA' in her honour.

Lady Ada
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9.	 Tabulating Machine

The Hollerith tabulating machine, also known as the tabulating machine, was an 
electrical counting machine invented by Herman Hollerith. It was first described in 
his doctoral thesis, which he presented at Columbia University in 1889. The machine 
was proof of his concept that data could be encoded by holes punched in a card and 
thereby counted and sorted electronically. It was successful, and Hollerith developed 
a tabulating machine company, which later merged to become a company called 
IBM.

Tabulating Machine
10.	 Mark I

Mark I is a programmable, electromechanical calculator designed by Professor 
Howard Aiken. Built by IBM and installed at Harvard in 1944, the Mark I's 765,000 
parts were used to string 78 adding machines together. It uses 18000 vacuum tubes 
to store data in the memory. The machine weighed 35 tones, 500 miles of wire, 8 feet 
tall and 51 feet long.

Electromechanical Computer (Devices) 

Mark I 

Mark I was designed 
by a Harvard graduate 
student, Howard H. 
Aiken in 1937 to solve 
advanced 
mathematical physics 
problems encountered 
in his research. 

The IBM Automatic 
Sequence Controlled 
Calculator (ASCC), 

Mark I
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11.	 Atanasoff-Berry Computer

Atanasoff-Berry Computer (the ABC) is considered as the first electronic digital 
computer and was the first machine to use vacuum tubes (over 300 vacuum tubes). 
Professor John Vincent Atanasoff and graduate student Cliff Berry developed the 
ABC in 1937 and continued development until 1942 at the Iowa State College 
(now Iowa State University). On October 19, 1973, Judge Earl R. Larson signed his 
conclusion that the ENIAC, patent by Eckert and Mauchly was invalid and named 
Atanasoff the inventor of the first electronic digital computer.

Atanasoff-Berry Computer

12.	 Electronic Computers (Devices) ENIAC

Electronic Numerical Integrator and Calculator, (the ENIAC) was the first electronic 
computer used for general purposes, such as solving numerical problems. It was 
invented by J. Presper Eckert and John Mauchly at the University of Pennsylvania 
to calculate artillery firing tables for the United States Army's Ballistic Research 
Laboratory. Its construction began in 1943 and was not completed until 1946. 
Although it was not completed until the end of World War II, the ENIAC was created 
to help with the war effort against German forces.In 1956, the end of its operation, 
the (ENIAC) occupied about 1,800 square feet and consisted of almost 20,000 
vacuum tubes, 1,500 relays, 10,000 capacitors, and 70,000 resistors. It also used 200 
kilowatts of electricity, weighed over 30 tons, and cost about $487,000.
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ENIAC

13.	 Electrical Delay Storage Automatic Calculator (EDSAC) 

Electronic Delay Storage Automatic Calculator (EDSAC) is an early British computer 
considered to be the first stored program electronic computer. It was created at the 
University of Cambridge in England, performed its first calculation on May 6, 1949, 
and was the computer that ran the first graphical computer game, nicknamed "Baby." 
In the picture to the right, is an example of the EDSAC computer.

The picture given below is an example of the EDSAC simulator that can be run on 
today's computers. The simulator simulates the EDSAC computer as it existed in 
between 1949-1951.

EDSAC 
Electronic Delay Storage Automatic Calculator (EDSAC) is an early British 
computer considered to be the first stored program electronic computer. It was 
created at the University of Cambridge in England, performed its first calculation 
on May 6, 1949, and was the computer that ran the first graphical computer game, 
nicknamed "Baby." In the picture to the right, is an example of the EDSAC 
computer. 

In the picture below, is an 
example of the EDSAC simulator 
that can be run on today's 
computers. The simulator 
simulates the EDSAC computer 
as it existed between 1949-1951. 

EDSAC

14.	 Universal Automatic Computer (UNIVAC I)

Universal automatic computer, the UNIVAC I was released in 1951 and 1952 
when first developed by J. Presper Eckert and John Mauchly. The UNIVAC is an 
electrical computer containing thousands of vacuum tubes that utilizes punch cards 
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and switches for inputting data and punch cards for outputting and storing data. The 
UNIVAC was later released the UNIVAC II, and III with various models, such as the 
418, 490, 491, 1100, 1101, 1102, 1103, 1104, 1105, 1106, 1107, and 1108.

Many of these models were only owned by a few companies or government agencies. 
The picture below given is an example of the UNIVAC computer. As seen in the 
picture, this is a room-sized computer and often required multiple people to operate.

UNIVAC I 
Universal Automatic Computer, the UNIVAC I was released in 1951 and 1952 
when first developed by J. Presper Eckert and John Mauchly. The UNIVAC is an 
electrical computer containing thousands of vacuum tubes that utilizes punch cards 
and switches for inputting data and punch cards for outputting and storing data. The 
UNIVAC was later released the UNIVAC II, and III with various models, such as 
the 418, 490, 491, 1100, 1101, 1102, 1103, 1104, 1105, 1106, 1107, and 1108. 
Many of these models were only owned by a few companies or government 
agencies. 

In the below picture is an example of the UNIVAC computer. As can be seen in the 
picture, this is a room-sized computer and often required multiple people to operate. 

An example of the UNIVAC computer

1.2.1	History of Computer in Nepal
Computer is called Susaankhya in Nepali language. There is not a long history of 
computer in Nepal. Nepal hired some types of calculators and computers for its 
census calculation. Following list shows the  history of computer in Nepal.

1)	 1961 AD (2018 BS) – “Facit” was used for census calculation. It was an electronic 
calculator, not a computer.

2)	 1971 AD (2028 BS) – “IBM 1401, a second-generation computer” was used for 
census calculation on rent for Rs. 1 lakhs and 25 thousand per month to process 
census data.

3)	 In 2031 BS- Yantrik Sarinikaran Kendra (Electronic Data Processing Centre) 
was established which was later called as National Computer Centre ( NCC ).

4)	 2038 BS- ICL 2950/10  a second generation mainframe computer having 64 
terminals was brought in Nepal by the aid of UNDP and UNFPA from England 
for 20 lakhs US dollars. Now, It is kept in Museum of NCC, Singhdurbar

5)	 2039 B.S.- Microcomputer like; Apple, Vector, Sirius were introduced in the 
capital by private companies and individuals. From that time computers have 
been used in different government sectors like banking, agriculture, universities 
etc.

6)	 1995 AD – Internet service limiting Email facility in Nepal was initiated by private 
sector company, Mercantile Communications.  Mercantile Communications 
stands first to start the Internet in Nepal.
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7)	 Father of Nepali Software incl. Nepali Fonts – Muni Shakya.

8)	 1997 AD – Telecommunications Act 1997 was issued.

9)	 1998 AD – On the basis of the Telecommunications Act 1997, Nepal 
Telecommunications Authority (NTA) – a telecommunication regulatory body 
was formed.

10)	2000 AD (2057 BS) – First IT Policy was formulated with a vision of positioning 
Nepal on global IT map within the next 5 years, which has adopted a 15-point 
strategic framework.

11)	IT Policy 2057 was reviewed in 2067 BS and again reviewed as ICT Policy in 
2072 BS.

12)	Electronic Transaction Act 2063 and Electronic Transaction Rules 2064 are 
issued.

13)	Computer Association of Nepal (CAN) was formed in May 1992 but was 
formally registered in December 1992. And later it was registered as Federation 
of Computer Association Nepal (CAN Federation) in January 2015.

1.3	 The Characteristics of Computer System
 High Speed

	Computer is a very fast device.

	It is capable of performing calculation of very large amount of data in a short 
time.

	The computer has units of speed in microsecond, nanosecond, and even the 
picosecond.

	It can perform millions of calculations in a few seconds as compared to man/
woman who will spend many months to perform the same task.

Accuracy

	In addition to being very fast, computers are very accurate.

	The calculations are 100% error free.

	Computers perform all jobs with 100% accuracy if the input is correct.

Storage Capability

	 Memory is a very important characteristic of computers.

	 A computer has much more storage capacity than human beings.
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	 It can store large amount of data.

	 It can store any type of data such as images, videos, text, audio, etc.

Diligence

	Unlike human beings, a computer is free from monotony, tiredness, and lack of 
concentration.

	It can work continuously without any error and boredom.

	It can perform repeated tasks with the same speed and accuracy.

Versatility

	A computer is a very versatile machine.

	It is very flexible in performing the jobs to be done.

	This machine can be used to solve the problems related to various fields.

	At one instance, it may be solving a complex scientific problem and the very 
next moment it may be playing a card game.

Reliability

	A computer is a reliable machine.

	Modern electronic components have long lives.

	Computers are designed to make maintenance easy.

Automation

	Computer is an automatic machine.

	Automation is the ability to perform a given task automatically. Once the 
computer receives a program i.e., the program is stored in the computer memory, 
then the program and instruction can control the program execution without 
human interaction.

Reduction in Paper Work and Cost

	The use of computers for data processing in an organization leads to reduction in 
paper work and results in speeding up the process.

	As data in electronic files can be retrieved as and when required, the problem of 
maintenance of large number of paper files gets reduced.

	Though the initial investment for installing a computer is high, it substantially 
reduces the cost of each of its transaction.
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1.4	 The Capabilities and Limitation of Computers
Computer - Applications

The application of computers in various fields are given below:

1.	 Business
	 A computer has high speed of calculation, diligence, accuracy, reliability, 

or versatility. It is an integrated part in all business organizations. It is used 
in business organizations for payroll calculations, budgeting, sales analysis, 
financial forecasting, managing employee database, maintenance of stocks, etc.

2.	 Banking

	 Today, banking is almost totally dependent on computers.

	 Banks provide the following facilities with the help of computers.

	Online accounting facility, which includes checking current balance, making 
deposits and overdrafts, checking interest charges, shares, and trustee record.

	ATM machines which are completely automated are making it even easier for 
customers to deal with banks.

3.	 Insurance

	 Insurance companies are keeping all records up-to-date with the help of 
computers. Insurance companies, finance houses, and stock broking firms are 
widely using computers for their concerns. Insurance companies are maintaining 
a database of all clients with information showing procedure to continue with 
policies, starting date of the policies, next due installment of a policy, maturity 
date, interests due, survival benefits, bonus, etc.

4.	 Education 

	 The computer helps in providing a lot of facilities in the education system.

	The computer provides a tool in education system known as Computer Based 
Education (CBE).

	CBE involves control, delivery, and evaluation of learning.

	There are a number of methods in which educational institutions can use a 
computer to educate students. ICT based classes are being more effective in 
learning process. 

	It is used to prepare a database about the performance of a student and analysis 
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is carried out on this basis.

5.	 Marketing

	 In marketing, uses of the computer are following –

	Advertising − With computers, advertising professionals create art and graphics, 
write and revise copy, and print and disseminate ads with the goal of selling more 
products.

	Home Shopping − Home shopping has been made possible through the use of 
computerized catalogues that provide access to product information and permit 
direct entry of orders to be filled by the customers.

6.	 Healthcare

	 Computers have become an important part in hospitals, labs, and dispensaries. 
They are being used in hospitals to keep the record of patients and medicines. It is 
also used in scanning and diagnosing different diseases. ECG, EEG, ultrasounds 
and CT scans, etc. are also done by computerized machines.

	 Following are some major fields of health care in which computers are used.

(i)	 Diagnostic System,

(ii)	Lab-diagnostic System,

(iii)	Patient Monitoring System, and

(iv)	Pharma Information System, Surgery etc.

7.	 Engineering Design

	 Computers are widely used for engineering purpose. One of the major areas 
is computer aided design  (CAD) that provides creation and modification of 
images. Some of the fields are structural engineering, industrial engineering, 
architectural engineering, etc.

8.	 Military

	 Computers are largely used in defense. Military also employs computerized 
control systems. Some military areas where a computer has been used are 
missile control, military communication, military operation and planning, smart 
weapons, etc.

9.	 Communication

	 Communication is to convey a message, an idea, a picture, or speech that is 
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received and understood clearly and correctly by the person for whom it is 
meant. Some main areas in this category are e-mail, chatting, usenet, FTP, telnet, 
video- conferencing, etc.

10.	Government

	 Computers play an important role in government services. Some major 
fields in this category are budgets, sales tax department, and income tax 
department, computation of male/female ratio, computerization of voter’s lists, 
computerization of PAN card, and weather forecasting, etc.

Limitation of Computers

There is no sector in this world that has not  advantaged from the usage of the 
computer. Computers are used in every sector of the world; from big IT firms to even 
the agricultural industry. There is no place where the benefits of the computer have not 
been reached. And they truly have outperformed humans in terms of speed, reliability, 
versatility, and the capacity to store and work day and night without getting tired. 
However, there are a few milestones that computers have yet to achieve. There are still 
some areas where humans outperform computers. Somewhere in the near future computers 
might overcome these limitations. But as of now, human work is still irreplaceable, so let 
us discuss a few such limitations of computers.

Following are certain limitations of computers.

	A computer is a machine that has no intelligence to perform any task

	Each instruction has to be given to the computer

	A computer cannot take any decision on its own

	Computers have no feelings or emotions.

However, there has been a lot of researches going on to overcome the limitations of 
computers. For example, there is extensive research going on artificial intelligence. There 
will be a time in the future when computers will possess human virtues but as of now, 
human work is irreplaceable.

1.5	 Types of Computer
There are different types of computer having different features. Computers differ 
based on their data processing abilities. They are classified according to purpose, 
data handling and functionality.
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According to purpose, computers are either general purpose or specific purpose.

a.	 Special Purpose Computers

b.	 General Purpose Computers

a.	 Special Purpose Computers

A special purpose computer is designed only to meet the requirements of a particular 
task or application. The instructions needed to perform a particular task are 
permanently stored into the internal memory, so that it can perform the given task 
on a single command. It therefore doesn’t possess unnecessary options and is less 
expensive.

b.	 General Purpose Computers

The general purpose computers are designed to meet the needs of many different 
applications. In these computers, the instructions needed to perform a particular task 
are wired permanently into the internal memory. When one job is over, instructions 
for another job can be loaded into the internal memory for processing.

This, a general purpose machine can be used to prepare pay-bills, manage inventories, 
print sales report and so on.

Based on the operating principles, computers can be classified into the following 
types :

a.	 Analog Computers

b.	 Digital Computers

c.	 Hybrid Computers

a.	 Analog Computers

An analog computer is a form of computer that uses the continuously changeable 
aspects of physical phenomena such as electrical, mechanical, or hydraulic quantities 
to model problem being solved. In contrast, digital computers represent varying 
quantities symbolically, as their numerical values change.

b.	 Digital Computers

Digital computers operate essentially by counting. All quantities are expressed 
as discrete or numbers. Digital computers are useful for evaluating arithmetic 
expressions and manipulations of data (such as preparation of bills, ledgers, solution 
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of simultaneous equations, etc.)

c.	 Hybrid Computers

Hybrid   computers   are   computers   that   exhibit   features   of analog computers 
and digital computers. The digital component normally serves as the controller and 
provides logical operations, while the analog component normally serves as a solver 
of differential equations.

Classification of Digital Computer based on Size and Capability

Based on size and capability, computers are broadly classified into following types.

a.	 Microcomputers (Personal Computer)

A microcomputer is the smallest general purpose processing system. Microcomputer 
can be classified into 2 types:

1.	 Desktops

2.	 Portables

The difference between desktops and portables is that portables can be used while 
travelling whereas desktops computers cannot be carried around. A portable computer 
is a computer that can be moved from one place to another.

The different portable computers are:

1.	 Laptop

2.	 Notebooks

3.	 Palmtop (hand held)

4.	 Wearable computers

a.	 Minicomputer

A minicomputer is a medium-sized computer. That is more powerful than a 
microcomputer. These computers are usually designed to serve multiple users 
simultaneously (Parallel Processing). They are more expensive than microcomputers.

Example: Digital Alpha, Sun Ultra.

b.	 Mainframe Computers

Computers with large storage capacities and very high speed of processing 
(compared to mini- or microcomputers) are known as mainframe computers. They 
support a large number of terminals for simultaneous use by a number of users like 



Computer Application/Grade 9
18

ATM transactions. They are also used as central host computers in distributed data 
processing system. Example: IBM 370, S/390.

c.	 Supercomputer

Supercomputers which have extremely large storage capacity and computing speeds 
are many times faster than other computers. A supercomputer is measured in terms of 
tens of millions instructions per second (mips), an operation is made up of numerous 
instructions. The supercomputer is mainly used for large scale numerical problems 
in scientific and engineering disciplines such as weather analysis. Examples: -  IBM 
Deep Blue

1.6	 The Generations of Computers and their Features
Computer generation is the classification of computers into different groups 
according to their manufacturing date, other hardware and software technology used 
inside those computers.

There are five computer generations known till date. Each generation has been 
discussed in detail along with their time period and characteristics. In the following 
table, an approximate date against each generation has been mentioned, which are 
normally accepted.

Following are the main five generations of computers

1.	 First Generation Computer

The period of first generation was from 1945 to 1955. The computers of first 
generation used vacuum tubes as the basic components for memory and circuitry for 
central processing unit (CPU). These tubes, like electric bulbs, produced a lot of heat 
and the installations used to fuse frequently. Therefore, they were very expensive 
and only large organizations were able to afford it.The computers in this generation 
used machine code as the programming language.

The main features of the first generation are vacuum tube technology, unreliable, 
supported machine language only, very costly, generated a lot of heat, slow input and 
output devices, huge size, need of AC, non-portable, consumed a lot of electricity, 
etc.

Some computers of this generation were ENIAC, EDVAC, UNIVAC, IBM-701, 
IBM-650, etc.
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2.	 Second Generation Computer

The period of second generation was from 1956 to 1964. In this generation, transistors 
which were cheapter, less power consumer, more compact in size, more reliable, and 
faster than the first generation machines made of vacuum tubes were used. In this 
generation, magnetic cores were used as the primary memory and magnetic tape and 
magnetic disks as secondary storage devices. In this generation, assembly language 
and high-level programming languages like FORTRAN, COBOL were used. The 
computers used batch processing and multiprogramming operating system. The 
main features of second generation are; use of transistors, reliable in comparison to 
first generation computers, smaller size as compared to first generation computers, 
generated less heat as compared to first generation computers, consumed less 
electricity as compared to first generation computers, faster than first generation 
computers, still very costly, AC required, supported machine and assembly languages, 
etc.

Some computers of this generation were IBM 1620, IBM 7094, CDC 1604, CDC 
3600, UNIVAC 1108 etc.

3.	 Third Generation Computer

The period of third generation was from 1965 to 1971. The computers of third 
generation used Integrated Circuits (ICs) in place of transistors. A single IC has 
many transistors, resistors, and capacitors along with the associated circuitry.

The IC was invented by Jack Kilby. This development made computers smaller 
in size, reliable, and efficient. In this generation, remote processing, time-sharing, 
multiprogramming operating system were used. High-level languages (FORTRAN, 
COBOL, PASCAL, BASIC, etc.) were used during this generation. The main 
features of third generation are IC used, more reliable in comparison to previous two 
generations, smaller size, generated less heat, faster, lesser maintenance, supported 
high-level language etc.

Some computers of this generation were IBM-360 series, Honeywell-6000 series,  
personal data processor (PDP), IBM-370/168, TDC-316 etc.

4.	 Fourth Generation Computer

The period of fourth generation computer was from 1972 to 1980. Computers of 
fourth generation used very large scale integrated (VLSI) circuits. VLSI circuits on a 
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single chip made it possible to have microcomputers of fourth generation.

Fourth generation computers became more powerful, compact, reliable, and 
affordable. As a result, it gave rise to personal computer (PC) revolution. In this 
generation, time sharing, real time networks, distributed operating system were 
used. All the high-level languages like C, C++, DBASE etc., were used in this 
generation. The main features of fourth generation are VLSI technology used, very 
cheap, portable and reliable, use of PCs, very small size, pipeline processing, no 
AC required, concept of internet was introduced, great developments in the fields of 
networks, computers became easily available, etc.

Some computers of this generation were DEC 10, STAR 1000, PDP 11, CRAY-1 
(Super Computer), CRAY-X-MP (Super Computer) etc.

5.	 Fifth Generation Computer

The period of fifth generation is from 1980 onwards. In the fifth generation, VLSI 
technology became ultra large scale integration (ULSI) resulting in the production of 
microprocessor chips having ten million electronic components.

This generation computer is based on parallel processing hardware and artificial 
intelligence (AI) software. AI is an emerging branch in computer science, which 
interprets the means and method of making computers think like human beings. All 
the high-level languages like C and C++, Java, .Net etc., are used in this generation.

AI includes Robotics, neural networks, game playing, development of expert 
systems to make decisions in real-life situations, natural language understanding and 
generation etc.

The main features of fifth generation are ULSI technology, development of true 
artificial intelligence, development of natural language processing, advancement in 
parallel processing, advancement in superconductor technology, more user-friendly 
interfaces with multimedia features, availability of very powerful and compact 
computers at cheaper rates etc.

Some computer types of this generation are desktop, laptop, notebook, ultrabook, 
chrome book etc
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Generation of Computers

1.7	 The Types of PC/Es and their Characteristics
1.	 Desktop Computer (Personal Computer)

	 A personal computer (PC) can be defined as a small, relatively inexpensive 
computer designed for an individual user. PCs are based on the microprocessor 
technology that enables manufacturers to put an entire CPU on one chip. 
Personal computers are used in business sectors for word processing, 
accounting, desktop publishing, and for running spreadsheet and database 
management applications. At home, the most popular use for personal 
computers is playing games and surfing the Internet. The characteristics of 
desktop computer are as follows:

	 Computers used to be huge and would sometime take up the whole 
space of a room

	 These computers were cheap and affordable for the public

	 Desktop computer normally have a separate monitor, keyboard, mouse, 
speakers, etc.

	 Desktop computer an be used as a standalone computer in your home 
for personal or work use

	 Tends to be connected to own printer and internet connection.

2.	 Laptop

	 Laptop computers, also known as notebooks, are portable computers that you 
can take with you were as you like and use in different environments. They 
include a screen, keyboard, and a track pad or trackball, which serves as the 
mouse. Because laptops are meant to be used on the go, they have a battery 
which allows them to operate without being plugged into a power outlet.
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Laptop consists of all the components (monitor, keyboard, etc.) on a single device. 
The main advantages of laptop computers are portable and they can connect 
wirelessly to network connections.

Laptop

3.	 Notebook

A notebook computer is a battery - or AC-powered personal computer generally 
smaller than a briefcase that can easily be transported and conveniently used 
in temporary spaces such as on airplanes, in libraries, temporary offices, and at 
meetings. A notebook computer, sometimes called a laptop computer, typically 
weighs less than 5 pounds and is 3 inches or less in thickness. Among the best- 
known makers of notebook and laptop computers are IBM, Apple, Compaq, Dell, 
Toshiba, and Hewlett-Packard.

A serial port also allows a regular mouse to be attached. The PC Card is insertable 
hardware for adding a modem or network interface card to a notebook. CD- ROM 
and digital versatile disc drives may be built-in or attachable.

4.	 Palmtop

A palmtop computer is a personal computer or other electronic device that has many 
of the same features as a computer and fits in the palm of your hand. A good example 
of an early palmtop computer is the PalmPilot. Because of their size, early palmtop 
computers did not have a keyboard or a mouse and often relied on a pen that used 
Graffiti or something similar.

The term "palmtop computer" was an early term used when computers were big and 
cumbersome and small cell phones and even smartphones were not yet invented. 
Today, this term is rarely used to describe a computer that fits in your hand because 
of the invention of the smartphone.
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5.	 Workstations

Workstation is a computer used for engineering applications (CAD/CAM), desktop 
publishing, software development, and other such types of applications which 
require a moderate amount of computing power and relatively high quality graphics 
capabilities.

Workstations generally come with a large, high-resolution graphics screen, large 
amount of RAM, inbuilt network support, and a graphical user interface. Most 
workstations also have mass storage device such as a disk drive, but a special type of 
workstation, called diskless workstation, comes without a disk drive.

Common operating systems for workstations are UNIX and Windows NT. Like PC, 
workstations are also single-user computers but are typically linked together to form 
a local-area network although they can also be used as stand-alone systems.
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Exercise

Choose the correct answer from the given alternatives.
1.	 Which of the following is the first calculating device?

a. Abacus		  b. Napier’s Bone

c. Pascaline		  d. Stepped Reckoner

2.	 Who is father of the computers?

a. James Gosling        	 b. Dennis Ritchie

c. Charles Babbage 	 d. Bjarne Stroustrup

3.	 Which of the following is not a characteristic of a computer?

a. Versatility	 b. Accuracy	 c. Diligence	 d. I.Q.

4.	 Which is an example of first generation computer?

a. EDVAC	 b. EDSAC	 c. ENIAC	 d. UNIVAC

5.	 In which generation of computer operating system was used for the first time?

a. First generation		  b. second generation

c. third generation		  d. fourth Generation

6.	 When was pascaline invented?

a. 1617	 b. 1620	 c. 1642	 d. 1837

7.	 Which of the following is the first computer to use stored program concept?

a. UNIVAC		  b. ENIAC

c. EDSAC		  d. None of the above

8.	 Once you load the suitable program and provide required data, computer does not 
need human intervention. This feature of computer is known as......

a. Accuracy		  b. Reliability

c. Versatility		  d. Automatic

9.	 What is the date when Babbage conceived analytical engine?

a. 1642	 b. 1837	 c. 1880	 d. 1850
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10.	 Which type of computer is mostly used for automatic operations?

a. Remote	 b. hybrid	 c. analog	 d. digital

Write short answer to the following questions. 
1.	 Who was John Napier? Explain in brief about his invention. 

2.	 Why is Charles Babbage known as father of computer? Also describe his inventions. 

3.	 List any four features of computer.

4.	 Which was the first computer brought in Nepal?

5.	 Why is computer called a versatile machine? Describe with examples. 

6.	 Write the features of Mark-I.

7.	 List any two advantages of fourth generation computer.

8.	 How can you utilize the artificial intelligence tools and development for smoothing 
for academic activities? Explain with examples.  

Write long answer to the following questions.
1.	 Explain the history of computer in Nepal in your own words.

2.	 What is computer generation? Describe different generation of computer with 
technologies used in each generation.

3.	 How can you differentiate general purpose with special purpose computer with 
suitable examples?
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2.1	 Concept of Computer Organization
Computer organization refers to the way in which the components of a computer 
system are arranged and interconnected to perform computational tasks efficiently 
and effectively. It encompasses the architecture, design, and implementation of 
computer systems at various levels, from the hardware components to the software 
layers that interact with them. 

The computer along with various hardware units and software that makes the 
computer function and perform the different tasks is collectively known as computer 
system. 

Computer system covers some categories such as:

•	 Hardware

•	 Software

•	 Data or information

•	 People

•	 Procedure (data which the computer converts)

•	 User

•	 Communication

1.	 Hardware

Hardware refers to the part of computer. Hardware is observable and we can touch 
it. It refers to the physical devices of the computer. It consists of interconnected 
electronic equipment that controls everything the computer does. It includes input 
devices, output devices, processing devices and storage devices. Examples of 
hardware are keyboard, monitor, CPU, hard disk and RAM.

2.	 Software

Software is the term used to describe the instruction that tells the hardware, what 
and how to perform a task. Without software, the hardware is useless. Examples of 
software are Window 7, MS office, Internet explorer, etc.

Unit 2 Concept of Computer Organization
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3.	 Data/Information

The function of a computer system is to convert data into information. Data can be 
considered as the raw facts whether in a paper, electronic or the other form that is 
processed by the computer. In other words, data consist of the raw facts and figures 
that are processed to form information. Information is summarized or manipulated 
or processed data.

4.	 People

People constitute the most important parts of the computer system. People operate 
the computer hardware and create the computer software. They also follow a certain 
procedure when using the hardware and software.

5.	 Procedure

The procedure is a description of how things are done, step for accomplishing a result. 
Procedure for a computer system appears in documentation manual, also known as 
reference manual which contains instruction, rules, and guidelines to follow when 
using hardware and software. When you buy a microcomputer or software package, 
it comes with one or more documentation manuals.

6.	 Communication

When one computer system is set up to share data and information electronically 
with another computer system, communication becomes a system element. In other 
words, the manner on which the various individual system is connected by wires, 
cables, phone lines, microwave, Wi-Fi or satellite is an element of the total computer 
system.

2.2	 Types of Computer Hardware
The computer is a device that is operated upon information or data. It is an electronic 
device which accepts inputs data, stores the data, carries out arithmetic, logic 
operations and provides the outputs in the desired format. The computer receives 
data, processes it, produces output and stores it for further references. So, a computer 
should have at least four major components to perform these tasks. A block diagram 
of the basic computer organization has the following functional units.
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Central Processing Unit

a)	 Input Unit

An input unit is any peripheral unit or piece of hardware used to send data or control 
signals to a computer or information processing system. Input devices allow users 
to interact with computers by providing a means to input data, commands, and 
instructions for processing. These devices convert input data and instructions into 
a suitable binary form such as ASCII, which can be understood by the computer. 
Some examples of input devices are keyboard, mouse, touchpad, trackball, joystick, 
scanner, microphone, touch screen, etc.

Some of the major functions of input units are as follows:

•	 Input units accept data and instruction from the outside worlds.

•	 They convert these data and instruction into computer understandable from a 
binary form such as ASCII.

•	 They supply the converted data and instructions to the computer system for 
further processing.

b)	 Central Processing Unit (CPU)

CPU is the component that is actually responsible for interpreting and executing most 
of the commands from the computer hardware and software and also controlling the 
operation of all other components such as memory unit, input and output devices. It 
simply accepts binary data as input and processes data according to those instructions 
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and provides the result as output. It is the logic machine. So, its main function is to 
run the program by fetching instructions from the RAM, evaluating and executing 
them in sequence. In summary, the functions of CPU are as follow:

•	 Reading instruction from memory

•	 Communicating with all peripherals using the system bus

•	 Controlling the sequence of instructions

•	 Controlling the flow of data from one component to another component

•	 Performing the computing task specified in the program

The CPU has three components responsible for different function, these components 
are control units, arithmetic-logical unit (ALU) and Register.

Components of CPU
2.3	 Control Unit

The control unit provides the necessary timing and control signals to all the 
operations on the computer. It controls the flow of data between the CPU, memory 
and peripherals. It also controls the entire operation of a computer. It obtains the 
instructions from the program stored in the main memory, interprets the instructions 
and issues the signals which cause the other units of the system to execute them. 
So, it is considered as a central nervous system of a computer that provides status, 
control and timing signals necessary for the operation of other parts of CPU memory 
and I/O devices. The main functions of control units are given below:

•	 Control units perform the data processing operations with the aid of program 
prepared by the user and sends control signals to various parts of the computer 
system.
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•	 They give commands to transfer data from the input devices to the memory to an 
arithmetic logic unit.

•	 They also transfer the results from ALU to the memory and then to the output 
devices.

•	 They store a program in the memory.

•	 They fetche the required instruction from the main storage and decode each 
instruction; and hence execute them in sequence.

2.	 Arithmetic Logic Unit

This is the area of CPU where various computing functions are performed on data. 
The ALU performs arithmetic operations such as addition, subtraction, multiplication 
and division and logical operation such as comparisonW AND, OR and Exclusive 
OR. The result of an operation is stored in Accumulator or in some register. The main 
functions of ALU are as follow:

•	 Arithmetic Logic Unit accepts operands from registers.

•	 It performs arithmetic and logic operations.

•	 It returns a result to register or a memory.

The logical operations of ALU give the computer the decision-making ability.

3.	 Registers

Registers are the high-speed temporary storage locations in the CPU made from 
electronic devices such as transistors, flip-flops, etc. So, registers can be thought as 
CPU’s working memory. Register are primarily used to store data temporarily during 
the execution of a program and are accessible to the user through instructions. These 
are the part of Control unit and ALU rather than of memory

Some major features of registers are:

•	 Storage of data that is immediately needed for the execution of

•	 Registers play a crucial role in arithmetic and logic operations

•	 During the execution of a computer program, instructions are fetched from 
memory and temporarily stored in registers before being processed by the CPU

•	 Registers are faster than other types of memory because they are located directly 
on the CPU chip

•	 Registers typically have limited capacity due to their high-speed nature. 
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4.	 Output Unit

The output unit is formed by the output devices attached to the computer. Output 
devices are used to present result produced by the computer to the users. The output 
from the computer is in the form of electric signals, which is then converted into 
human understandable form into human readable form.

The examples of output devices are the monitor, printer and speaker. The main 
functions of the output unit are as follow:

•	 Output unit accepts the result produced by the computer which is in electric 
binary signals.

•	 It then converts the result into human readable form.

•	 Finally, it supplies the converted results to the outside word.

2.4	 Memory and Storage Devices
Memory Unit

Memory unit is also called storage unit. The data and instructions which are entered 
through an input unit must be stored on the computer before the actual processing 
starts. The result produces by the computer after processing is also kept somewhere 
before passing to the output units. If intermediate results are produced during 
processing, it should be stored in somewhere in memory. The storage unit of a 
computer performs all these needs. In brief, the specific functions performed by the 
memory unit are as follow:

•	 Memory unit stores data and instructions, which are entered through input devices

•	 It stores an intermediate result of processing

•	 It stores the final result of processing before the results passed to output device

The storage unit of computers consists of two types of memory or storage: 1. primary, 
and 2. secondary storage

Computer Memory
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i.	  Primary Memory

Memory storage that communicates directly with CPU is called primary memory. It 
enables the computer to store, at least temporarily data and instruction. It is mainly 
used to hold data and instructions and as well as the intermediate result of processing 
which the computer system is currently working on. Primary memory is volatile, 
that is, it loses its content when power supply is off. There are two types of primary 
memory. They are RAM and ROM.

1.	 Random Access Memory (RAM)

•	 Random access memory is also called as read write memory or the main memory 
or the primary memory.

•	 The programs and data that the CPU requires during execution of a program are 
stored in this memory.

•	 It is a volatile memory as the data loses when the power is turned off.

•	 RAM is further classified into two types- SRAM (Static Random Access 
Memory) and DRAM (Dynamic Random Access Memory).

2.	 Read Only Memory (ROM)

The functions of ROM are given below;

•	 Read only memory stores crucial information essential to operate the system, 
like the program essential to boot the computer.

•	 It is not volatile.

•	 It is used in embedded systems or where the programming needs no change.

•	 It is used in calculators and peripheral devices.

•	 ROM is further classified into- ROM, PROM, EPROM, and EEPROM.

Types of Read Only Memory (ROM)

1.	 Programmable read-only memory (PROM) – It can be programmed by user. 
Once programmed, the data and instructions in it cannot be changed.

2.	 Erasable programmable read only memory (EPROM) – It can be reprogrammed. 
To erase data from it, expose it to ultra violet light. To reprogram it, erase all the 
previous data.

3.	 Electrically erasable programmable read only memory (EEPROM) – The data 
can be erased by applying electric field, no need of ultra violet light. We can erase 
only portions of the chip.
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Difference between RAM and ROM

RAM ROM

1.	 Temporary Storage 1.	 Permanent storage

2.	 Store data in MBs 2.	 Store data in GBs

3.	 Volatile 3.	 Non-volatile

4.	 Used in normal operations 4.	 Used for startup rocess of computer

5.	 Writing data is faster 5.	 Writing data is slower

Cache Memory

Cache memory is a small-sized type of volatile computer memory that provides high-speed 
data access to a processor and stores frequently used computer programs, applications and 
data. Cache memory is a very high speed memory that is placed between the CPU and main 
memory, to operate at the speed of the CPU. It is used to reduce the average time to access 
data from the main memory. The cache is a smaller and faster memory which stores copies 
of the data from frequently used main memory locations.

ii.	 Secondary Storage 

Auxiliary storage is also known as secondary storage. It is the memory that 
supplements the main memory. These are a non-volatile memory. It is mainly used 
to transfer data to program from one computer to another computer. There are high 
capacity storage devices used to store data and program permanently. These are also 
used as backup devices which allow to store the valuable information as backup on 
which you are working on. The examples of secondary memory are magnetic tape, 
magnetic disk, optical disk, etc.

Comparison between Primary and Secondary Memory
Comparison 
Parameters

Primary Memory Secondary Memory

Storage validity Primary memory is the main 
memory and stores data 
temporarily.

Secondary memory is the 
external memory and stores data 
permanently.

Access The CPU can directly access the 
data.

The CPU cannot directly access the 
data.
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Volatility Primary memory is volatile. It 
loses data in case of a power 
outage.

Secondary memory is non-volatile; 
data is stored even during a power 
failure.

Storage  Data is stored inside costly 
semiconductor chips.

Data is stored on external hardware 
devices like hard drives, floppy 
disks, etc.

Division It can be divided into RAM and 
ROM 

They do not have such a 
classification. Secondary memories 
are permanent storage devices like 
CDs, DVDs, etc.

Speed Faster  Slower
Stored data It saves the data that the computer 

is currently using.
It can save various types of data in 
various formats and huge sizes.

2.5	 Various types of Secondary Storage Devices
1.	 Magnetic Tape

Magnetic tape is a type of physical storage media for different kinds of data. It is 
considered an analog solution, in contrast to more recent types of storage media, 
such as solid state disk (SSD) drives. Magnetic tape has been a major vehicle for 
audio and binary data storage for several decades, and is still part of data storage 
for some systems. Magnetic tape was used in many of the larger and less complex 
mainframe computers that predated today’s personal computers (PC).

2.	 Magnetic Storage Devices

Magnetic storage or magnetic recording is the storage of data on a magnetized 
medium. Magnetic storage uses different patterns of magnetization in a magnet 
stable material to store data and is a form of non-volatile memory. The information 
is accessed using one or more read/write heads.

3.	 Floppy Disks

A floppy disk, also called a floppy, diskette, or just disk, is a type of disk storage 
composed of a disk of thin and flexible magnetic storage medium, sealed in a 
rectangular plastic enclosure lined with fabric that removes dust particles. Floppy 
disks are read and written by a floppy disk drive (FDD).
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Floppy Disks

4.	 Hard Disks

A hard disk drive (HDD), hard disk, hard drive, or fixed disk is an electromechanical 
data storage device that uses magnetic storage to store and retrieve digital information 
using one or more rigid rapidly rotating disks (platters) coated with magnetic 
material. The platters are paired with magnetic heads, usually arranged on a moving 
actuator arm, which read and write data to the platter surfaces. Data is accessed in 
a random-access manner, meaning that individual blocks of data can be stored or 
retrieved in any order and not only sequentially. HDDs are a type of non-volatile 
storage, retaining stored data even when powered off.

Hard Disk

5.	 Solid State Drive (SSD)

Hard disk can be replaced and upgraded by solid state drive (SSD) as new technology. 
Semiconductor chips are used to store data in SSD. The speed to read and write data 
is greater than hard disk. So its price is more expensive than hard disk. Laptop, 
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notebook, ultra-book, etc. uses SSD as storage device. Its storage capacity is about 4 
TB but various companies are trying to develop SSD with high storage capacity. It is 
costlier than HDD (Hard Disk Drive).

Differences between SSD and HDD

S.N. Description HDD SSD
1 Storage 

technology
HDD use magnetic storage 
technology with spinning disks or 
platters.

There are no moving parts in 
an SSD, and data is stored in 
memory chips. 

2 Speed HDDs are generally slower compared 
to SSDs. The speed is affected by the 
rotational speed of the disks and the 
mechanical components involved in 
data access.

They provide faster data access 
and transfer speeds because 
there are no mechanical 
parts, and data is accessed 
electronically.

3 Durability 
and reliability 

HDDs are more susceptible to 
physical shock and damage due to 
their mechanical components.

SSDs are more durable and 
reliable in terms of physical 
shock because they lack 
moving parts.

4 Power 
Consumption 

HDDs generally consume more 
power because of the spinning disks 
and moving parts.

SSDs have lower power 
consumption as they do not 
have moving parts and operate 
using flash memory.

5 Cost Cheap than SSD SSDs are relatively more 
expensive but have become 
more affordable over time.

6.	 External Hard Drive

The working principle of hard disk is similar to that of internal hard drive but it is 
not placed inside CPU casing. It can be externally connected with a USB (Universal 
Serial Bus) port. It is portable and easy to carry. It is used to transfer data, information 
and software from one computer to another.

7.	 Pen Drive

Pen drive is a popular flash storage device. It is also called flash memory. It is 
connected through the USB ports. It is a small size and portable device. It can be 
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carried in a pocket like pen. So it got its name as a pen drive. It is used to transfer 
data, information and software from one computer to another. It is made up of 
semiconductor chip which is EEPROM technology. The writing speed of pen drive 
of USB 3.0 is up to 60 MB/S and data reading speed up to 120 MB/S.

8.	 Optical Disks

An optical disc (OD) is a flat, usually circular disc which encodes binary data (bits) 
in the form of pits (binary value of 0 or off, due to lack of reflection when read) and 
lands (binary value of 1 or on, due to a reflection when read) on a special material 
(often aluminum) on one of its flat surfaces. The encoding material sits a top a 
thicker substrate (usually polycarbonate) which makes up the bulk of the disc and 
forms a dust defocusing layer. The encoding pattern follows a continuous, spiral 
path covering the entire disc surface and extending from the innermost track to the 
outermost track. The data is stored on the disc with a laser or stamping machine, and 
can be accessed when the data path is illuminated with a laser diode in an optical disc 
drive which spins the disc at speeds of about 200 to 4,000 RPM or more, depending 
on the drive type, disc format, and the distance of the read head from the center of 
the disc (inner tracks are read at a higher disc speed). There are four types of optical 
disks-

A.	 CD-ROM- Compact Disk Read Only Memory

B.	 WORM – Write Once Read Many

C.	 Erasable Optical Disk

D.	 DVD ROM.

E.	 VCD

A.	 CD-ROM

It is an optical ROM in which, pre-recorded data can be read out. The manufacturer 
writes data on CD-ROMs. The disk is made up of a resin such as polycarbonate. It is 
coated with a material which will change when a high intensity laser beam is focused 
on it. The coating material is highly reflective, usually aluminum. It is also called a 
laser disk.

The advantages of CD-ROM are its high storing capacity, mass copy of information 
stored, removable from the computer, etc.
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B.	 WORM or CD-R (CD-Recordable)

WORM or CD-R is write- once read-many type optical disk memory. The users can 
write data on WORM and read the written data as many times as desired. To write 
data on the disk, the laser beam of modest density is employed, which forms pits or 
bubbles on the disk surface. Its disk controller is somewhat expensive than that for 
CD-ROM. For writing operation, required laser power is more than that required for 
reading. Its advantages are its high capacity, better reliability and longer life. The 
drawback is greater access time compares to that of hard disk.

C.	 Erasable Optical Disk or CD-ROM

Erasable optical disk or CD-ROM is a read/write optical disk memory. Information 
can be written to and read from the disk. The disk contents can be erased and new 
data can be rewritten. So, it can serve as a secondary memory of a computer. Its 
advantages over magnetic hard disk are:

•	 Very high storage capacity

•	 An optical disk can be removed from the drive

•	 It has long life

•	 It is more reliable etc.

The drawback is its longer access time compared to that of a hard disk

D.	 DVD ROM

DVD stands for Digital Versatile Disks. A DVD stores much more data than CD- 
ROM. Its capacity is 4.7 GB, 8.5 GB, 20 GB, etc. the capacity depends on whether it 
is a single layer, and double layer single sided or double sided disk. DVD ROM uses 
the same principle as a CDROM for reading and writing. But a smaller wavelength 
beam is used. A lens system is used to focus on two different layers on the disk. On 
each layer data is recorded. Thus, the capacity can be doubled. Further the recording 
beam is sharper compared to CDROM and the distance between successive tracks 
on the surface is smaller. The total capacity of DVD ROM is 8.5 GB. In double sided 
DVDROM two such disks are stuck back to back which allows recording on both 
sides. This requires the disk to be reversed to read the reverse side. Hence, the double 
sided DVDROM’s capacity is 17 GB. However, double sided DVDROM should be 
handled carefully as both sides have data, they are thinner, and could be accidentally 
damaged.
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E.	 VCD

Video CD (abbreviated as VCD, and also known as Compact Disc digital video) is 
a home video format and the first format for distributing films on standard 120 mm 
(4.7 in) optical discs. The format is a standard digital format for storing video on a 
compact disc. VCDs are playable in dedicated VCD players and widely playable in 
most DVD players, personal computers and some video game consoles.

F.	 DVD RW

DVD RW stands for "Digital Versatile Disk Rewritable." A DVD-RW is like a 
DVD-R but can be erased and written to again. Like CD-RWs, DVD-RWs must be 
erased in order for new data to be added. DVD-RWs can hold 4.7GB of data and do 
not come in double-layered or double-sided versions like DVD-Rs do. Because of 
their large capacity and ability to be used multiple times, DVD-RW discs are a great 
solution for frequent backups. To record data onto a DVD-RW disc, you'll need a 
DVD burner that supports the DVD-RW format.

The various DVD storage capacities are as follow:

•	 Single Side Layer- 4.7 GB 

•	 Single Side Double Layer-8.5 GB

•	 Double Layer Single Side- 9.4 GB 

•	 Double Layer Double Side-17.08 GB

9.	 Blue Ray Disc

Blu-ray disc is a high-density optical disc format similar to DVD. Blu-ray is the type 
of disc used for play station 3 games and for playing high-definition (HD) movies. 
In the past, there were other standards for such movies, such as the HD DVD format. 
Blu-ray won what is called the format war.

A dual-layer Blu-ray disc can store up to 50GB (gigabytes) of data. This is over five 
times the capacity of a DVD, and over 70 times more than a CD or VCD.

10.	 Flash Drives

A flash drive is a small, ultra-portable storage device which, unlike an optical drive 
or a traditional hard drive, has no moving parts.

Flash drives connect to computers and other devices via a built-in USB Type- A plug, 
making a flash drive a kind of combination USB device and cable.
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11.	 SD Cards

The SD card is a basic way of transferring information and storing it. The good thing 
about it is that it is a non-volatile solution just like the majority of storage.

SD Cards

12.	 MMC Memory Cards

Multi dedia card (MMC) is a memory-card standard used for solid-state storage. 
MMC operates as a storage medium for a portable device, in a form that can easily 
be removed for access by a PC. For example, a digital camera would use an MMC 
for storing image files. MMCs are available in sizes up to and including 512 GB.

Memory cards

2.5.1	Physical Structure of Floppy and Hard Disk, Drive Naming 
Conventions in PC Physical Structure of Floppy Disk
A floppy disk is basically a circular sheet of plastic, coated with magnetic material. 
A hard disk is made of a stack of circular metal platters, also coated with magnetic 
material. Before a disk can be used it must be formatted. The surface of the disk is 
divided into a number of concentric tracks, each of which is subdivided into sectors.

Floppy disks have 80 tracks on each side and each track is split into 18 sectors. A 
3.5" floppy disk with 80 tracks and 18 sectors will have 80 x 18 = 1,440 storage 
units, each uniquely identified by its track and sector position. Each storage unit can 
hold 512 bytes of data, so the disk has a capacity of 1,440 x 512 = 737,280 bytes (720 
KBytes) per side, or 1,400 KBytes (1.4 MBytes) per disk.

A hard disk is a sealed unit which contains a stack of circular platters mounted on 
a common spindle. Electromagnetic read/write heads are located above and below 
each platter. The platters rotate at a constant speed, eg. 7200 rpm. While they are 
spinning the heads can move in towards the center or out towards the edge. This 
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allows them to reach any location on the platter.

Physical Structure of Hard Disk

The above picture is the physical structure of a hard disk. The hard disk consists of several 
discs. How to locate a position on a hard disk? There are three words you should learn: 
cylinder, head and sector.

Cylinder

The disc that makes up the hard disk is divided into tracks. Tracks of all discs which have 
same track value are called a cylinder. So the cylinder is a pile of tracks with same track 
value of a hard disk.

Head

Normally, a disc has two heads for reading or writing data, one is for the top and the other 
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one is for the opposite side; the head value means the disc location and side.

Sector

A track is composed of sectors and the number of sectors of all tracks on the hard disk is the 
same. Sector is the minimal storage unit of a hard disk. The size of one sector is always 512 
bytes (rarely, it might be 1024, 2048 or 4096 bytes in some special hard disks).

2.6	 Input Device
An input device is a piece of computer hardware equipment used to provide data and 
control signals to an information processing system such as a computer or information 
appliance. Examples of input devices include keyboards, mouse, trackball, joystick, 
digitizing tablet, scanners, digital cameras, MICR, OCR, OMR, bar-code reader, 
voice recognition, light pen, touch screen, etc.

2.6.1	Keyboard
Keyboard is the most common and very popular input device which helps to input 
data to the computer. The layout of the keyboard is like that of traditional typewriter, 
although there are some additional keys provided for performing additional functions.

Keyboard

Keyboards are of two sizes 84 keys or 101/102 keys, but now keyboards with 104 
keys or 108 keys are also available.

2.6.2	Mouse
Mouse is the most popular pointing device. It is a very famous cursor-control device, 
which senses the movement of the mouse and sends corresponding signals to the 
CPU when the mouse buttons are pressed.

There are two major types of the mouse; optical and mechanical, and both types 
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consist of subcategories called wired or wireless. Optical mouse works based on the 
LED light to detect movement, whereas in mechanical mouse, the ball is situated 
at the bottom of the mouse, which is responsible for detecting the movement. A 
laser mouse is a type of optical mouse, and its functioning is similar to an LED 
mouse, which works on light to sense movement. However, there is a difference in 
the source of light in LED mice and laser mice. Both can work on different surfaces 
like glass and plastic sheets. Laser mice are the updated version of a mouse present 
in both forms, wired and wireless.

Generally, it has two buttons called the left and the right button and a wheel is present 
between the buttons. A mouse can be used to control the position of the cursor on the 
screen, but it cannot be used to enter text into the computer.

2.6.3	Track Ball
Track ball is an input device that is mostly used in notebook or laptop computer, 
instead of a mouse. This is a ball which is half inserted and by moving fingers on 
the ball, the pointer can be moved. Since the whole device is not moved, a track ball 
requires less space than a mouse. A track ball comes in various shapes like a ball, a 
button, or a square.

2.6.4	Joystick
Joystick is also a pointing device, which is used to move the cursor position on a 
monitor screen. It is a stick having a spherical ball at its both lower and upper ends. 
The lower spherical ball moves in a socket. The joystick can be moved in all four 
directions. The function of the joystick is similar to that of a mouse. It is mainly used 
in computer aided designing (CAD) and playing computer games.

2.6.5	Digitizer
Digitizer is an input device which converts analog information into digital form. 
Digitizer can convert a signal from the television or camera into a series of numbers 
that could be stored in a computer. A digitizer, also known as a graphics tablet 
or drawing tablet, is a device that allows you to input drawings, sketches, and 
handwritten notes into a computer. It consists of a flat surface and a stylus or pen-
like instrument that you use to draw or write on the surface. The device captures the 
movements and pressure applied by the stylus and translates them into digital data 
that can be interpreted by the computer.
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2.6.6	Scanner
Scanner is an input device, which works more like a photocopy machine. It is used 
when some information is available on paper and it is to be transferred to the hard 
disk of the computer for further manipulation. Scanner captures images from the 
source which are then converted into a digital form that can be stored on the disk. 
These images can be edited before they are printed.

2.6.7	Digital Camera
A digital camera is a camera that takes video or photographs and input to the computer 
in the digital format. At first, the photographs are stored in the camera's memory and 
then transferred to a computer through a cable. Then, we can edit that photograph 
according to our requirement. Most of the camera we use today are digital.

2.6.8	Magnetic Ink Card Reader (MICR)
MICR input device is generally used in banks as there are large number of cheques 
to be processed every day. The bank's code number and cheque number are printed 
on the cheques with a special type of ink that contains particles of magnetic material 
that are machine readable.

MICR

This reading process is called Magnetic Ink Character Recognition (MICR). The 
main advantages of MICR is that it is fast and less error prone.

2.6.9	Optical Character Reader (OCR)
OCR is an input device used to read a printed text.

OSR Reader
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OCR scans the text optically, character by character, converts them into a machine 
readable code, and stores the text on the system memory.

2.6.10	  Optical Mark Reader (OMR)
OMR is a special type of optical scanner used to recognize the type of mark made 
by pen or pencil. It is used where one out of a few alternatives is to be selected and 
marked.

Optical mark Reader

It is specially used for checking the answer sheets of examinations having multiple 
choice questions.

2.6.11	 Bar Code Readers (BCR)
Bar code reader is a device used for reading bar coded data (data in the form of light 
and dark lines). Bar coded data is generally used in labeling goods, numbering the 
books, etc. It may be a handheld scanner or may be embedded in a stationary scanner.

Bar Code Readers

Bar code reader scans a bar code image, converts it into an alphanumeric value, 
which is then fed to the computer that the bar code reader is connected to.
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2.6.12	  QR Code Readers
A QR code reader, also known as a QR code scanner, is a software application or a 
feature in a device that is designed to interpret and decode quick response (QR) codes. 
QR codes are two-dimensional barcodes that can store a variety of information, such 
as website URLs, text, contact details, or other data.

The QR code reader uses the device's camera to capture and analyze the QR code's 
pattern, converting it into readable information. Once the QR-Code is successfully 
scanned, the reader typically displays the embedded content or prompts the user to 
take specific actions based on the encoded information.

QR readers

2.6.13	  Voice Recognition
Voice or speaker recognition is the ability of a machine or program to receive and 
interpret dictation or to understand and carry out spoken commands. Voice recognition 
has gained prominence and use with the rise of AI and intelligent assistants, such as 
Amazon's Alexa, Apple's Siri and Microsoft's Cortana.

Voice recognition systems enable consumers to interact with technology simply by 
speaking to it, enabling hands-free requests, reminders and other simple tasks. Voice 
recognition is a computer software program or hardware device with the ability to 
decode the human voice.

2.6.14	  Light Pen
Light pen is a pointing device similar to a pen. It is used to select a displayed menu 
item or draw pictures on the monitor screen. It consists of a photocell and an optical 
system placed in a small tube.
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Light pen
When the tip of a light pen is moved over the monitor screen and the pen button 
is pressed, its photocell sensing element detects the screen location and sends the 
corresponding signal to the CPU.

2.6.15	  Microphone
Microphone is an input device to input sound that is then stored in a digital form. The 
microphone is used for various applications such as adding sound to a multimedia 
presentation or for mixing music.

Microphone
2.6.16	  Touch Screen

A touch screen is a display device that allows the user to interact with a computer by 
using their finger. They can be quite useful as an alternative to a mouse or keyboard 
for navigating a graphical user interface (GUI). Touch screens are used on a variety of 
devices such as computer and laptop monitors, smart phones, tablets, cash registers, 
and information kiosks. Some touch screens use a grid of infrared beams to sense the 
presence of a finger instead of utilizing touch-sensitive input.

Touch screens



Computer Application/Grade 9
48

2.7	 Output devices
Following are some of the important output devices used in a computer.

•	 Monitors

•	 Graphic Plotter

•	 Printer

2.7.1	Monitors
Monitors, commonly called as visual display unit (VDU), are the main output device 
of a computer. It forms images from tiny dots, called pixels that are arranged in a 
rectangular form. The sharpness of the image depends upon the number of pixels.

There are two kinds of viewing screen used for monitors.

•	 Cathode-ray tube (CRT)

•	 Flat-panel display

1.	 Cathode-Ray Tube (CRT) Monitor

The CRT display is made up of small picture elements called pixels. The smaller the 
pixels, the better the image clarity or resolution. It takes more than one illuminated 
pixel to form a whole character, such as the letter ‘e’ in the word help.

Cathode Ray Tube Monitor

2.	 Flat-Panel Display Monitor

The flat-panel display refers to a class of video devices that have reduced volume, 
weight and power requirement in comparison to the CRT. You can hang them on walls 
or wear them on your wrists. Current uses of flat-panel displays include calculators, 
video games, monitors, laptop computer, and graphics display.

The flat-panel display is divided into two categories

•	 Emissive Displays− Emissive displays are devices that convert electrical energy 
into light. For example, plasma panel and light emitting diodes (LED).
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•	 Non-Emissive Displays− Non-emissive displays use optical effects to convert 
sunlight or light from some other source into graphics patterns. For example, 
LCD (Liquid-Crystal Device).

Flat Panel Monitor

Characteristics of a Monitor

Following are the characteristics of a monitor:

a)	 Size

The most important aspect of a monitor is its size. Screen sizes are measured in 
diagonal inches, the distance from one corner to another opposite corner diagonally.

b)	 Resolution

The resolution of a monitor indicates how density the pixels are packed. Pixel is 
short for picture element. A pixel is a single point in a graphic image.

c)	 Band Width

The amount of data that can be transmitted in a fixed amount of time. The maximum 
amount of data transmitted over an internet connection in a given amount of time. 
Bandwidth is often mistaken for internet speed when it is actually the volume of 
information that can be sent over a connection in a measured amount of time – 
calculated in megabits per second (Mbps).

d)	 Refresh Rate

Display monitors must be refresh many times per second. The refresh rate determines 
how many times per seconds the screen is to be red drawn. The refresh rate of a 
monitor is measured in Hertz.

e)	 Interlacing

Interlacing is a technique in which instead of scanning the image one line at a time, 
it scans alternately i.e. alternate lines are scanned at each pass.



Computer Application/Grade 9
50

f)	 Video Standard

It will be frustrating if you get a new monitor and then find out you cannot connect it 
to your computer. Your computer needs to send information to your monitor so you 
can see it. Four different standards are widely used. Each has sub- standards. Your 
computer will normally have from 1 to 3 of those options available to you. They 
seldom offer all four standards. Your monitor will probably offer 2 or 3 options. 
Sometimes your computer might not have the type of standard used by your monitor, 
especially if you are adding a second monitor.

g)	  VGA

The oldest standard is VGA. It stands for Video Graphics Array and was introduced 
by IBM in 1987. It has been improved since then to allow for more pixels and 
better performance. This is an Analog display standard, so cabling, and distance can 
degrade the quality of the output. Generally, newer monitors will look better using 
a digital standard.

h)	 SVGA

A super video graphics array (SVGA) monitor is an output device which uses 
the SVGA standard. SVGA is a video-display-standard type developed by the 
video electronics standards association (VESA) for IBM PC compatible personal 
computers (PCs).

i)	 XGA

Extended graphics array (XGA) is a high-resolution video display mode that provides 
screen pixel resolution of 1,024 by 768 in 256 colours or 640 by 480 in high (16-
bit) colour. The XGA standard is used in desktop and laptop computers as well as in 
projection systems.

3.	 Printers

Printer is an output device, which is used to print information on paper. There are 
two types of printers:

•	 Impact printers

•	 Non-impact printers

a.	 Impact Printers

Impact printers print the characters by striking them on the ribbon, which is then 
pressed on the paper.
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Characteristics of impact printers are the following:

•	 Very low costs

•	 Very noisy

•	 Useful for bulk printing due to low cost

These printers are of two types:

•	 Character printers

•	 Line printers

i)	 Character Printers

Character printers are the printers which print one character at a time. These are 
further divided into two types:

•	 Dot Matrix Printer(DMP)

•	 Daisy Wheel

Dot Matrix Printer

In the market, one of the most popular printers is dot matrix printer. These printers are 
popular because of their ease of printing and economical price. Each character printed is in 
the form of pattern of dots and head consists of a matrix of pins of size (5*7, 7*9, 9*7 or 
9*9) which come out to form a character which is why it is called dot matrix printer.

Dot matrix Printer
Advantages

•	 Dot matrix printer is inexpensive

•	 It is widely used

•	 Other language characters can be printed.
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Disadvantages

•	 It has slow speed

•	 It has poor quality

Daisy Wheel
Head is lying on a wheel and pins corresponding to characters are like petals of Daisy 
(flower) which is why it is called daisy wheel printer. These printers are generally used for 
word-processing in offices that require a few letters to be sent here and there with very nice 
quality.

Daisy Wheel Printer

Advantages

•	 More reliable than DMP

•	 Better quality

•	 Fonts of character can be easily changed.

Disadvantages

•	 Slower than DMP

•	 Noisy

•	 More expensive than DMP

ii)	 Line Printers

Line printers are the printers which print one line at a time.

Line Printer
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These are of two types:

•	 Drum printer

•	 Chain printer

a)	 Drum Printer

This printer is like a drum in shape hence it is called drum printer. The surface of 
the drum is divided into a number of tracks. Total tracks are equal to the size of the 
paper, i.e. for a paper width of 132 characters, drum will have 132 tracks. A character 
set is embossed on the track. Different character sets available in the market are 
48-character set, 64 and 96 characters set. One rotation of drum prints one line. 
Drum printers are fast in speed and can print 300 to 2000 lines per minute.

Advantages

•	 Very high speed

Disadvantages

•	 Very expensive

•	 Characters fonts cannot be changed

b)	 Chain Printer

In this printer, a chain of character sets is used, hence it is called chain printer. A 
standard character set may have 48, 64, or 96 characters.

Advantages

•	 Character fonts can easily be changed.

•	 Different languages can be used with the same printer.

Disadvantages

•	 Noisy

b.	 Non-impact Printers

Non-impact printers print the characters without using the ribbon. These printers 
print a complete page at a time, thus they are also called as page printers.

These printers are of two types:

•	 Laser printers

•	 Inkjet printers
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Characteristics of non-impact printers
•	 Faster than impact printers

•	 They are not noisy

•	 High quality

•	 Supports many fonts and different character size

i)	 Laser Printers

These are non-impact page printers. They use laser lights to produce the dots needed 
to form the characters to be printed on a page.

Laser Printer
Advantages

•	 Very high speed

•	 Very high quality output

•	 Good graphics quality

•	 Supports many fonts and different character size

Disadvantages

•	 Expensive

•	 Cannot be used to produce multiple copies of a document in a single printing

ii)	 Inkjet Printers

Inkjet printers are non-impact character printers based on a relatively new technology. 
They print characters by spraying small drops of ink onto paper. Inkjet printers 
produce high quality output with presentable features.

They make less noise because no hammering is done and these have many styles of 
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printing modes available. Colour printing is also possible. Some models of Inkjet 
printers can produce multiple copies of printing too.

Inkjet Printer

Advantages

•	 High quality printing

•	 More reliable

Disadvantages

•	 Expensive as the cost per page is high

•	 Slow as compared to laser printer

2.8	 Computer Software
Software is a set of programs, which is designed to perform a well-defined function. 
A program is a sequence of instructions written to solve a particular problem.

Software is a collection of instructions that enable the user to interact with a 
computer, its hardware, or perform tasks. Without software, most computers would 
be useless. For example, without your Internet browser software, you cannot surf the 
Internet or read the page. Without an operating system, the browser cannot run on 
your computer. The picture to the right shows a Microsoft Excel box, an example of 
a spreadsheet software program.

2.8.1	Necessity of Computer Software
Software is the soul of the computer. Without it, the computer will never be 
useful. In simple words, software is a set of programs, procedures, algorithms 
and its documentation. Program software performs the function of the program it 
implements, either by directly providing instructions to the computer hardware or 
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by serving as input to another piece of software. Computer software is essential for 
the functioning of modern computers and plays a crucial role in various aspects of 
our daily lives.

Some necessities of computer software are security, encryption software, backup 
and disaster discovery, network enhancement, automation, healthcare, education 
and research, development tools, business operations, communication, productivity 
tools, etc.

2.8.2	Types of Software
There are two types of software:

•	 System software

•	 Application software

a)	 System Software

The system software is a collection of programs designed to operate, control, 
and extend the processing capabilities of the computer itself. System software is 
generally prepared by the computer manufacturers. System software handles essential 
tasks such as managing memory, controlling hardware components, facilitating 
communication between hardware and software, and providing a user interface. 
The operating system is a primary example of system software. These software 
products comprise of programs written in low-level languages, which interact with 
the hardware at a very basic level. System software serves as the interface between 
the hardware and the end users.

Some examples of system software are operating system, compilers, interpreter, 
assemblers, etc.

Here is a list of some of the most prominent features of a system software –
•	 Close to the system

•	 Fast in speed

•	 Difficult to design
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•	 Difficult to understand

•	 Less interactive

•	 Smaller in size

•	 Difficult to manipulate

•	 Generally written in low-level language

b)	 Application Software

Application software products are designed to satisfy a particular need of a particular 
environment. All software applications prepared in the computer lab can come under 
the category of application software. Application software is created to fulfill specific 
user requirements, ranging from productivity tasks (word processing, spreadsheet 
calculations) to entertainment (games, multimedia applications) and specialized 
functions (engineering software, graphics design tools).

Application software may consist of a single program, such as microsoft's notepad 
for writing and editing a simple text. It may also consist of a collection of programs, 
often called a software package, which work together to accomplish a task, such as 
a spreadsheet package.

Following another examples of application software:

•	 Payroll software

•	 Student record software

•	 Inventory management software

•	 Income tax software

•	 Railways reservation software

•	 Microsoft office suite software

•	 Microsoft word

•	 Microsoft wxcel

•	 Microsoft powerpoint
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Features of application software are as follows:

•	 Close to the user

•	 Easy to design

•	 More interactive

•	 Slow in speed

•	 Generally written in high-level language

•	 Easy to understand

•	 Easy to manipulate and use

•	 Bigger in size and requires large storage space
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Exercise

Choose the correct answer from the given alternatives.
1.	 Which devices provide a means of communication between a computer and outer 

world?

a. I/O	 b. Storage	 c. compact	 d. Drivers

2.	 Which of the following is not a point and draw device?

a. Keypad	 b. Trackball 	 c. Touch screen	 d. Mouse 

3.	 What does USB stand for?

a. Universal signal board	 b. Universal signal bus 

c. Universal serial bus	 d. Universal serial board 

4.	 Which of the following uses multiple hard platters mounted on a single central shift?

a. Disk drives 	 b. Hard disks	 c. Disk packs	 d. Compact disks 

5.	 Components that provide internal storage to the CPU are…

a. Register	 b. Program Counters  c. Controllers	 d. Internal chips

6.	 Saving data and instructions to make them readily available is the job of …….

a. Storage unit	 b. Cache unit	 c. Input unit	 d. Output unit

7.	 Which of the following is non-volatile storage?

a. Backup	 b. Secondary	 c. Primary	 d. Cache memory

8.	 A non-erasable disk that stores digitized audio information is _____

a. CD	 b. CD-ROM	 c. DVD-R	 d. DVD-RW

9.	 Brain of computer is…….

a. Control unit		  b. Arithmetic and logic unit

c. Central processing unit	 d. Memory

10.	 What does MBR stand for?

a. Main buffer register	 b. Memory buffer routine

c. Main buffer routine	 d. Memory ruffer register
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11.	 What does PC stand for?

a. Program changer 	 b. Program counter

c. Performance counter	 d. Performance charger

12.	 The portion of the processor which contains the hardware required to fetch the 
operations is 

a. Datapath	 b. Processor	 c. Control	 d. Output unit

13.	 Which of the following is the example of software application?

a. Complier	 b. Interpreter	 c. Assembler	 d. MS word

Write short answer to the following questions. 
1.	 What is computer system? Explain the different types of hardware devices that make 

computer system.

2.	 What is volatile and non-volatile memory? Differentiate between primary and 
secondary data.

3.	 Describe the block diagram of computer architecture with block diagram. 

4.	 What is Control Unit? Write its functions.

5.	 What is ALU? Writes its functions.

6.	 Write short notes on 

a. RAM

b. ROM

c. Cache memory

d. Register 

7.	 What is software? Discuss the types of software with example and explain too.

8.	 What is a printer? Differentiate between impact and non-impact printer.

9.	 Why monitor is required in computer system? Explain with reasons.

Write long answer to the following questions.
1.	 Explain the features of system software and application software with examples. 

2.	 Draw and explain the block diagram of computer system.

3.	 Difference between system software and application software. What are the roles of 
system software in computer system? Explain with the real life examples. 
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4.	 Why is ROM memory called volatile memory? How does RAM increase the 
performance of the system?

5.	 Why are control unit and ALU is necessary in the CPU? Explain their detail roles.

Project works
1.	 Be familiar with all the hardware parts of computer within the CPU as well as 

external hardware.

2.	 Learn to assemble and disassemble PC. 



Computer Application/Grade 9
62

3.1	 Introduction of Operating System
An operating system is a kind of system software that controls and co-ordinates the 
overall operations of the computer system. The operating system is a program with 
the following features:

	An operating system is a program that acts as an interface between the software 
and the computer hardware.

	It is specialized software that controls and monitors the execution of all other 
programs that reside in the computer, including application programs and other 
system software.

Operating system
 3.1.1	Characteristics of Operating System

Here is a list of some of the most prominent characteristic features of operating 
systems:

	Memory management

	Processor management

	Device management

Unit 3 Operating System
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	File management security

	Job accounting control

	Over system performance

	Interaction with the operators

	Coordination between other software and users

3.2	 Types of Operating System
An operating system performs all the basic tasks like managing file, process, and 
memory. The operating system acts as manager of all the resources, i.e. resource 
manager. Thus operating system becomes an interface between user and machine.

Some of the widely used operating systems are as follows:

Batch Operating System

The users of a batch operating system do not interact with the computer directly. Each 
user prepares his job on an off-line device like punch cards and submits it to the computer 
operator. To speed up processing, jobs with similar needs are batched together and run as a 
group. The programmers leave their programs with the operator and the operator then sorts 
the programs with similar requirements into batches.

The problems with batch systems are as follows:

	Lack of interaction between the user and the job

	CPU is often idle because the speed of the mechanical I/O devices is slower than 
the CPU

	Difficult to provide the desired priority

Single-user, Single-tasking Operating System

As the name implies, this operating system is designed to manage the computer so that one 
user can effectively do one thing at a time. The palm OS for palm hand held computer is a 
good example of a modern single-user, single-task operating system.

Single-user, Multi-tasking Operating System

Single-user, multi-tasking operation system is the type of operating system most people 
use on their desktop and laptop computers today. Microsoft's windows and apple's Mac OS 
platforms are both examples of operating systems that will let a single user have several 
programs in operation at the same time. For example, it is entirely possible for a windows 
user to be writing a note in a word processor while downloading a file from the internet 
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while printing the text of an e-mail message.

Multi-programming Operating System

In a multi-programming system, there are one or more programs loaded in main memory 
which are ready to execute. Only one program at a time is able to get the CPU for executing 
its instructions (i.e., there is at most one process running on the system) while all the others 
are waiting their turn.

The main idea of multiprogramming is to maximize the use of CPU time. Indeed, suppose 
the currently running process is performing an I/O task. Then, the OS may interrupt that 
process and give the control to one of the other in-main-memory programs that are ready to 
execute (i.e. process context switching). In this way, no CPU time is wasted by the system 
waiting for the I/O task to be completed, and a running process keeps executing until 
either it voluntarily releases the CPU or when it blocks for an I/O operation. Therefore, the 
ultimate goal of multi-programming is  to keep the CPU busy as long as there are processes 
ready to execute.

Finally, note that if there are N ready processes and all of those are highly CPU- bound (i.e., 
they mostly execute CPU tasks and none or very few I/O operations), in the very worst case 
one program might wait all the other N-1 ones to complete before executing.

Multi-user Operating System

A multi-user operating system allows many different users to take advantage of the 
computer's resources simultaneously. The operating system must make sure that the 
requirements of the various users are balanced, and that each of the programs they are 
using has sufficient and separate resources so that a problem with one user doesn't affect the 
entire community of users. Unix, VMS and mainframe operating systems, such as MVS, are 
examples of multi-user operating systems.

Multiprocessing Operating System

Multiprocessing sometimes refers to executing multiple processes (programs) at the 
same time. This might be misleading because we have already introduced the term 
“multiprogramming” to describe that before. In fact, multiprocessing refers to the hardware 
(i.e., the CPU units) rather than the software (i.e., running processes). If the underlying 
hardware provides more than one processor, then, that is multiprocessing. Several variations 
on the basic scheme exist, e.g., multiple cores on one die or multiple dies in one package 
or multiple packages in one system. Anyway, a system can be both multi programmed by 
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having multiple programs running at the same time and multiprocessing by having more 
than one physical processor.

Multithreading Operating System

Multitasking refers to multiple tasks running (apparently) simultaneously by sharing 
the CPU time. Finally, multiprocessing describes systems having multiple CPUs. 
Multithreading is an execution model that allows a single process to have multiple code 
segments (i.e., threads) run concurrently within the “context” of that process. Multiple 
threads of a single process can share the CPU in a single CPU system or (purely) run in 
parallel in a multiprocessing system.

Time-sharing Operating Systems

Time-sharing is a technique which enables many people, located at various terminals, to 
use a particular computer system at the same time. Time-sharing or multitasking is a logical 
extension of multiprogramming. Processor's time which is shared among multiple users 
simultaneously is termed as time-sharing.

Real-time Operating System (RTOS)

Real-time operating systems are used to control machinery, scientific instruments and 
industrial systems. An RTOS typically has very little user-interface capability, and no 
end-user utilities, since the system will be a "sealed box" when delivered for use. A very 
important part of an RTOS is managing the resources of the computer so that a particular 
operation executes in precisely the same amount of time, every time it occurs. In a complex 
machine, having a part move more quickly just because system resources are available may 
be just as catastrophic as having it not move at all because the system is busy.

Distributed Operating System

Distributed operating systems use multiple central processors to serve multiple real- time 
applications and multiple users. Data processing jobs are distributed among the processors 
accordingly.

Network Operating System

A network operating system runs on a server and provides the server the capability to manage 
data, users, groups, security, applications, and other networking functions. The primary 
purpose of the network operating system is to allow shared file and printer access among 
multiple computers in a network, typically a local area network (LAN), a private network 
or to other networks.
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Examples of network operating systems include Microsoft Windows Server 2003, Microsoft 
Windows Server 2008, UNIX, Linux, Mac OS X, Novell NetWare, and BSD.

3.3	 Disk Operating System
Disk operating system (DOS) was the first operating system used by IBM-compatible 
computers. It was originally available in two versions that were essentially the same, 
but marketed under two different names. "PC-DOS" was the version developed 
by IBM and sold to the first IBM-compatible manufacturers. "MS-DOS" was the 
version that Microsoft bought the rights to, and was bundled with the first versions 
of Windows.

DOS uses a command line, or text-based interface, that allows the user to type 
commands. By typing simple instructions such as print working directory (PWD) 
and cd (change directory), the user can browse the files on the hard drive, open files, 
and run programs. While the commands are simple to type, the user must know the 
basic commands in order to use DOS effectively (similar to Unix). This made the 
operating system difficult for novices to use, which is why Microsoft later bundled 
the graphic-based Windows operating system with DOS.

The first versions of Windows (through Windows 95) actually ran on top of the DOS 
operating system. This is why so many DOS-related files (such as .INI, .DLL, and 
.COM files) are still used by Windows. However, the Windows operating system 
was rewritten for Windows new technology (), which enabled Windows to run on its 
own, without using DOS. Later versions of Windows, such as Windows 2000, XP, 
and Vista, also do not require DOS.

DOS is still included with Windows, but is run from the Windows operating system 
instead of the other way around. The DOS command prompt can be opened in 
Windows by selecting "Run..." from the Start Menu and typing cmd.

Command based User Interface (CUI)

CUI is a traditional user interface. It provides the interactive terminal where user can enter 
the command to interpret. It is the only one common place where the program and the user 
communicate with each other. MS-DOS and Novell Netware are some example of CUI 
based operating system. In CUI, user has to interact with the applications by making use of 
commands. In CUI, only one task can run at a time.

CLI or CUI advantages and disadvantages

The advantages of a command line interface are:
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	granular control of an OS or application

	faster management of a large number of operating systems

	ability to store scripts to automate regular tasks; and

	basic command line interface knowledge to help with troubleshooting, such as 
network connection issues.

The disadvantages of a command line interface are:

	CUI is not user-friendly

	steeper learning curve associated with memorizing commands and complex 
syntax/arguments; and

	different commands used in different shells.

Concept of File and Directory

A file is systematic collection of related data or information or program instructions. A file 
name contains two parts: name and extension. Name helps to identify the file and extension 
helps to identify the type of file. Example, sarthak.exe. Here, sarthak is file and .exe is 
extension.

Rules for Writing Filename

1.	 Only alphanumeric characters are used in file name.

2.	 The name can have maximum eight characters long and extension can have three 
characters long. The name and extension are separated by. (period) sign.

3.	 Space, commas, colon and backslash cannot be used in filename.

A directory is a location for storing files on your computer. Directories are found in 
a hierarchical file system, such as Linux, MS-DOS, OS/2, and Unix.

Wildcards and Pathname

Wild card character, a wildcard is a symbol used to replace or represent one or more 
characters. Wildcards are typically either an asterisk (*), which represents one or more 
characters or question mark (?), which represents a single character. In the below example 
of how a wildcard may be used, realize that wildcards are relatively universal.

Path is used to specify the location of files. It is the way of indicating the location of file. 
The path is specified by giving pathname. The pathname is a sequence of directory name 
followed by a file name and separated by "\" slash.

Example: C:\program files\Photoshop
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System Files

•	 IO.SYS (or IBMBIO.COM): This contains the system initialization code and built 
in device drivers. It is hidden file which manages and controls other programs.

•	 MSDOS.SYS (or IBMDOS.COM): This contains the DOS kernel. Command line 
interpreter (Shell). It is hidden file which manages input/output operations of input/
output devices.

•	 COMMAND.COM: This is the command interpreter. User configuration files:

•	 AUTOEXEC.BAT: This is run by the	 default shell (usually COMMAND.COM) to 
execute commands at startup.

•	 CONFIG.SYS: This contains statements to configure DOS and load device drivers.

3.4	 Windows Operating System
In windows operating system, we can give commands to the computer by clicking on 
icons, menus and buttons by using a mouse. We do not need to remember commands 
to perform any tasks in the computer like MS-DOS.

Graphical User Interface (GUI)

With advancement of technology, computer system has become quicker and cheaper. 
Operating environment has also changed. This leads the development of graphical user 
interface where users can interact with the computer using picture and graphs, rather than 
character and commands. It displays the icon, buttons, dialog box etc. Popular GUI based 
operating system is Microsoft Windows.

Advantages of graphical user interface (GUI):

	Easiness for non-technical people

	Drag and drop feature

	Looks nicer than text interface

	Hot keys usage

	User-friendly

Disadvantages of graphical user interface (GUI):

	Difficult to develop and high cost

	Slower than command line tools

	Extra attention required



Computer Application/Grade 9
69

	Time consumption

	Memory resources

	Implementation

Examples of GUI

	Microsoft Windows, Mac OS

Difference Between GUI and CUI

S.N. GUI CUI
1. GUI is based on graphical user 

interface mode and instructions 
are given using graphical 
components like menu bar, 
toolbar etc.

CUI is based on command user interface 
mode and instructions are given using 
characters.

2. It is graphical and user friendly 
and easy to learn and operate.

It is more textual and less user friendly and 
difficult to operate and learn. User needs 
to memorize the commands to operate 
the system.

3. It consists of different components 
such as text box, icon, desktop, 
pointing devices etc.

It does not consist of such different 
components.

4. Eg. Windows, Linux OS Eg. MS-DOS, Unix OS

Working with a windows environment and windows application program desktop.

The desktop is the background displayed on your computer screen. It is the total visible area 
on the screen which users get immediately after turning on the computer. Files, folders, and 
program icons can be displayed on the desktop for easy access to users.

Desktop
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Desktop
On the desktop, files, folders and programs are displayed on window frame. The desktop 
may contain many items such as computer, network, eecycle bin, user, etc. The desktop 
can be customized with themes and backgrounds to personalize the look of the computer.

Start Menu

The start menu provides access to the most useful items on your computer including all 
programs, most recent documents, help and support and other items on your computer. 
Present Windows includes more Start menu customization options. This menu appears by 
clicking on the start button.

Startup Menu

Icons

Icons are the small graphical image used in GUI OS environment. It represents the symbolic 
meaning of the command, file, program, web page, etc. Icons help to execute commands, 
open programs or documents quickly. To execute a command by using an icon, click or 
double-click on the icon. An icon is a group of images of various formats (size and colours).

Icons
Window

Windows are frames on the desktop that contains the contents of opened files, folders, and 
programs. In other words, it is usually a rectangular portion of the display on a computer 
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monitor that presents its contents (e.g. the contents of a directory, a text file or an image) on 
the screen. Windows are one of the elements that comprise a graphical user interface (GUI). 

Task Bar

Task bar

The taskbar displays opened files, folders, and programs. When multiple windows are open, 
you can click on the file, folder or program buttons in the taskbar to switch between windows.

List of components of tasks bar:

1.	 Start button

2.	 Quick launch bar

3.	 System trays with some programs

4.	 Time Bar

All documents using the same extension have the same icon. Some folders can 
have a customized icon applied to them. The name of file, folder or program is 
displayed under the icon.

Computer

Computer
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Computer folder displays all hard disk drives and removable storage devices connected 
to your computer. Double-clicking on a drive or removable storage device displays its 
contents.

To open the computer Folder 

1. Click on start Icon>Computer or double-click on the Computer icon. 
Documents 

Documents folder provides a place to store all of your files. When you save a 
document, the default save location is the Documents folder: 

 
 
 
 
 

Fig. Documents 
To open the Documents Folder 

1. Click Start>Documents or Double-Click. 

2. Networks 
3. The Networks folder displays all the shared resources connected to your 

computer by a network. 
Networks 
The Networks folder display all the shared resources connected to your computer 
by a network. 

 
 
 

Fig. Networks 

To Open the Network Folders

1.	 Click start>Networks or Double-click on the networks.

Recycle Bin

When you delete a program, file or folder, it is moved to the recycle bin. The recycle bin 
gives you the opportunity of retrieving your deleted items later if you change your minds. 
Items in the recycle bin still take up hard disk space.

Networks

Documents
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  Recycle bin
When the recycle bin is full, Windows automatically cleans out enough space to accommodate 
the newest deleted items. By default, the recycle bin is located on your desktop.

To restore items from the recycle bin:

1.	 Double-click on the recycle bin on the desktop. This opens the recycle bin windows.

2.	 Select the items you want to restore.

3.	 Click the Restore this item link in the recycle bin tasks area.

Music

By default, the music folder is situated in the libraries folder. When you use windows 
media player to copy music from a CD or download music from the Internet, the default 
save location is the music folder.

 Music
To Open the Music Folder

1.	 Click start>Music.

Pictures

Pictures

By default, my pictures folder is situated in the libraries folder. When you save pictures 
from your digital camera or scanner to your computer or save a file in a graphics program, 
such as Microsoft Paint, the default save location is the pictures folder.
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To Open the Pictures Folder

1.	 Click start>My pictures.

2.	 Working with files and folders

Folder

Folders on a computer provide a storage system similar to folders in a filing cabinet. Folders 
can contain files and other subfolders. Window provide a number of personal folders to 
start your computer filing system. A folder is typically represented by a folder icon. The 
folder name is the icon. The folder in windows is also known as a directory in DOS.

Folder
Creating the Personal Folder on the Desktop

1.	 Right click on the desktop.

2.	 Select New>folder.

3.	 Give the name of the folder then press enter.

Operating a File or Folder

1.	 Double-click on the file or folder you want to open.

2.	 The file or folder is displayed in a window.

To Copy or Cut Files and Folders

1.	 Right click on the file or folder you want to copy or cut.

2.	 From the pop-up menu, select copy or cut.

3.	 Open the location you want the copied or cut item to be placed.

4.	 Right-click in the location.

5.	 From the pop-up menu, select paste.

To Rename Files and Folders

1.	 Right-click on the file or folder you want to rename.

2.	 From the pop-up menu, select rename.

3.	 Type a new name.

4.	 Press the enter key on your keyboard.
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To Delete a File or Folder 

1.	 Select the file or folder you want to delete.

2.	 Do right, click on the file or folder you want to delete.

3.	 From the pop-up menu, select delete.

or

1.	 Select the file or folder you want to delete.

2.	 Press the delete key on your keyboard.

Changing File and Folder Views

Changing file and folder views

To change how the files and folders within a folder are viewed:

1.	 Click the change your views option.

2.	 Select the file and folder view you want.

Display File and Folder Properties

Files and folders have property sheets that include information such as the type, size and 
location of file or folder; the date of a file or folder was created, modified or accessed; file 
and folder attributes; the name of the program that opens a file and the number of files or 
subfolders contained in a folder.

To display properties for files and folders within a folder window:

1.	 Select the file or folder (in the folder window) for which you want to display 
properties.
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2.	 Right –click on the file or folder for which you want to display properties.

3.	 From the pop-up menu, select properties.

Modifying Folder Options

1.	 Open the folder for which you want to modify.

2.	 Select organize> folder and search options.

3.	 This opens the folder options dialog box.

4.	 Make the folder modifications you want

5.	 Click OK.

Using Task Panels

Using Task Panel

Task panels provide an easy way to access the most commonly used folder tasks. The task 
panel displays a list of hyperlinked tasks to the left of the folder contents.

Several folders offer additional specialized hyperlinked tasks. For example, the pictures and 
Music folders offer links that help you manage your picture and music files. The recycle bin 
offers links to empty the recycle bin or restore items from recycle bin.

Computer folders offer links to view system information, add or remove programs, and 
change system settings.

Searching Files/Folders using Search Companion

Searching Files and Folder
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Enhanced for Windows 7, the Search Companion is designed to help you quickly find what 
you`re looking for.

1.	 Click start Icon

2.	 Type whatever you want to search.

3.	 Working with a Windows Application Program

Customizing the Desktop

By default, the Windows theme is applied the first time you start Windows. A desktop 
theme affects the whole look of your desktop.

Customizing the Desktop
To apply a desktop theme:

1.	 Right click a desktop.

2.	 From the pop-up menu, select personalize. This opens the personalization dialog 
box.

3.	 Select a theme from the theme option.

To apply a desktop background

1.	 Right click on the desktop
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2.	 From the pop-up menu, select personalize. This opens the personalization dialog 
box.

3.	 Click the desktop background option.

4.	 Select a background from background list.

5.	 Click on save changes.

Control Panel

As you have read earlier control panel is one of the most important system folders, which 
consists of various controlling programs icon to control an overall operation of the windows. 
The following is the sample of control panel.

Control Panel
Date and Time

With the help of this option, we can change/set our system date and time as we  need.

Date and Time
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Display

This option is to customize the desktop environment.

Keyboard

We can set keyboard settings like its character repetition and cursor blinking rate, a width 
of the cursor.

Program and Features

This option allows the user to do following things;

Allows users to uninstall and change existing software packages, as well as indicating how 
much space individual programs take and how frequently they are used.

1.	 Allows users to manually install software and install add-ons from windows update.

2.	 Allows users to change which windows components are installed.

Administrative Tools

This option contains tools for system administration, including security, performance, 
and service configuration. These are the links to various configurations of the microsoft 
management console such as the local services list and the even viewer.

Windows Keyboard Shortcuts
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3.5	 Open Sources Operating System
Open-source software (OSS) is a type of computer software whose source code is 
released under a license in which the copyright holder grants users the rights to 
study, change, and distribute the software to anyone and for any purpose. Open- 
source software may be developed in a collaborative public manner. According to 
scientists who have studied it, open-source software is a prominent example of open 
collaboration. The term is often written without a hyphen as "open source software".

Open-source software development, or collaborative development between multiple 
independent contributors, generates an increasingly more diverse scope of design 
perspective than any one company is capable of developing and sustaining long 
term.

Advantages of Open Source Software

1.	 These software are freely available and no license is required to use them. Source code 
of these software is freely available in the internet and it can be easily downloaded.

2.	 It has freedom at work. Everyone is free to modify the software according to the 
requirement from its source code.

3.	 The OSS allows to take our own security ownership.

4.	 There is no restriction of law to use them.

5.	 By adopting open source software, we become part of a community of users and 
developers.

Introduction to Linux

Linux is a free open-source operating system based on Unix. Linux was originally created 
by Linus Torvalds with the assistance of developers from around the globe. Linux is free to 
download, edit and distribute. Linux is a very powerful operating system and it is gradually 
becoming popular throughout the world.

Advantages of Linux

Low cost: There is no need to spend time and huge amount money to obtain licenses since 
Linux and much of it's software come with the GNU General Public License.

Stability: Linux has high stability compared with other operating systems. There is no 
need to reboot the Linux system to maintain performance levels.

Performance: Linux provides high performance on various networks. It has the ability to 
handle large numbers of users simultaneously.



Computer Application/Grade 9
81

Networking: Linux provides a strong support for network functionality; client and server 
systems can be easily set up on any computer running Linux. It can perform tasks such as  
network backup faster than other operating systems.

Flexibility: Linux is very flexible. Linux can be used for high performance server 
applications, desktop applications, and embedded systems.

Compatibility: It runs all common UNIX software packages and can process all common 
file formats.

Fast and easy installation: Linux distributions come with user-friendly installation.

Security: Linux is one of the most secure operating systems. File ownership and permissions 
make linux more secure.

Open source: Linux is an open source operating systems. You can easily get the source 
code for linux and edit it to develop your personal operating system.

Today, Linux is widely used for both basic home and office uses. It is the main operating 
system used for high performance business and in web servers. Linux has made a high 
impact in this world.

Introduction to UNIX

The Unix operating system is a set of programs that act as a link between the computer 
and the user. The computer programs that allocate the system resources and coordinate 
all the details of the computer's internals is called the operating system or the kernel. 
Users communicate with the kernel through a program known as the shell. The shell is a 
command line interpreter; it translates commands entered by the user and converts them 
into a language that is understood by the kernel. Unix was originally developed in 1969 by 
a group of AT&T employees Ken Thompson, Dennis Ritchie, Douglas McIlroy, and Joe 
Ossanna at Bell Labs.There are various Unix variants available in the market. Solaris Unix, 
AIX, HP Unix and BSD are a few examples. Linux is also a flavour of Unix which is freely 
available.

	 Several people can use a Unix computer at the same time; hence Unix is called a 
multiuser system.

	 A user can also run multiple programs at the same time; hence Unix is a multitasking 
environment.
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Exercise

Choose the correct answer from the given alternatives.
1.	 Which of the following is not an operating system?

a. Windows	 b. Linux	 c. Oracle	 d. DOS

2.	 Which of the following is a single-user operating system?

a. Windows	 b. MAC	 c. MS-DOS	 d. None of the above

3.	 Which one is the basic input device in GUI?

a. Mouse	 b. Graphics tablet	 c. Voice system	 d. Touch panel

4.	 Which component appears in the initial windows startup display?

a. Dialog boxes	 b. Task bar	 c. Star menu	 d. All

5.	 In which button the help menu is available?

a. Start	 b. Restart	 c. Turn off	 d. End

6.	 The ……… can be defined as the entire windows display and can be envisioned   of 
your own desk surface.

a. Dialog box	 b. Window	 c. Desktop	 d. All

7.	 To …….. a menu, click outside it or press (ESC).

a.  Close	 b. Open	 c. Either A or B	 d. Both A and B

8.	 You can switch from one program to another on the desktop by clicking within the 
desired program’s window or by clicking on its.

a. Task bar button	 b. Icon	 c. Folder	 d. Menu

9.	 When was UNIX developed ?

a. 1990	 b. 1890	 c. 1969	 d. 1976

10.	 Which kind of operating system is UNIX?

a. Multi user	 b. Multi processes	 c. Multi tasking	 d. All of the above
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Write short answer to the following questions. 
1.	 What is a file? How can you create a new folder?

2.	 Explain operating system with two examples.

3.	 List out the functions of MS DOS.

4.	 Distinguish between GUI and CUI.

5.	 Is UNIX a single user operating system?

6.	 How can you change the date and time in your computer?

7.	 If your file is deleted from your computer, how can you restore those files?

8.	 Write the features of OSS.

9.	 Which file of MS DOS contains all internal command?

10.	 What is Linux? What are its salience features?

11.	 List any two functions of an operating system.

12.	 Write one example of GUI operating besides Windows.

13.	 Why are most of the applications based on GUI?

14.	 Why are open source software useful?

Write long answer to the following questions.
1.	 Explain the types of operating system.

2.	 What is windows operating system? Explain.

3.	 Why is GUI operating software more popular than CUI? Give reason.

Project works
1.	 Be familiar with Windows Operating System, UNIX as well as Linux Operating 

System. 

2.	 Learn to install the computer system by giving connection and loading system 
software and application software.

3.	 Learn to install existing operating system. 
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Unit 4 Application of Software

4.1	 Introduction of Programming Language
The method used to develop a solution or a program is called programming. It is the 
way of writing program using specific computer language to perform specific task.

Computer Language (Code): The set of codes which is used to write computer 
program is called computer language. It is artificial language and can be used to 
define a sequence of instructions that can ultimately be processed and executed by 
the computer.

Source Program (Code): The original program written in high level language is 
called source program. It should be translated into machine code, so that computer 
understands and responses it.

Object Program (Code): The program converted into machine code by compiler is 
called object program.

Types of Computer Language 

Machine Level Language

The program written using machine code or binary numbers (0 and 1) is called machine 
level language. It is computer’s own binary-based language, or machine language which is 
difficult for human beings to use. It is machine dependent complicated and time consuming. 
It is also called first generation language.

Assembly Language

The language which permits the use of mnemonics (which are combination of codes and 
English phrases) for each instruction that machine can do is called low level language. 
It remains in between machine level language and high level language. It is easier than 
machine level language and should be translated into machine code using assembler. It is 
also called second generation language. Example pseudo programming.
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Advantages of Low Level Language

i)	 The computation time of an assembly language program is less.

ii)	 Program debugging is easier.

Disadvantages of Low Level Language

i)	 It is machine dependent.

ii)	 Too difficult to learn and implement.

Bug and Debug

When an error is found in a set of instructions given to a computer, it is called a bug. The 
process of finding the error in a set of computer instructions is called debugging.

High Level Language

The language which uses plain English words or phrases and mathematical notation, 
following the correct syntax (Certain rules which are followed to write programs) is called 
high level language. It should be translated into machine code using compiler or interpreter. 
So they are slower. It is also called third generation language. Example: QBASIC, C, C++, 
LOGO, LISP, ADA, PASCAL etc.

Advantages of High Level Language

	 It is very simple because plain English words are used for programming.

	 There are pre-defined commands, which minimize the work of programmers.

	 All the commands are syntax driven, so they are very easy to learn and implement.

Features of High Level Language

	 It is machine independent and problems oriented.

	 It does not require extensive mathematics knowledge and computer hardware 
knowledge.

	 It requires less time to learn and write the programs.

	 It provides better implementation and documentation.

Fourth Generation Language (4GL)

Fourth generation computer programming language (4GL) is closer to human language 
than other high-level languages and is accessible to people without formal training as 
programmers. They allow multiple common operations to be performed with a single 
programmer-entered command. They are intended to be easier for users than machine 
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languages (first-generation), assembly languages (second-generation), and older high-level 
languages (third-generation).

A 4GL normally contains utility software (tool) that interacts with the database management 
system (DBMS) software to store, manipulate and retrieve data needed to satisfy user 
requirements for information.

Merits of 4GL

1.	 Programming productivity is increased. One line of 4GL code is equivalent to several 
lines of 3GL code.

2.	 System development is faster.

3.	 Program maintenance is easier.

4.	 The finished system is more likely to be what the user envisaged, if a prototype is 
used and the user is involved throughout the development.

5.	 End user can often develop their own applications.

6.	 Programs developed in 4GLs are more portable than those developed in other 
generation of languages.

7.	 Documentation is improved because many 4GLs are self-documenting.

Demerits of 4GL

1.	 The programs developed in the 4GLs are executed at a slower speed by the CPU.

2.	 The programs developed in these programming languages need more space in the 
memory of the computer system.

4.2	 Types of Language Processor Software
Language processor: The set of program codes, which are used to translate program 
written in high level language or low level language into machine code, is called 
language processor. There are three types of language processor.

	Interpreter: The language processor which converts high level language 
and Low level language into machine code is called interpreter. It translates 
programming codes line by line so it is slower than compilers and assemblers.

	Compiler: The language processor which translates the program written in high 
level language into machine code is called compiler.

	Assembler: The language processor which translates the program written in low 
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level language into machine code is called assembler.

4.3	 List of High Level Programming Language
FORTRAN

It is a procedural, imperative, general purpose computer programming language that 
works well for scientific computations and numeric operations. After IBM developed 
it in the 1950s, it soon gained popularity in programming. It is very popular in the 
field of high-performance computing. It is a structured and compiled programming 
language that is a subset of Fortran95. Fortran 2003, a revised version of FORTRAN 
supports object-oriented programming.

COBOL

COBOL stands for common business-oriented language that is designed for the 
business and finance domain. COBOL 2002 standard supports object-oriented 
programming. It is one of the very old programming languages that are still in use.

BASIC

Developed by John George Kemeny and Thomas Eugene Kurtz at Dartmouth in 
1964, it is an acronym for Beginner’s All-purpose Symbolic Instruction Code. It was 
designed with the intent of giving the non-science people an access to computers.

PASCAL

Pascal is a procedural programming language that was intended to use data structuring 
and structured programming. Niklaus Wirth, a Swiss computer scientist designed 
this language and it was named after Blaise Pascal, a French mathematician and 
philosopher.

C Programming Language 

Dennis Ritchie at the Bell Telephone Laboratories developed C to be used on the 
Unix platform. It is a general-purpose, cross-platform, procedural, imperative 
programming language. It is used for implementing system software and application 
software and is one of the most-used computer programming languages today. The 
development of C++ and C# was influenced by C.

C++

C++ consists of a combination of high-level and low-level language features and 
is hence considered as a middle-level programming language. Bjarne Stroustrup of 
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Bell Labs developed C++ as an extension of the C language. Originally known as 
‘C with Classes’, it came to be known as C++ from 1983. It is a multi-paradigm 
language that supports procedural programming, generic programming, object- 
oriented programming, and data abstraction.

C #

C sharp is a multi-paradigm programming language that supports imperative, generic 
and object-oriented programming. It is a part of the microsoft .NET framework. It 
is similar to C++ in its object-oriented syntax and is also influenced by Java and 
Delphi.

JAVA

Java is a general-purpose computer programming language that is concurrent, class- 
based, object-oriented, and specifically designed to have as few implementation 
dependencies as possible. Compiled Java code can run on all platforms that support 
Java without the need for recompilation. It is a very popular language of the modern 
times.

Visual Basic

Visual basic is an event-driven programming language that is packaged with an 
integrated development environment. It inherits many of its features from BASIC. 
Its graphical development features make it easy for beginners to learn VB.

Visual FoxPro

Visual FoxPro is an object-oriented and procedural programming language derived 
from FoxPro. It is integrated with a relational database system of its own and does not 
require an additional programming environment. It supports dynamic programming.

XML

XML stands for Extensible Markup Language. It is extensible because it allows the 
users to define their own XML elements. It supports the sharing of structured data 
over the Internet and the encoding and serializing of data. It originated as a subset 
of SGML.

PHP

PHP is one of the very popularly used general purpose scripting languages. It is 
developed for creating dynamic web pages and supports a command line interface 
capability.
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4.4	 Difference between Program and Software
SOFTWARE

Software are made up of two or more than two programs. It instructs computer 
processor to perform specific operations.

(In simple words it gives instruction or data to central processor unit (CPU).

PROGRAMS

A computer program is a collection of instructions that performs a specific task when 
executed by a computer. A set of instructions tells a computer what to do (instruction 
is in the form code .binary.) A software can be program but a program cannot be 
software.

Software typically consists of files while programs can be files or even notes.

4.5	 Program Control Structures
The structures which regulate the order in which program statements are executed 
are called control structures. There are 3 types of control structure. They are:

Sequence

Sequence is the set of program instructions which follow one another and are to be 
executed unconditionally (not dependent on any program conditions). Instructions 
are put in a predefined sequence (just like a queue in a cinema hall) and the next 
instruction is executed by CPU only after the execution of the previous instruction 
(C never comes before B).

Selection

Selection is the set of instructions which are to be executed conditionally i.e. they 
are executed based on a condition that can be either true or false. Commonly used 
logic for selection are if condition, if else condition, if else if condition, nested if else 
condition and switch case condition.

If condition

If condition is used in case the given problem has only one condition and only one 
action. Considering either true or false part, if the given condition is true then the 
statement will be executed. Otherwise, the control exits from the condition.

Else If Condition
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This condition is used if the problem has one condition but two alternative actions. 
Here, if the condition is true, statement 1 will be executed; otherwise, statement 2 
will be executed.

Iteration

These are the computer instructions which are to be performed repeatedly and 
conditionally i.e. loop statements are driven by the loop condition. Commonly used 
logic for iteration are while loop, do while loop and for a loop.

While Loop

In this loop, first, the condition is checked by the computer and if the condition turns 
out to be true, then the statement inside the loop is executed. This process is repeated 
and the value of increment and decrement operator is always changing. When the 
condition is false, the loop stops.

Algorithm Syntax

Initialization while (condition)

	 {

		  Statements

		  ……………….

		  ………………. increment/decrement

	 }

Do While Loop

In this loop, first, the computer checks the initial value; second executes the 
statements inside the loop and finally, checks the condition. The process is repeated 
for next pass, if the condition is true. Otherwise, the loop stops. If the condition is 
initially false, it will execute for at least one time.

Algorithm syntax

Initialization do {

			   Statements

			   ………………..

			   ……………….. 

			   increment/ decrement
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				    } while (condition)

For Loop

It is the most commonly used loop. It consists of 3 expressions; initialization, 
condition and counter, which are defined within a statement.

Algorithm Syntax

For (initialization; condition; counter)

		  {

			   Statements

			   ……………….

			   ……………….

		  }

Where, initialization is starting point, the condition is stopping point and increment/ 
decrement is a counter.

4.6	 Program Design Tools
Also known as the programming tools, program design tools are the tools used to 
develop a program. While designing a program, different tools are required to solve 
several problems. Some of the frequently used tools are:

Algorithm

An algorithm is a sequence of instructions or step by step instruction to find the solution of 
a problem. An algorithm should be simple and clear. It must be to the point and should lead 
to the solution of the problem in a finite number of steps.

An algorithm is a collection of a finite number of instructions arranged in a sequence to find 
the solution of a problem.

Example 1: Algorithm for adding the two numbers.

Step 1: Start the program

Step 2: Input number x, y

Step 3: Read x, y

Step 4: Z = x + y

Step 5: Print Z
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Step 6: Stop the program

Example 2: An algorithm to go to the cinema and see a movie.

Step 1: Start the program

Step 2: Go to the cinema hall

Step 3: Is the ticket counter open?

Step 4: If it is not open, return home

Step 5: If it is open, buy a ticket

Step 6: Get into the cinema hall

Step 7: Watch the movie

Step 8: Return home

Step 9: End the program

Flowchart

A flowchart is a pictorial representation of an algorithm. We can also define it as a program 
planning tool for organizing a sequence of steps necessary to solve a problem, which is 
shown in terms of symbols.

Flowchart uses symbols that have geometrical shapes to indicate the different operations. 
These symbols are connected by flow lines which indicate the order of execution of the 
various activities. It is used by the programmers to develop programs and by system, 
designers to represent the overall system while analyzing and developing the system.
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Advantages of Flowchart

	 It is an independent language. So, the flowchart we design for programming in one 
language is applicable for programming in another language.

	 Once the flowchart is prepared, it is very easy to do the coding by looking at the 
algorithm.

	 It is very easy to understand the logic of program by designing the flowchart. Even 
people who don’t know the coding can understand the logic of a program with the 
help of flowchart.

	 Systematic debugging and testing is easily possible with the help of flowchart.

Disadvantages of Flowchart

	 Preparing a flowchart is a time-consuming process.

	 If there is a change in logic again, we have to develop the new flowchart.

	 Flowchart does not provide any convenient means to highlight the most important 
operation.

	 The flowchart is quite costly to produce and difficult to use and manage.

	 Complex and detailed charts can be laborious to plan and draw.

Symbols for Flowcharts
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Basic symbol for flowchart
Guidelines for Drawing a Flowchart

1.	 The title for every flowchart is compulsory.

2.	 There must be START and END point for every flowchart.

3.	 The symbols used in flowchart should have only one entry point on the top. The exit 
point for symbols (except for decision/diamond symbol) is on the button.

4.	 There should be two exit points for decision symbol; exit points can be on the bottom 
and one side or on the sides.

5.	 The flow of flowchart is generally from top to bottom. But in some cases, it can also 
flow to upward direction

6.	 The direction of the flow of control should be indicated by arrowheads.

7.	 The operations for every step should be written inside the symbol.

8.	 The language used in flowchart should be simple so that it can be easily understood.

9.	 The flow lines that show the direction of flow of flowchart must not cross each other.

10.	 While connecting different pages of the same flowchart, connectors must be used.
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Structured English (Pseudo code)

The general meaning of pseudo code is false code or fake code. Before we write a real 
program, we write a program that looks like a code on the basis of algorithm and flowchart, 
which may not be syntactically correct but looks like a program code is called Pseudo 
code. The instruction of pseudo code is written by using english phrase and mathematical 
expression. It has no hard or fast rules for writing instruction but the instruction is closer 
to high-level language instructions. Therefore, the pseudo code designers should have 
basic knowledge about high-level language before writing it. It is independent of any 
programming language.

Example: Pseudo code for calculating area of rectangle input length, breadth

Calculate area= length*breadth output area

Some solve algorithm and flowcharts

Example1: To calculate the area of a circle

Algorithm

Step1: Start

Step2: Input radius of the circle say r

Step3: Use the formula πr2 and store result in a variable AREA

Step4: Print AREA

Step5: Stop

Flowchart
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Example 2: Design an algorithm and flowchart to input fifty numbers and calculate their 
sum.

Algorithm

Step1: Start

Step2: Initialize the count variable to zero

Step3: Initialize the sum variable to zero

Step4: Read a number say x

Step5: Add 1 to the number in the count variable

Step6: Add the number x to the sum variable.

Step7: is the count variable in the memory greater than 50?

              If yes, display the sum: go to step 8.

              If No, Repeat from step 4

Step8: Stop

Flowchart

Example 3: Determine whether a student passed the exam or not:

Algorithm

•	 Step 1: Input grades of 4 courses M1, M2, M3 and M4,

•	 Step 2: Calculate the average grade with formula "Grade=(M1+M2+M3+M4)/4"
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•	 Step 3: If the average grade is less than 60, print "FAIL", else print "PASS".

Flowchart

Example 4: Convert temperature from fahrenheit (℉) to celsius (℃)

Algorithm

Step 1: Read temperature in fahrenheit,

Step 2: Calculate temperature with formula C=5/9*(F-32),

Step 3: Print C.

Flowchart

Structured English (Pseudo code)

The general meaning of pseudo code is false code or fake code. Before we write a real 
program, we write a program that looks like a code on the basis of algorithm and flowchart, 
which may not be syntactically correct but looks like a program code is called pseudo 
code. The instruction of pseudo code is written by using english phrase and mathematical 
expression. It has no hard or fast rules for writing instruction but the instruction is closer 
to high-level language instructions. Therefore, the pseudo code designers should have 
basic knowledge about high-level language before writing it. It is independent of any 
programming language.
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Example: Pseudo code for calculating area of rectangle input length, breadth

Calculate area= length*breadth output area

Some solve algorithm and flowcharts

Structured English (Pseudo code)

The general meaning of pseudo code is false code or fake code. Before we write a real 
program, we write a program that looks like a code on the basis of algorithm and flowchart, 
which may not be syntactically correct but looks like a program code is called pseudo 
code. The instruction of pseudo code is written by using english phrase and mathematical 
expression. It has no hard or fast rules for writing instruction but the instruction is closer 
to high-level language instructions. Therefore, the pseudo code designers should have 
basic knowledge about high-level language before writing it. It is independent of any 
programming language.

Example: Pseudo code for calculating area of rectangle Input length, breadth

Calculate area= length*breadth output area

4.7	 Introduction to QBASIC
Q-BASIC is a high level programming language developed by Microsoft Corporation, 
USA for microcomputers in 1985. It uses interpreter as a language translator program. 
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It uses a set of keywords and mathematical symbols to write programs. The programs 
written in QBASIC need to be converted into machine codes by using interpreter.

4.7.1	Elements of QBASIC
The elements used in Q basic are as follows:

Character set

Variables

Constants

Operator and Operands

Expression

Statements

Character Set

QBASIC has the character set consisting of the following elements:

1.	 Alphabets: A, B, C,. Z

2.	 Digits: 0, 1, 2. ,9 and

3.	 Special characters: + - * / ( ) . , $ ; ,: ,= ,> ,< , ^

The symbol ̂  (caret) is used to denote exponentiation operator, the symbol * (asterisk) 
is used to denote multiplication and other symbols which have their usual meanings.

Constants

A quantity in a computer program which does not change its value during the execution of 
the program is called a constant. QBASIC allows the following constants:

Numeric Constant

The numeric constant is one that is formed by a sequence of digits 0, 1, 2,. 9 and may 
include a decimal point. A numeric constant may be an integer or a real number. 383, +57, 
0, -6.2 and 6.15E4 are valid numeric constants. The number 6.15E4, in fact, represent 6.15 
* 104. The notation E is used to represent the exponential form. The number after E is the 
exponent which can be positive or negative. However, its length cannot exceed two digits.

String Constant

A string constant consists of a sequence of characters which must be enclosed by a quotation 
mark.
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Variables

The quantity which may change its values during the execution of the program is called 
the variable.

In QBASIC, variables are also of two types:

	 Numeric Variable: Numeric variable can assume numeric value and is represented 
by an alphabet or an alphabet followed by another alphabet or digit. For example A, 
C, A2, ABC, A6 etc, represent numeric variables.

	 String Variable: A string variable is represented by an alphabet followed by dollar 
($) sign. It should be kept in mind that while constructing the string variable, dollar 
($) should be the last character. For example, B1$, NAME$, BOOK1$, etc. are valid 
string variables.

Expression

An expression can be a string, or numeric constant, a variable or a combination of   constants, 
variables with operators which return a single value.

Operands

Operands are the data or variables on which mathematical, logical and string operations 
take place.

Operators

Operators are the symbols, which are used to perform specific task such as arithmetic 
operations, logical expressions, and string expressions.

Statements

A statement is a set of instructions written using keywords or commands of QBASIC. 
Every programming language uses keywords as a statement with certain syntax.

4.7.2	QBASIC Statement
A statement (for the QBASIC) is a set of instructions written by using keywords 
or commands of QBASIC. Every programming language uses keywords as a 
statement with certain syntax. The keywords have specific meaning in the QBASIC 
programming. The statements are the first stored in the memory and executed only 
when the RUN command is given.
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The different types of statements used in QBASIC are as follows:

	Declaration statement

	Assignment statement

	Input/output statement

	Control statement

Declaration Statement

The statements which are used to define and declare the values, variables, constants etc for 
programming purpose are known as declaration statement. The declaration statements are 
DIM, REM, CONST, DECLARE, etc.

REM Statement

REM statement is a basic declaration statement that allows explanatory remarks to be 
inserted in a program. The remarks may be useful in a program to explain about different 
kinds of statements and user defined words. Adding comments in the program allows us to 
remind about the program and also helps other programmers to understand the logic of the 
program.

Syntax: REM < Remarks>

CONST Statement

The statement declares one or more symbolic constants in program.

Syntax CONST constantname = expression [,constantname = expression]...

Constant name The name of the constant. This name can consist of up to 40 characters 
and must begin with a letter

Valid characters are A-Z, 0-9, and period (.)
Expression An expression that is assigned to the constant can consist of literals 

(such as 1.0), other constants, any arithmetic or logical operators except 
exponentiation (^), or a single literal string

Example CONST PI = 3.141593

DIM Statement

DIM declares an array or specifies a data type for a non-array variable.
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Syntax 

Example

CLS

Const pi = 3.14 

Dim r as single

    r = 5

 a= pi *r^2

 PRINT "area of circle ="; a 

END

DIM [SHARED] variable [(subscripts)] [AS type] [, variable[(subscripts)] [AS type]]...

SHARED Specifies that variables are shared with all SUB or FUNCTION

procedures in the module

Variable The name of an array or variable
Subscripts Dimensions of the array, expressed as follows:

[lower TO] upper [,[lower TO] upper]...
Lower The lower bound of the array's subscripts. The 

default lower bound is zero
Upper The upper bound

AS type

Declares the data type of the array or variable

(INTEGER, LONG, SINGLE, DOUBLE, STRING, or a user-defined data type).

Assignment Statement

The statements which are used to assign the value to the related variable are known as 
assignment statements. The assignment statements are let, swap, etc.

LET Statement

LET is an assignment statement. It is used to assign the value to a variable. LET is an 
optional statement i.e. without using LET statement one can assign the value to a variable. 
The data type must match with the variable type otherwise type mismatch error will occur.

Syntax: |LET| variable = value or expression
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Example

CLS

INPUT " First number"; A

INPUT "Second number"; B

 LET S = A+B

PRINT " The Sum is"; S

 END

Read Data Statement

It is used in conjunction with the DATA command which lets QBASIC to read data. It is 
used mostly when dealing with large quantities of data in program.

Example

CLS

READ A, B, C

PRINT A, B, C DATA 15,25,35 

      END

Input/Output Statement

The statements which are used to provide input to variables of QBASIC program for 
processing and display the result as output on the screen are known as input/output 
statement. The input/output statements are: CLS, INPUT, LINE INPUT, PRINT, PRINT 
USING etc.

CLS Statement

The CLS statement clears the screen. If you write CLS statement in the middle of the 
program, then, you cannot see the outputs generated before execution of CLS because it 
clears the screen.

Syntax: CLS

INPUT Statement

It receives input from the keyboard during the execution of the program.

Syntax: INPUT [“Message”] ; variable
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PRINT Statement

PRINT statement provides output on the screen. It prints the values of the expression on the 
screen. If the expression list is blank, no characters are printed. The expressions in the list 
may be numeric or string. In case of number, the negative number is preceded by a minus 
sign (-) but in positive number it is preceded by a space.

We can use semicolon and comma with a print statement which results differently than 
a normal PRINT statement. If expression list ends with comma or semicolon, the next 
PRINT statement prints on the same line. Comma provides a TAB space but semicolon 
provides only one space.

Syntax: PRINT ["Message"]; expression

Example

CLS

PRINT "We live in Nepal."

PRINT

PRINT "Nepal lies in between India and China."

PRINT 2076

PRINT "The number is:"; 7

END

Output

We live in Nepal.

Nepal lies in between India and China.

 2076

The number is: 7

LINE INPUT

This statement allows inputting line of data at a time and assigning in to single Variable.

Syntax: LINE INPUT “string”; string variable

Example

CLS

LINE INPUT “please enter the data”; n$ 

PRINT n$

END



Computer Application/Grade 9
105

4.7.3	Control Statement
The statements which are used to transfer the control of the program from one part to 
another part with or without condition are known as control statements. The control 
statements are IF THEN, SELECT CASE, FOR NEXT, DO LOOP, ON GOTO etc.

GOTO Statement

The GOTO is a jumping statement which jumps from one point to another point within 
program. It is used to transfer the control from one point of the program to another point 
without testing a condition. The GOTO statement is marked by label statement. It sends the 
controls to the labeled block and starts executing.

Syntax: GOTO <label / line number> where label is a name followed by a colon.

Example

CLS

INPUT "ENTER YOUR AGE"; A

IF A>18 THEN GOTO TEST1 ELSE GOTO TEST2 TEST1:

PRINT "YOU ARE ELIGIBLE FOR VOTE" 

GOTO LAST

TEST2:

PRINT "YOU ARE NOT ELIGIBLE FOR VOTE"

 LAST:

END

1.	 If– Then Statement

When there is a single option to be executed on the basis of true result of a condition, 
then ' if – then –end if ' statement used. So, there is a test for a condition in 'if – then' 
statement and if the result of the condition is found to be 'TRUE', then the statement 
of 'If- Then' block is executed and if the result of the condition is FALSE, then there 
is no statement to execute. In such case, simply the program execution goes to the 
line below the END IF statement. So, it performs when the condition is only TRUE.

Syntax

If [condition] then

          Block of statements

End If
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Example

CLS

Input "Enter your age"; a

	 If a<=10 then

	 Print "Child"

	 End if

End

2.	 If Then Else Statement

When there is a need to select an option to be executed out of two options on the basis 
of two conditions, the 'if – then – else statement is used but the second condition is 
seldom checked. So, there is a test for a condition in if – then – else ' statement and if 
the result of the condition is found to be true, then the block of statement associated 
with 'if' part is executed otherwise the block of statement associated with 'Else" part 
is executed. There is no chance to execute both if and else part within a single if – 
then – else statement.

Syntax

If [condition] then 

Block 1 of statements

	 Else

		  Block 2 of statements

End if

Example

CLS

INPUT "ENTER A NUMBER"; N IF N MOD 2 = 0 THEN

	 PRINT "EVEN NUMBER" 

	 ELSE

		  PRINT "ODD NUMBER"

	 END IF

END



Computer Application/Grade 9
107

3.	 If Then Else If Statement

When there is a need to select an option to be executed out of multiple options based 
on multiple conditions, the 'if – then – else if statement is used. If none of condition 
is true, then statement associated with 'else' part is executed.

Syntax

If [condition1] then 

Block 1 of statements

 Elseif [condition2] then 

Block 2 of statements Elseif[condition3] then 

Block 3 of statements

…………………….

……………………

………………….

Else

Block 'n' of statements

End if

Example

REM POSITIVE, NEGATIVE OR NEUTRAL NUMBER

 CLS

INPUT "ENTER A NUMBER"; N

 IF N > 0 THEN

PRINT "POSITIVE NUMBER"; N

 ELSEIF N<0 THEN

PRINT "NEGATIVE NUMBER"; N 

ELSE

PRINT "NEUTRAL NUMBER"; N 

END IF

END

REM program to enter a number and check it is less than 10 or not 

CLS
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INPUT ‘’Enter a number: ”;N

IF N<10 THEN

PRINT “It is less than ten”;N

ELSE

PRINT “it is more than ten”;N

END IF

END

LAB PRACTICE 1

REM program to enter any two number and check find the greater one

CLS

INPUT “Enter first number:”;N1

INPUT “Enter second number:”;N2

IF N1>N2 THEN

PRINT “the first number is greater”;N1

ELSE

PRINT “the second number is greater”;N2

END IF

END

4.	 IF…….ELSEIF……ENDIF Statement

These blocks of statements allow you to have more than one IF….THEN statements 
in the same program.

Syntax:

IF conditioon1 THEN

     Statement block1

ELSEIF condition2 THEN

     Statement block 2

ELSEIF CONDITION 3

      Statement block 3

ELSE
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       Statement block 4

END IF

LAB Practice 2

REM program to enter any three numbers and find the greatest number 

CLS

INPUT “Enter the first number” , a

INPUT “Enter the second number” , b

INPUT “Enter the third number” , c

IF a>b AND a>c THEN

     PRINT “First number is greatest “;a

ELSEIF b>a AND b>c THEN

     PRINT “Second number is greatest” ;b

ELSEIF c>a AND c>b THEN

     PRINT “Third number is greatest” ;c

ELSE 

     PRINT “Third number is greatest”;c

ELSE

PRINT “All are equal”

ENDIF

END

Press F5

Enter the first number? 10

Enter the second number? 15

Enter the third number? 20

Third number is greatest 20

LAB PRACTICE 3

REM program to enter any number from 1 to 7 and print the matching day 

CLS

INPUT “Enter any number”; Num
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IF Num =1 THEN

     PRINT’’IT’S Sunday’’

ELSEIF Num =2 THEN

      PRINT “It’s Monday’’

ELSEIF Num =3 THEN

      PRINT “It’s Tuesday”

ELSEIF Num =4 THEN

      PRINT “It’s Wednesday”

ELSEIF Num =5 THEN

      PRINT “It’s Thursday”

ELSEIF Num =6 THEN

      PRINT “It’s Friday”

ELSEIF Num =7 THEN 

      PRINT “It’s Saturday”

ELSE

       PRINT “Invalid number”

END IF

END

Select… Case... Statement

Select case is also the multiple branching statements. It is used to execute one of several 
statement blocks depending on the value of an expression.

Syntax

Select case test expression Case test1

Statements

 Case test 2 Statement

 Case Else

Statement End Select

Example

CLS

INPUT "ENTER AGE OF A PERSON"; A
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SELECT CASE A

  CASE 1 TO 12

PRINT"CHILD " 

  CASE 13 TO 19

     PRINT"TEENAGE "

   CASE 1 TO 12

PRINT"CHILD " 

   CASE 20 TO 40

PRINT"YOUNG " 

   CASE 41 TO 70

PRINT"OLD "

   END SELECT

END

EXAMPLE 2

CLS

INPUT “Enter your name: “, Name$

SELECT CASE Name$

CASE “Ram”

       PRINT “Greetings, oh powerful master”

CASE “Hari” 

       PRINT  “Go away!”

CASE ELSE

        PRINT ‘Hello, “;Name$;”. How are you?’’

END SELECT

END

4.7.4	Looping in QBASIC
A LOOP is defined as a set of instructions that repeat a block of statements to given 
number of times or till the given condition is satisfied or until a certain condition 
becomes true. Programming process jumps forwards and backwards in looping. 
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Loop helps us to do more works with lesser number of statements.

There are three loop statements in QBASIC:

1.	 FOR...........NEXT

2.	 WHILE ..............WEND

3.	 DO.........................LOOP

4.	 DO WHILE/UNTIL...............LOOP

5.	 DO......................LOOP WHILE/UNTIL

1.	 FOR...............NEXT Statement

Repeats a block of statements for a specified number of times.

Syntax

For counter = start To end [Step step] 

	 [Block of statement to be executed]

	 [Exit For]

	 [Statements]

Next

NEXT counter

Where, counter is a numeric variable used as the loop counter. Start and end are the initial 
and final values of the counter. Increment/decrement is the amount the counter is changed 
each time through the loop.

2.	 WHILE ... WEND loop

In a WHILE ... WEND loop, if the condition is True, all statements are executed until 
WEND keyword is encountered. If the condition is false, the loop is exited and the 
control jumps to very next statement after WEND keyword.

Syntax

WHILE conditions

{block of statements}

WEND

Example

i=10 
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While i>5 

Print “hello”

 i=i-1 

Wend

Example 

Write a program to print sum of first 5 even numbers

CLS

I= 1

WHILE I<=10

          NO

          PRINT I;

          I = I +1

WEND

END

Example

REM generate the following numbers 2,4,6,8,10.....50

CLS

I= 2

WHILE I< = 50

       PRINT I;

       I= I+2

WEND

END

Example

REM to print numbers stated below 1,3,5,7,9,.......99

CLS

I= 1

WHILE I<=99
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      PRINT I;

      I= I+2

WEND

END

Example

REM to print numbers stated below 1,4,9,.....up to 10th term.

CLS

1=1

WHILE I<=10

     PRINT I^2;

     I=I+1

WEND

END

Example

REM to print numbers stated below10,9,8,7.....up to 1.

CLS

I=10

WHILE I>1

        PRINT I;

        I= I-1

WEND 

END

3.	 DO-LOOP statement

Repeats a block of statements while a condition is true or until a condition becomes 
true.

Syntax 1: (pre-test)

DO (WHILE | UNTIL) Condition

(Block of statement to be executed)
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Loop

Example 12

CLS

CNT =1

DO WHILE CNT <=10

          PRINT CNT ^2

           CNT =CNT +1

LOOP

END

Part Description
Counter Numeric variable used as a loop counter. The variable can't be an array 

element or an element of a user-defined type.
Start Initial value of counter.

End Final value of counter.

Step Amount counter is changed each time through the loop. If not specified, 
step defaults to one.

statements One or more statements between For and Next that are executed the specified 
number of times.

Remarks

The step argument can be either positive   or   negative.   The   value   of the step argument 
determines loop processing as follows:

Value Loop executes if

Positive or 0 counter <= end

Negative counter >= end

Once the loop starts and all statements in the loop have executed, step is added to counter. 
At this point, either the statements in the loop execute again (based on the same test that 
caused the loop to execute initially), or the loop is exited and execution continues with the 
statement following the Next statement.
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Some solved QBASIC questions.

1.	 REM DISPLAY FROM 1 TO N NUMBER

 CLS

INPUT “ENTER THE VALUE OF N"; N

 FOR I =1 TO N

PRINT I;

 NEXT I

 END

2.	 Write a program to display Fibonacci series 2,2,4,6,10,16,…, up to 10th terms.

CLS 

A=2

 B=2

	 FOR J=1 to 10 PRINT A;

	 C=A+B

 A=B

 B=C

	 J= J+1

	 NEXT	

END

3.	 Write a program to display the reverse word for any entered word by a user.

CLS

INPUT “Enter any word ”;n$ 

FOR j=LEN(n$) TO 1 STEP -1

C$=MID$(n$,j,1) Rev$=Rev$+C$

NEXT	 j

PRINT “The reverse word is ”;Rev$ 

END

4.	 Write a program to find the greatest number among any 10 numbers entered by 
a user using an array.

CLS
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OPTION BASE 1

	 DIM n(10)

PRINT “Enter any 10 numbers” 

FOR j=1 TO 10

INPUT n(j)

        NEXT j

FOR k=1 TO 10

IF n(k)>g THEN g=n(k)

 NEXT k

PRINT “The greatest number is ”;g 

END

5.	 Use of LEFT$ with FOR…NEXT

CLS

C$= “NEPAL”

FOR J=1 TO 5

      L$= LEFT$(C$,J)

PRINT L$

NEXT J

END

OUTPUT

N

NE

NEP

NEPA

NEPAL

RIGHT$( )

The function returns specified number of characters from the right of the supplied string.
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6.	 Solved example                                                                                   

CLS

C$=’’NEPAL’’

        FOR J=1 TO LEN (C$)

        R$= RIGHT$(C$,J)

PRINT R$

NEXT J

END

OUTPUT

L

AL

PAL

EPAL

NEPAL
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Exercise

Choose the correct answer from the given alternatives.
1.	 A program that can execute high-level language programs...........

a. compiler	 b. interpreter	 c. sensor	 d. circuitry

2.	 Identify a fourth generation language (4GL) from the given below......

a. FORTRAN	 b. COBOL	 c. Unix shell	 d. C++

3.	 Assembler is………

a.	 a program that accepts a program written in a high level language and produces 
an object program 

b.	 a program that places programs into memory and prepares them for execution

c.	 a program that automate the translation of assembly language into machine 
language

d.	 is a program that appears to execute a source program as if it were machine 
language

4.	 Which of the following used to convert high-level language instruction into machine 
language?

a. An operating environment	 b. Application software

c. System software		 d. An interpreter

5.	 The language processor which translates the program written in low level language 
into machine code is………………

a. Interpreter	 b. Compiler	 c. Assembler	 d. None

6.	 A language supported by MS. Net platform...........

a. C	 b. C++	 c. Java	 d. C#

7.	 In which structure charts modules are described as........

a. Circle	 b. Triangles	 c. Rectangle	 d. Ellipse

8.	 “Name$” is known as a......

a. String	 b. Constant	 c. Variable	 d. Input driver
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9.	 What must you do if a “Syntax Error” appears?

a.	 Check for flaws, edit, and return.it may be a programmer’s error .

b.	 Close the program

c.	 Delete it

d.	 None of the above

10.	 An algorithm is:...........

a.	 The output of the instruction to the computer.

b.	 The required data to be processed.

c.	 A finite sequence or series of precise instructions and problem solving methods.

d.	 problem definition

11.	 In which language, instructions are given in the form of strings of 0’s and 1’s?

a.	 Assembly Language

b.	 Machine Language

c.	 High Level Language

d.	 None of These

12.	 Choose the language in which instructions are given in the form of short words 
called mnemonics.....

a.	 High Level Language

b.	 Machine Language

c.	 Assembly Language

d.	 None of These

13.	 Choose the area in which you will type the instructions or programs....

a.	 Status

b.	 Work Area

c.	 Menu Bar

d.	 All of these

14.	 Which shortcut is used to run a QBASIC program from the key board press?

a. F6	 b. F5	 c. F11	 d. Ctrl+R
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15.	 Which do not change during the execution of the program?

a. Variables	 b. Constants	 c. Command	 d. None of these

16.	 Rules for naming a variable in QBASIC are.........

a.	 The first character of the variable should be alphabet.

b.	 It should not contain any special character except ‘_’ (Underscore).

c.	 Both of these

d.	 None of these

17.	 The______________Command is used to assign or give a value to a variable.

a. Print	 b. Input	 c. Let	 d. Rem

18.	 What will be the output of the given QBASIC Code: A=100

B=200

PRINT “A+B”; A+B

a. 300  300

b. A+B 300

c. 300 A+B

d. A+B A+B

19.	 Which statement is used to clear the output screen?

a. CLEAR	 b. CLS	 c. CS	 d. None of these

20.	 Which is used to give remarks or comments in a program?

a. REM	 b. INPUT	 c. CLS	 d. None of these

21.	 Which is used to take a value from the user and store it in a variable?

a. Print	 b. Input	 c. Rem	 d. LET

22.	 If value of A=6 and B=2 then what will be the value of A^B?

a. 16	 b. 12	 c. 3	 d. 36

23.	 An example of conditional statement is the..............

a. If…. Then statement	 b. Input Statement

c. Print Statement		  d. Let Statement



Computer Application/Grade 9
122

24.	 An example of relational operator is ______.

a. =	 b. AND	 c. +	 d. All of these

25.	 A collection of statements written using a programming language to give the 
instructions to the computer is ______.

a. Program	 b. Variable	 c. Constant	 d. Operator

Write short answer to the following questions. 
1.	 Which is computer's native language? Which codes are used by Assembly language?

2.	 Write two examples of high level programming language. Which type of language is 
known as first generation programming language?

3.	 Which language is used to write algorithm? Which symbol is used to put processing 
in flowchart?

4.	 What is the extension of Q basic program file? Which key is used to run Q basic 
program? Which operator is used to perform addition in Q basic?

5.	 What are the lists of high level programming language? Explain 

6.	 Distinguish between program and software.

7.	 What is control structure? Write its type.

8.	 What are the elements of Q basic?

9.	 What are the different types of Q basic statement?

10.	 What is language processing software? Write its types.

11.	 Differentiate between compiler and interpreter.

12.	 Define term program and programming. 

13.	 What is programming language? Write its types.

14.	 What is machine level language? Write its features.

15.	 Why is pre planning necessary before writing actual program?

16.	 What are characters set used in Q basic while programming?

17.	 Why is source code needed to convert into machine code?

Write long answer to the following questions.
1.	 What is programming language? Explain machine level and assembly level 

programming language.

2.	 What is high level language? Write its features.



Computer Application/Grade 9
123

3.	 What is programming tool? Discuss the role of algorithm to design effective program.

4.	 Explain flowchart with the common symbols used in it.

5.	 What is Q basic programming language? Discuss its features.

6.	 How can you convert the source code to machine code using Interpreter, Complier 
and Assembler?  Describe in details.

Project works
1.	 WAP to display all natural number from 1 to 100.

2.	 WAP to display all natural numbers from 1 to 100 in descending order.

3.	 WAP to display all even number from 2 to 50.

4.	 WAP to display all even numbers from 1 to 100.

5.	 WAP to display 5,10,15,……50.

6.	 WAP to display 100,90,80…..10.

7.	 WAP to display 2,4,6,8,… 12th term.

8.	 WAP to display 1,8,27,…..12th term.

9.	 WAP to display 4,6,10,16,26…10th term.

10.	 WAP to display 5, 55, 555, 5555,  55555.

11.	 WAP to display 33333, 3333, 333, 33, 3.

12.	 WAP to display 7, 22, 11, 34, 17, 52, 26, 13, 40,20.

13.	 WAP to display all natural numbers from 2 to 100 and also its sum. 

14.	 WAP to calculate sum and average of N natural numbers.

15.	 WAP to show the multiplication table of 6.

16.	 WAP to print the multiplication table of an input number.

17.	 Write an algorithm and flowchart to check whether a number is odd or even.

18.	 Write an algorithm and flowchart to check the greater among three entered number.

19.	 Write an algorithm and flowchart to check whether entered number is prime or 
composite.

20.	 Write an algorithm and flowchart to input marks of five subjects and their average.

21.	 Write an algorithm and flowchart to calculate sum of even numbers from 2 to 100.
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QBASIC

1.	 WAP to input a number and check smallest number among three entered numbers.

2.	 WAP to input a number then check and display whether it is positive, negative or 
zero.

3.	 WAP to check and print whether entered number is exactly divided by 3 and 5 (both) 
or not.

4.	 WAP to display your name 20 times using FOR….NEXT statement.

5.	 WAP to display first 10 even numbers starting from 2.

6.	 WAP to print multiplication table of entered number upto its ten multiples. 

7.	 WAP to display the following numeric series.

a)	 1  4  9   16……..upto 10th term

b)	 5  10  20  40…………upto 10th term

c)	 128  64  32  16 ……upto 7th term

d)	 100  90  80……..upto 10

e)	 2  2  4  10  16  26  upto 10th term

f)	 1  11  111  1111 11111

g)	 1  12  123   1234   12345

h)	 1

2 2

3 3 3

4 4 4 4

5 5 5 5 5 
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5.1	 Word Processing Software
Word processor software is an application package that allows a user to create, 
edit, store and print out text based documents. Word processing is the techniques 
of creating, formatting, editing and manipulating documents, reports, etc. Most 
modern companies that have a need for producing business letters or other types of 
text documents will have access to word processing software and a printer.

Some of the widely used computer word processing software are Microsoft Word, 
Word Perfect, Word Star, Word Pad, Vim Editor etc.

Types of Word Processing Software Microsoft Word

Microsoft Word is a widely used commercial word processor designed by Microsoft. 
Microsoft Word is a component of the Microsoft Office suite of productivity software, but 
can also be purchased as a stand-alone product. It was initially launched in 1983 and has 
since been revised numerous times. Microsoft Word is available for both Windows and 
Macintosh operating systems. Microsoft Word is often called simply Word or MS Word.

Microsoft Word offers several features to ease document creation and editing, including:

•	 WYSIWYG (what-you-see-is-what-you-get) display: It ensures that everything 
displayed on screen appears the same way when printed or moved to another format 
or program.

•	 Spell check: Word features a built-in dictionary for spell checking; misspelled 
words are marked with a red squiggly underline. Sometimes, Word auto- corrects an 
obviously misspelled word or phrase.

•	 Text-level features such as bold, underline, italic and strike-through

•	 Page-level features such as indentation, paragraphing and justification

The default file format was .doc prior to the Microsoft Word 2007 version; in 2007, 
.docx became the default file format.

Unit 5A. Application of Software
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5.1.1	Word Perfect
WordPerfect is a word processing application from Corel Corp. WordPerfect was 
popular in the early 1990s. It is best for writing simple essays and articles. Though it 
isn't used as much today, WordPerfect is compatible with Microsoft Word, meaning 
that you can open and edit WordPerfect files in the Word program, then save them 
as WordPerfect files again. WordPerfect also can be used for formatting and laying 
out documents.

Lotus Word Pro

If you use Lotus Notes or Lotus 1-2-3--common in corporate environments--Lotus Word 
Pro is an ideal program for your word processing needs. This program works in concert 
with Lotus applications to allow you to create and distribute formatted text documents. It 
is produced and distributed by IBM Corp. Lotus Word Pro is also compatible with Microsoft 
Word and ideal for writing reports, memos and proposals.

Uses of Word Processor

Word processors have a variety of uses and applications within the business world, home, 
and education. Businesses tend to have their own format and style for any documents 
produced. In Business word processing is used for legal copies, letters and letter head, 
memos,  reference documents etc.

Many homes have word processors on their computers, in the home word processing tends 
to be educational, planning or business related, dealing with assignments or work being 
completed at home, or recreational.

In education word processing is used in a variety of different ways in the production of 
assignments, notes, exams, and for practicing its uses!

Word Processor's Interface

Word processor interface consists of main editing window; it displays a document and 
several tools to manipulate it. Tools are grouped together in different toolbar in order to work 
with document.

Title Bar

Title bar is located at the top of the screen. Word processor displays the name of the current 
document on it.

Figure 56: MS-Office Word
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Menu bar

Each word on the menu bar represents a different menu. Each menu contains different 
commands of word.

Standard Bar

Standard bar displays some of the most common word processing tasks. The tasks are 
opening, copying and printing files etc.

Formatting Toolbar

Formatting toolbar is used to access various formatting commands quickly such as font 
type, font style and text alignment etc.

Status Bar

The status bar is a horizontal area at the bottom of the document window. It provides 
information about the current state of the documents.

Scroll Bars

Scroll bars are used to move in the document. You can scroll the document by clicking the 
scroll arrows at either end of the scroll bar or by dragging the scroll button in scroll bar.

Rulers

The horizontal ruler can be used to set tab stops and indents or to adjust the width of 
columns. The horizontal or vertical ruler can also be used to change the page margins or 
place items on the page.
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Enter and Edit Text Formatting

The processing of typing text in a document is called entering text. The processing of 
changing the existing document is called editing text. The word processor places a blinking 
insertion point at the top left corner of screen. It is known as cursor. Te cursor indicates 
the location where the next character will be placed in the document. The cursor moves 
forward on the screen as the user types. The cursor moves to the next line as it reaches the 
end of line.

Word process allows the user to change some text without retyping the whole document. 
It is different from type writer where the user has to type whole document again. There are 
many ways to edit an existing document.

1.	 Typing Modes

All word processor provide two modes of typing. These are as follows:

i.	 Insert Mode

Insert mode is used to insert text in the existing document. The existing character 
moves to the right side when the user types a character. It is the default mode of MS 
word. The following procedure is used to write text in insert mode:

1.	 Place the cursor where the text is to be typed in insert mode.

2.	 Make sure that [OVR] option on status bar is not highlighted. If it is highlighted, 
press insert key to disable it.

3.	 Type any text. The existing text will move to the right side and new text will 
appear.

ii.	 Overtype Mode

In overtype mode, the new character replaces the existing characters. The following 
procedure is used to write text in overtype mode:

4.	 Place the cursor where the text is to be typed in overtype mode.

5.	 Press the insert key, the overtype mode will be activated. The [OVR] option 
on status bar will be highlighted.
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6.	 Type any text. The existing text will be overwritten by the new text.

7.	 Erasing Text

	 Two keys on the keyboard are used to erase text from a document. These are:

ii.	 Delete Key

The delete key erases the character to the right of the cursor.

iii.	 Backspace Key

Backspace key erases the character to the left of the cursor.

The delete and backspace keys erase one character at a time. The user can select 
multiple characters and then press delete key to delete all selected characters.

iv.	 Undo and Redo

Undo command is used to remove the effect of the last action or number of actions. 
Redo command is used to remove the effect of undo command.

8.	 FormattingText

Formatting of a document includes:

i.	  Changing the appearance of the text.

ii.	 Adding picture and graphics

iii.	 Controlling the layout of the text on the page.

The formatting toolbar is the easiest way to change any attribute.

Paragraphs Formatting

A paragraph is a unit of text or other content that starts at the beginning of a document, 
immediately after a hard return (a carriage return), a page break, or a section break, or at 
the beginning of a table cell, header, footer, or list of footnotes and ends with a hard return 
(carriage return) or at the end of a table cell. Word documents generally contain paragraphs 
with different formatting. Even a very simple document with a centered heading and a 
justified body contains paragraphs with two different types of formatting.

Word's graphical user interface (GUI) provides ways to apply numerous formatting options 
to your paragraphs. However, these options are not available in a single location, and some 
of these locations differ in different versions of Word. For this reason, this page is divided 
into the following sections, and the applicable options are described in each section.

	The Paragraph Group
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	The Paragraph Dialog Box

	The Tabs Dialog Box

	Keyboard Shortcuts

	More Information

The Paragraph Group

Many options are available directly in the paragraph group on the Home tab of the Ribbon, 
in the Paragraph group on the Page Layout tab, and on the contextual toolbar and menu that 
appear when you right-click within text.

Alignment

Alignment or justification refers to the way in which the lines of a paragraph are aligned. 
There are four types of alignment, and the type of alignment of the paragraph where your 
cursor is located is indicated by the highlighted button in the paragraph group on the 
Home tab.

 
•	 With left alignment ( ) (the default), the left-hand ends of all the lines in the 

paragraph are aligned along the left-hand margin of the text area.

•	 With center alignment ( ), the mid-points (centers) of all the lines in the paragraph 
are aligned along the same imaginary vertical line at the center of the text area 
between the margins.

•	 With right alignment ( ), the right-hand ends of all the lines in the paragraph are 
aligned along the right-hand margin of the text area.

•	 With justified alignment or full justification ( ),  all the lines in the paragraph, 
except the last line, are extended so that the left-hand end of each line is aligned 
along the left-hand margin of the text area, the right-hand end of each line is aligned 
along the right-hand margin of the text area, and the lines are all of the same length. 
This is achieved by inserting additional space between words.

You can change the type of alignment of the paragraph where your cursor is located 
or of a group of selected paragraphs by clicking the applicable button in the paragraph 
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group on the Home tab. There are also shortcut keys.

Note. When you apply justified alignment to a paragraph, the last line does not extend 
across the full width of the text area. You can make all the lines in a paragraph extend 
across the full width of the text area by placing your cursor within the paragraph and 
pressing Ctrl+Shift+J, but it should be mentioned that in this case Word also adds 
space between letters within words to extend the lines.

Line Spacing

Line spacing refers to the vertical distance between the lines within a paragraph and determines 
the location of each line relative to the line above it. Line spacing can be specified by name 
(single, 1.5 lines, double), by a number that indicates a multiple of single spacing (for 
example, 2.0 is equivalent to double spacing), and by an exact distance in points, where a 
point (pt) is equal to 1/72 of an inch. You can quickly view and change the line spacing to 
several common standard values by   clicking   the Line   Spacing button   ( ) in the 
Paragraph group   on the Home tab. More line spacing options become available when you 
click Line Spacing Options to open the Paragraph dialog box.

Indents

The indent before text refers to the width of the additional empty space that is inserted 
between the margin and the text on the left-hand side of a paragraph of left- to-right text, 
and the indent after text refers to the width of the additional empty space that is inserted 
between the text and the margin on the right-hand side of a paragraph of left-to-right text. 
You can quickly increase the indent before text to the next tab stop by clicking the Increase 
Indent button ( ) in the Paragraph group on the Home tab, and you can quickly decrease 
the indent before text to the      preceding tab stop by clicking the Decrease Indent button (
) in the Paragraph group on the Home tab.

Paragraph Spacing

The spacing between your paragraphs is determined by the spacing before it and the spacing 
after it that are set for each paragraph. You can modify the spacing before a paragraph and 
the spacing after it by changing the values in the applicable  boxes in the Paragraph group 
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on the Page Layout tab.

Note. When the first of two consecutive paragraphs has non-zero spacing after it and the 
second paragraph has non-zero spacing before it, only the larger of the two spaces will be 
inserted between the paragraphs.

Borders

If you want to add borders around the paragraph where your cursor is located, click the 
Borders button (  ) to add the current default borders (the original default or the last border 
style that you selected). If you want to select a border style that differs from the current 
default   border   style, click   the   small   arrow  on     the borders button, and select one of 
the border styles displayed or click Borders and Shading to define your own custom borders. 
If you want to add borders around multiple   paragraphs, select   the   applicable   paragraphs   
before   you   click the Borders button or the small arrow on it.

Shading (Coloured Background)

If you want to add shading with the current default background colour to the entire text 
area of the paragraph where your cursor is located, click the Shading button (                     ) 
in the Paragraph group on the Home tab. If you want to select a background colour   other   
than   the   current   default colour, click   the   small   arrow   on the Shading button and 
then click one of the colours displayed or define your own custom colour. If you want to 
apply the same shading to multiple paragraphs, select the applicable paragraphs before you 
click the Shading button or the small arrow on it.

If you choose a very dark background colour, Word will automatically change the text 
colour to white to maintain good contrast and keep your text visible.

The Paragraph Dialog Box

Many of the paragraph formatting options described in the previous sections and additional 
paragraph formatting options are available in the Paragraph dialog box, which has two tabs.

	Indents and Spacing

	Line and Page Breaks

Note: When the first of two consecutive paragraphs has non-zero spacing after it and the 
second paragraph has non-zero spacing before it, only the larger of the two spaces will be 
inserted between the paragraphs.

Borders
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If you want to add borders around the paragraph where your cursor is located, click the 
borders button (  ) to add the current default borders (the original default or the last border 
style that you selected). If you want to select a border style that differs from the current 
default   border   style,   click   the   small   arrow on  the Borders button, and select one of 
the border styles displayed or click Borders and Shading to define your own custom borders. 
If you want to add borders around multiple   paragraphs, select   the applicable   paragraphs   
before you   click the Borders button or the small arrow on it.

Shading (Coloured Background)

If you want to add shading with the current default background colour to the entire 
text area of the paragraph where your cursor is located, click the Shading button (  ) in the 
Paragraph group on the Home tab. If you want to select a background   colour other than   
the   current   default colour, click   the small arrow on the Shading button and then click 
one of the colours displayed or define your own custom colour. If you want to apply the 
same shading to multiple paragraphs, select the applicable paragraphs before you click the 
Shading button or the small arrow on it.

If you choose a very dark background colour, Word will automatically change the text 
colour to white to maintain good contrast and keep your text visible.

The Paragraph Dialog Box

Many of the paragraph formatting options described in the previous sections and additional 
paragraph formatting options are available in the Paragraph dialog box, which has two tabs.

	 Indents and Spacing

	 Line and Page Breaks

	 Before opening the Paragraph dialog box, place your cursor anywhere within a 
single paragraph that you want to format or select the multiple paragraphs that you 
want to format. To open the Paragraph dialog box, on the Home tab or on the 
Page Layout tab, at the bottom of the Paragraph group, click the Paragraph dialog 
box launcher ( ).

	 When you click OK in the Paragraph dialog box or press Enter, any changes that you 
have made on either tab will be applied to the single paragraph where you cursor was 
located or to the paragraphs that you selected.

	 The paragraph formatting options that are available on the Indents and Spacing 
tab of the Paragraph dialog box are divided among the General, Indentation, and 
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Spacing groups.

	 These paragraph formatting options are described in the next subsections.

Alignment

Alignment or justification refers to the way in which the lines of a paragraph are aligned. 
There are four types of alignment, namely, left, center, right, and justified.

Indentation

The value in the Before text box specifies the width of the additional empty space that is 
inserted between the margin and the text on the left-hand side of a paragraph of left-to-right 
text, and the value in the After text box specifies the width of the additional empty space 
that is inserted between the text and the margin on the right- hand side of a paragraph of 
left-to-right text. A negative value specifies the distance by which the text extends beyond 
the respective margin.

Two types of special indentation can be specified in the Special box.

Paragraph diolog box

	 If you choose first line, you can set the amount of additional indentation before the 
text on the first line of a paragraph or multiple paragraphs in the By box.

	 If you choose Hanging, you can create a hanging indent. In this case you can set the 
additional indentation before the text for all the lines except the first in the By box. 
If you want a part of the text on the first line to be aligned with the other lines in the 
paragraph, set the value in the By box equal to the first tab stop or set the first tab 
stop equal to the value in the By box and insert a tab character in the first line before 
the text to be aligned.
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Spacing

The spacing between two paragraphs is determined by the spacing before one paragraph 
and the spacing after the preceding paragraph, which are displayed and can be modified in 
the before and after boxes.

Line spacing refers to the vertical distance between the lines within a paragraph and 
determines the location of each line relative to the line above it. The following types of line 
spacing can be specified in the Line spacing box.

•	 Single, 1.5 lines, Double,

•	 At least. When this option is selected, an exact distance in points, where a point (pt) 
is equal to 1/72 of an inch, is specified in the At box.

•	 Exact. When this option is selected, an exact distance in points, where a point (pt) is 
equal to 1/72 of an inch, is specified in the At box.

•	 Multiple. When this option is selected, a number that indicates a multiple of single 
spacing (for example, 2.0 is equivalent to double spacing), is specified in the At box.

Line and Page Breaks Tab

The paragraph formatting options that you can configure on the Line and Page Breaks tab 
of the Paragraph dialog box can help you control where automatic page breaks occur in 
your document.



Computer Application/Grade 9
136

These paragraph formatting options include the following.

•	 Widow/orphan control. A widow is the last line of text in a paragraph with two or 
more lines that appear alone on the top of a page. An orphan is the first line of text in 
a paragraph with two or more lines that appears alone at the bottom of a page. When 
the Widow/orphan control option is selected for a paragraph, Word will break the 
paragraph at the end of a page only if it contains four or more lines and only if there 
is room for at least two lines at the bottom of the page before the break and there is 
room for at least two lines at the top of the page after the break.

•	 Keep with next. When this option is selected for a paragraph, the paragraph and the 
next paragraph will be on the same page, and no page break will occur between them 
unless a manual page break is inserted between them or the Page break before the 
option is selected for the next paragraph.

•	 Keep lines together. When this option is selected for a paragraph, all the lines in the 
paragraph will remain on the same page unless the paragraph cannot fit on a single 
page. If there is not sufficient space for the whole paragraph on the page containing 
the preceding paragraph, the paragraph will start at the top of the next page.

•	 Page break before. When this option is selected for a paragraph, the paragraph will be 
located at the top of the page following the preceding paragraph. In many situations, 
it is preferable to use this option to force a page break before a specific paragraph 
and not to insert a manual page break.

The Tabs Dialog Box

Tab stops are used to horizontally align portions of text or other content on one or more 
lines when the portions of text or other content in each line are separated by tab characters. 
When you set a tab stop, you can configure it to align text to the left of the tab stop position, 
to align text to the right of it, to center text at it, to align the decimal point in the text at it, 
or to add a solid vertical line or bar at the tab stop in front of the aligned text.

If you do not set any tab stops in a paragraph either directly or by applying a style to it, 
Word creates default tab stops every 0.5" (1.27 cm) across the entire width of the text area. 
The tab stops that are configured in a paragraph apply to all the lines in the paragraph.

The Tabs dialog box can be used to set tab stops for one or more paragraphs. Before opening 
the Tabs dialog box, place your cursor anywhere within a single paragraph for which you 
want to set tab stops or select the multiple paragraphs for which you want to create tab 
stops. Then open the Tabs dialog box as follows.
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•	 First open the Paragraph dialog box as described in The Paragraph Dialog Box.

•	 Then in the Paragraph dialog box click Tabs.

Tab Dialog Box

If you want to modify the tab stops that appear in the Tabs dialog box for the single 
paragraph or multiple paragraphs that you selected, perform the following steps.

1.	 If one or more tab stops are listed under Tab stop position, click Clear All to delete 
all of them, or select each tab stop that you want to delete and click Clear.

2.	 To set a new tab stop, enter its position in the Tab stop position text box, under 
Alignment select the desired type of alignment, under leader select None or the 
desired type of leader, and then click Set.

3.	 The position of the new tab stop should appear under Tab stop position.

4.	 If you want to set more than one tab stop, repeat the previous step for each tab stop 
that you want to set.

5.	 If you want to use evenly spaced default tab stops, after you have cleared any tab 
stops that may have been listed under Tab stop position, adjust the distance that 
appears in Default tab stops to the desired default spacing.

6.	 Click OK.

Keyboard Shortcuts

The keyboard shortcuts (or shortcut keys or shortcut key combinations) that you can 
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use to quickly apply paragraph formatting are listed in the following table.

Keyboard shortcuts for using in paragraph formatting

Key Action

Ctrl+E Applies center alignment.

Ctrl+J Applies justified alignment.

Ctrl+Shift+J
Spreads the current paragraph across the entire width between the 
margins.

Ctrl+M
Increases the indentation of the current paragraph or selected 
paragraphs to the next tab stop.

Ctrl+Shift+M Decreases the indentation to the preceding tab stop.

Ctrl+Q
Resets the paragraph formatting to the default paragraph formatting 
of the applied style.

Ctrl+R Applies right alignment.

Ctrl+Shift+S
Opens the Apply Styles task pane for applying, creating, or 
modifying styles and formatting (use Alt+Ctrl+Shift+S to modify 
a style without applying it to the selection).

Alt+Ctrl+Shift+S Opens the Styles pane.

Ctrl+1
Applies single line spacing to the current paragraph or selected 
paragraphs.

Ctrl+2
Applies double spacing to the current paragraph or selected 
paragraphs.

Ctrl+5
Applies 1.5 line spacing to the current paragraph or selected 
paragraphs.

Ctrl+0
Adds or removes additional space before the current paragraph or 
selected paragraphs.

Shift+F1 Shows or hides the formatting properties in the task pane.

Formatting Document

Formatting document is the technique which allows making our document more attractive 
and professional. It includes changing font, setting margins, setting text alignments etc.

Changing the Font Type
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There are different types of fonts supported by MS-Word. To change the font, follow these 
steps:

Step 1: Select the text to change the font type.

Step 2: Click on the drop down arrow of Font button in the Font group of the Home  tab.

Step 3: Click on the font name to apply.

Changing the Font Style (Bold, Italic and Underline)

Different font styles such as bold, italic and underline are available in MS-Word.

Step 1: Select the text to make Bold, Italic and Underline.

Step 2: To make the text bold, click on bold button in the font group of the Home tab.

Step 3: To make the text italic click on the italic button

Step 4: To make the text underline click on the underline button.

Changing the Font Size

To change font size, follow these steps:

Step 1: Select the text which you want to change the size.

Step 2: Click on the dropdown arrow of the font size button in the font group of the Home 
tab.

Step 3: Choose required font size.

Press ctrl+] key to increase the font size. Press ctrl+[ key to decrease the font size.

Changing the Font Colour

To change font colour, follow these steps:

Step 1: Select the text which you want to change their colours.

Step 2: Click on the dropdown arrow of the font colour button in the font group of the 
Home tab.

Then a colour box with different colours will display.

Step 3: Click on desired colour from the list.

Subscript and Superscript

Superscript is the number, figure or symbol that is raised up from the base line. For example 
a2 + b2. Likewise subscript is dropped down from the base line. For example H2O. To 
change subscript/superscript follow these steps.

Step 1: Select the required character to make subscript or superscript.
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Step 2: Open the Font dialog box.

Step 3: Put tick mark on the required option (subscript/superscript)

Step 4: Click on the OK button.

OR, press Ctrl and +keys for subscript. Ctrl, shift and + keys for superscript.

Changing Line Spacing

Select Design > Paragraph Spacing.

However, the cursor over each option to see a preview, and then select the option you want.

For single spacing, select No Paragraph Space.

Change line spacing for part of your document

Select the paragraphs you want to change.

Select Home > Line and Paragraph Spacing, and choose the spacing you want.

Work with Special Features of Word Processing

A word processor enables you to create a document, store it electronically on a disk, display 
it on a screen, modify it by entering commands and characters from the keyboard, and print 
it on a printer.

The great advantage of word processing over using a typewriter is that you can make 
changes without retyping the entire document.

If you make a typing mistake, you simply back up the cursor and correct your mistake.

If you want to delete a paragraph, you simply remove it, without leaving a trace.

It is equally easy to insert a word, sentence, or paragraph in the middle of a document.

Word processors usually support these features (and a few others) :

•	 Cut and paste: Allows you to remove (cut) a section of text from one place in a 
document and insert (paste) it somewhere else

Word wrap: The word processor automatically moves to the next line when you 
have filled one line with text, and it will readjust text if you change the margins

•	 Print: Allows you to send a document to a printer to get hardcopy

•	 Font specifications: Allows you to change fonts within a document For example, 
you can specify bold, italics, and underlining Most word processors also let you 
change the font size and even the typeface.

•	 Graphics: Allows you to embed illustrations and graphs into a document Some 
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word processors let you create the illustrations within the word processor; others let 
you insert an illustration produced by a different program

•	 Headers, footers, and page numbering: Allows you to specify customized headers 
and footers that the word processor will put at the top and bottom of every page 
The word processor automatically keeps track of page numbers so that the correct 
number appears on each page.

•	 Layout: Allows you to specify different margins within a single document and to 
specify various methods for indenting paragraphs.

•	 Merges: Allows you to merge text from one file into another file. This is particularly 
useful for generating many files that have the same format but different data. 
Generating mailing labels is the classic example of using merges.

•	 Spell checker: A utility that allows you to check the spelling of words. It will 
highlight any words that it does not recognize.

•	 Thesaurus: A built-in thesaurus that allows you to search for synonyms without 
leaving the word processor.

Language Tools

Microsoft Word’s language tools are more than just red or blue squiggly lines. There is help 
to choose alternative words, alternate languages, check and improve grammar, hyphenate 
documents and even test the document for readability.

You may think you know all about the language tools, but Word always has a few extras 
tucked away to surprise even experts.

•	 Spelling

•	 AutoCorrect

•	 Thesaurus

•	 Grammar

•	 Delay

•	 Options

•	 Word Count and Statistics

•	 Readability

•	 Hyphenation

•	 Translation
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Spelling

We all know about the red squiggly line on misspelled words. Right-click to see possible 
correct spellings.

Ignore All– Word will consider that word as correctly spelled in this document. There is no 
option to ignore just one instance of a misspelled word.

Add to Dictionary– adds this word to your custom dictionary. It will not be marked as 
wrong in any other documents.

Smart Lookup– new in Office 2016. Opens a Bing search for that word in a side- pane.

Auto Correct

AutoCorrect is Word magically changing common spelling mistakes as you type. It is 
different from the speller checker but related.

Things like type accommodation you have and many more are loaded into an AutoCorrect 
list at Options | Proofing | AutoCorrect. When you type something from the ‘Replace’ 
column, Word will insert the ‘With’ value instead.

You can add your own common mistakes to this list or use AutoCorrect to save typing by 
changing a shortcut term into a longer one. (e.g. type IRSf to get Internal Revenue Service)

At the bottom of these options is ‘Automatically use suggestions from the spelling checker’ 
which ties the spell check to Autocorrect.

Thesaurus

In a paper thesaurus you look up a word to see alternatives or synonyms. Microsoft Word 
has a thesaurus in some languages. Right-click on a correctly spelled word and choose 
Synonyms. Here we are looking for synonyms of ‘thesaurus’:

•	 Click on a synonym to replace the current word.

•	 Or choose ‘Thesaurus…’ to see more in a side-pane. If your computer is connected 
to the Internet you’ll see extra options.

•	 There’s a longer list of synonyms and you can type other words into the search box 
at the top.

•	 The speaker icon next to the word will play a voice speaking the word.

•	 Click on ‘See More…’ to open a web page about that word. In this case the page 
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includes a great line from Steven Wright, “What’s another word for Thesaurus?”

•	 At the bottom of the pane you can switch languages or variants. For example, switch 
between US English and ‘real’ English from the Mother Country <g>.

Grammar

The blue squiggly line checks not just for grammar but also common typing mistakes. For 
example, adding extra spaces between words.

Or missing the comma after ‘For example’ <g>.

Ignore Once – removes the blue squiggly line with no change.

Grammar – opens the Grammar pane to show more options and examples. Like the Spelling 
pane, there is a change language option.

The English grammar check in Word isn’t perfect by any means. Surely this sentence 
deserves a squiggle or two?

And there are instances where the grammar check is wrong. English is such a messy 
language that the Microsoft grammar check should be regarded as a minor miracle for what 
it can do, rather than its shortcomings.

Tables

Insert a Table

In Microsoft Office Word 2007, you can insert a table by choosing from a selection of 
preformatted tables — complete with sample data — or by selecting the number of rows 
and columns that you want. You can insert a table into a document, or you can insert one 
table into another table to create a more complex table.

Use Table Templates

You can use table templates to insert a table that is based on a gallery of preformatted 
tables. Table templates contain sample data to help you visualize what the table will look 
like when you add your data.

1.	 Click where you want to insert a table.

2.	 On the Insert tab, in the Tables group, click Table, point to Quick Tables, and then 
click the template that you want.

3.	 Replace the data in the template with the data that you want.

Use the Table Menu
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1.	 Click where you want to insert a table.

2.	 On the Insert tab, in the Tables group, click Table, and then, under Insert Table, drag 
to select the number of rows and columns that you want.

Use the Insert Table Command

You can use the Insert Table command to choose the table dimensions and format before 
you insert the table into a document.

1.	 Click where you want to insert a table.

2.	 On the Insert tab, in the Tables group, click Table, and then click Insert Table.

3.	 Under Table size, enter the number of columns and rows.

4.	 Under AutoFit behavior, choose options to adjust the table size.

Word Art

WordArt is a gallery of text styles that you can add to your 2007 Microsoft Office system 
documents to create decorative effects, such as shadowed or mirrored (reflected) text. In 
Microsoft Office PowerPoint 2007, you can also convert existing text into WordArt. To 
insert word art, follow these steps:

1.	 On the Insert tab, in the Text group, click WordArt, and then click the WordArt style 
that you want.

2.	 Type your text in the Text box.

Convert existing text to WordArt in Office PowerPoint 2007

1.	 Select the text that you want to convert to WordArt.

2.	 On the Insert tab, in the Text group, click WordArt, and then click the WordArt that 
you want.

Create, Apply, or Remove a Chart Template

To reuse a favorite chart type that you customized to meet your needs, you can save that 
chart as a chart template (*.crtx) in the charts template folder.
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Apply a Chart Template

1.	 Do one of the following:

•	 To create a new chart based on the template, on the Insert tab, in the Charts 
group, click any chart type, and then click All Chart Types.

•	 You can also click the Dialog Box Launcher  next to Charts in the Charts 
group on the Insert tab.

2.	 To make a selected chart match a template, on the Design tab, in the Type group, 
click Change Chart Type.

Click Templates in the first box, and then click the template that you want to use in 
the second box under My Templates.

If a chart template is located in a folder other than the Charts folder, click Manage 
Templates, locate the chart template, and then copy or move it to the Charts folder 
under Templates.

Remove or delete a chart template

1.	 On the Insert tab, in the Charts group, click any chart type, and then click

All Chart Types.

You can also click the Dialog Box Launcher next to Charts in the Charts group on 
the Insert tab.
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2.	 Click Manage Templates

3.	 Do one of the followings;

Save a chart as a chart template

1.	 Click the chart that you want to save as a template.

	 This displays the Chart Tools, adding the Design, Layout, and Format tabs.

2.	 On the Design tab, in the Type group, click Save Template.

	 In the Save in box, make sure that the Charts folder is selected.

	 In the File name box, type an appropriate name for the chart template.

Add a shape from within the SmartArt graphic

1.	 Click the SmartArt graphic that you want to add a shape to.

2.	 Click the existing shape that is located closest to where you want to add the new 
shape.

3.	 Under SmartArt Tools, click the Design tab.

4.	 In the Create Graphic group, click the arrow under Add Shape, and then do one of 
the following to select a location for the new shape:

•	 To insert a shape at the same level as the selected shape but following it, click

Add Shape After

•	 To insert a shape at the same level as the selected shape but before it, click Add 
Shape Before
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•	 To insert a shape one level above the selected shape, click Add Shape Above.

•	 The new shape takes the position of the selected shape, and the selected shape 
and all of the shapes below it are demoted one level each.

•	 To insert a shape one level below the selected shape, click Add Shape Below. 
The new shape is added at the end of other shapes at the same level.

5.2	 Spreadsheet Software
Spreadsheet software is a software application capable of organizing, storing and 
analyzing data in tabular form. The application can provide digital simulation of 
paper accounting worksheets. They can also have multiple interacting sheets with data 
represented in text, numeric or in graphic form. With these capabilities, spreadsheet 
software has replaced many paper-based systems, especially in the business world. 
Originally developed as an aid for accounting and bookkeeping tasks, spreadsheets 
are now widely used in other contexts where tabular lists can be used, modified and 
collaborated.

Spreadsheet software is also known as a spreadsheet program or spreadsheet 
application.

5.2.1	Uses of Spreadsheets
Spreadsheets provide invaluable tools for collecting and calculating data of all types. 
Beyond arithmetic, they can be formatted to create clear, concise reports and can be 
sorted and updated with the touch of a button.

Lists

You can create lists, from shopping lists to contact lists, on a spreadsheet.

Accounting

Beyond sorting, spreadsheets are invaluable calculators. By entering the appropriate 
mathematical functions into cells, you can turn a simple spreadsheet into an accounting page.

Time Sheets

Besides adding and subtracting integers, spreadsheets can also perform those calculations 
on time-based numbers. Formatting cells to reflect data as a time (as opposed to simple 
integers) can allow you to use the spreadsheet as a time sheet.

Database Use

Although spreadsheets are not true relational databases, they can be designed and formatted 
to function as simplified ones.
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Chart Creation

Charts and graphs create better depictions of trends and percentages than raw numbers.

5.2.2	Types of Spreadsheets
Spreadsheets play a central role in the daily administrative tasks within many 
businesses both small and large. With spreadsheet software such as Microsoft 
Excel, business managers and administrators can capture, manipulate, analyze and 
present valuable data related to particular areas of their operation. The types of data 
spreadsheets are used to manage typically fall into one of a few common categories. 
As well as recording business data, spreadsheets can be used to manage it in a variety 
of ways.

Financial

Many businesses use spreadsheets to manage accounting data. This includes budget 
management such as tracking income and expenses.

Statistical

Spreadsheets are primarily used to capture data, but they also provide the means to analyze 
and manipulate data sets.

Presentation

Once a spreadsheet has been populated with one or more data sets, users can exploit features 
within the spreadsheet application to present these data sets graphically.

Future Planning

Spreadsheet data sets can be used to inform the process of making future plans for a 
business. As well as including graphs or tables representing historical business data within 
business plans, spreadsheets can be created specifically for the purposes of projection.

Project Tracking

Spreadsheets can play a role in project management tasks within certain organizations.

Spreadsheet's Interface The Excel Interface File Tab & Ribbon

In Excel 2010, the Office button has been replaced by a modification of the familiar File 
menu. Click to reveal the New, Open, Save, Print and Close options.

If you are upgrading to 2010 from 2007, not much of the interface has changed. However, 
if you are upgrading from an older version of Excel, you may be unfamiliar with the new 
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interface, which will be explained in the sections below. Seven tabs are displayed across 
the top-left of the window.

Home Tab

The Home tab contains the most common text editing tools used in Excel.

Figure 59: Home Tab

Shortcut Menu

The most common Excel commands and functions can be accessed quickly by using the 
shortcut menu. To access this feature, simply right-click the element you wish to edit if you 
are using a PC, or control-click the element you wish to edit if you are using a Mac. The 
options displayed will vary depending on the element you have selected.

Spreadsheet Basics

Each Excel file is a workbook that can hold many worksheets. The worksheet is a grid 
of columns (designated by letters) and rows (designated by numbers). The letters of the 
columns are indicated in the blue buttons across the top of the worksheet. The numbers of 
the rows are indicated in the blue buttons down the left of the worksheet. The intersection 
of a column and a row is called a cell. You can input your data into the cells. Cells can 
contain text, numbers, or formulas for automatic calculations. Each cell on the spreadsheet 
has a cell address that is the column letter followed by the row number.

Formula Bar

This will be one of the most useful tools as you use Excel. The formula bar allows you to 
see all the details and methods used to return what is seen in a cell. Whenever you input 
any information into a cell, the output, or end result is what is shown once you move away 
from the cell. This is most prominent when using functions, as you do not see the whole 
equation in the cell in the worksheet, only the result. The formula bar is located below the 
ribbon and spans most of the window.
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Figure 60: formula Bar

It is possible to hide the formula bar, though is not recommended. We can hide or show the 
formula bar. If it is mistakenly hidden, go to Excel Options at the bottom right of the menu 
that opens when you click the Office button. Go to the Advanced option, and under Display, 
you can click the check box for Show formula bar. When done, simply click Ok.
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Adding a Worksheet

By default, three worksheets are included in each Excel workbook. You can access the 
different worksheets by clicking the worksheet tabs just above the status bar.

To add a new worksheet, click the Insert Worksheet tab, to the right of the existing worksheet 
tabs.

Renaming a Worksheet

To rename a worksheet tab, follow either of these steps:

Steps Actions Option 1

1.	 Right-click the tab you want to rename if you are using a PC, or control-click the tab 
you want to rename if you are using a Mac. A shortcut menu will open.

2.	 Click Rename from the shortcut menu.

3.	 Type the new name.

Option 2

1.	 Hover over the tab you want to rename, and double Left-click the tab.

2.	 Begin typing to rename the tab.

Worksheets

A worksheet is a collection of cells where you keep and manipulate the data. Each Excel 
workbook can contain multiple worksheets.

Select a Worksheet

When you open an Excel workbook, Excel automatically selects Sheet1 for you. The name 
of the worksheet appears on its sheet tab at the bottom of the document window.
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Insert a Worksheet

You can insert as many worksheets as you want. To quickly insert a new worksheet, click 
the plus sign at the bottom of the document window.

Result:

Rename a Worksheet

To give a worksheet a more specific name, execute the following steps.

1.	 Right click on the sheet tab of Sheet1.

2.	 Choose Rename.
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For example, type Sales 2016

Move a Worksheet

To move a worksheet, click on the sheet tab of the worksheet you want to move and drag 
it into the new position.

1.	 For example, click on the sheet tab of Sheet2 and drag it before Sales 2016.

Result:

Delete a Worksheet

To delete a worksheet, right click on a sheet tab and choose Delete.

For example, delete Sheet2.
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Result:

Copy a Worksheet

Imagine, you have got the sales for 2016 ready and want to create the exact same sheet for 
2017, but with different data. You can recreate the worksheet, but this is time-consuming. 
It's a lot easier to copy the entire worksheet and only change the numbers.

1.	 Right click on the sheet tab of Sales 2016.

2.	 Choose Move or Copy.

The 'Move or Copy' dialog box appears.

3.	 Select (move to end) and check Create a copy.

4.	 Click OK.
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Result:

Note: you can even copy a worksheet to another Excel workbook by selecting the specific 
workbook from the drop-down list (see the dialog box shown earlier).

Labels and Values

Entering data into a spreadsheet is just like typing in a word processing program, but you 
have to first click the cell in which you want the data to be placed before typing the data.

All words describing the values (numbers) are called labels. The numbers, which can later 
be used in formulas, are called values.

Notice also that the labels (composed of letters) are all left justified and the values (composed 
of numbers) are all right justified in their cells.

Formulas

All formulas start with an = sign.

Refer to the cell address instead of the value in the cell e.g. =A2+C2 instead of 45+57. That 
way, if a value changes in a cell, the answer to the formula changes with it.

=SUM(B3:B9) =AVERAGE(B3:B9)

Adds list of values from cell B3 to cell Averages the values from cell B3 to

B9 cell B9

Other Functions

There are many functions that you could explore with time. SUM and AVERAGE are two 
of the most common, below are a few more:

SUM adds the numbers in the list

AVERAGE averages the numbers in the list

PRODUCT multiplies the numbers in the list

MAX identifies the highest number in the list
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MIN identifies the lowest number in the list

COUNT counts the number of numerical items in the list

COUNTA counts the number of alphabetical items in the list

COUNTIF

counts the   number   of   items   that   satisfy   certain   criteria
e.g. =COUNTIF(A4:A20,">50") counts the number of values 
that are higher than 50 in the list from A4 to A20 - notice the 
use of the comma and quotation marks to separate the list 
(A4:A20) from the criteria (>50).

Date & Time Functions

To enter a date in Excel, use the "/" or "-" characters. To enter a time, use the ":" (colon). 
You can also enter a date and a time in one cell.

Note: Dates are in US Format. Months first, Days second. This type of format depends on 
your windows regional settings. Learn more about Date and Time formats.

Year, Month, Day

To get the year of a date, use the YEAR function.

Note: use the MONTH and DAY function to get the month and day of a date.

Format a Worksheet

You can help improve the readability of a worksheet by applying different types of 
formatting. For example, you can apply borders and shading to help define the cells in a 
worksheet.

Apply Cell Borders

1.	 Select the cell or range of cells that you want to add a border to.

Tip : To quickly select the whole worksheet, click the Select All button.

1.	 On the Home tab, in the Font group, click the arrow next to Borders  ,

2.	 Then click the border style that you want.
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The Borders button displays the most recently used border style. You can click the Borders 
button (not the arrow) to apply that style.

Change Text Colour and Alignment

1.	 Select the cell or range of cells that contain (or will contain) the text that you want to 
format. You can also select one or more portions of the text within a cell and apply 
different text colours to those sections.

2.	 To change the colour of text in the selected cells, on the Home tab, in the Font group,   
click   the   arrow   next   to Font   Colour  , and then under Theme Colours or 
Standard Colours, click the colour that you want to use.

	 Note To apply a colour other than the available theme colours and standard colours, 
click More Colours, and then define the colour that you want to use on the Standard 
tab or Custom tab of the Colours dialog box.

3.	 To change the alignment of the text in the selected cells, on the Home tab, in the 
Alignment group, click the alignment option that you want.

For example, to change the horizontal alignment of cell contents, click Align Text Left  
, Center  , or Align Text Right  .

Apply Cell Shading

Select the cell or range of cells that you want to apply cell shading to.

On the Home tab, in the Font group, click the arrow next to Fill Colour  , and then under 
Theme Colours or Standard Colours, click the colour that you want.

Relative and Absolute Cell References

There are two types of cell references: relative and absolute. Relative and absolute references 
behave differently when copied and filled to other cells. Relative references change when a 
formula is copied to another cell. Absolute references, on the other hand, remain constant 
no matter where they are copied.
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Relative References

By default, all cell references are relative references. When copied across multiple cells, 
they change based on the relative position of rows and columns. For example, if you copy 
the formula =A1+B1 from row 1 to row 2, the formula will become =A2+B2. Relative 
references are especially convenient whenever you need to repeat the same calculation 
across multiple rows or columns.

In the following example, we want to create a formula that will multiply each item's price 
by the quantity. Rather than create a new formula for each row, we can create a single 
formula in cell D2 and then copy it to the other rows. We'll use relative references so the 
formula correctly calculates the total for each item.

1.	 Select the cell that will contain the formula. In our example, we'll select cell D2.

2.	 Enter the formula to calculate the desired value. In our example, we'll type =B2*C2.

Absolute References

1.	 There may be times when you do not want a cell reference to change when filling 
cells. Unlike relative references, absolute references do not change when copied or 
filled. You can use an absolute reference to keep a row and/or column constant.

2.	 An absolute reference is designated in a formula by the addition of a dollar sign ($). 
It can precede the column reference, the row reference, or both.

You will usually use the $A$2 format when creating formulas that contain absolute 
references. The other two formats are used much less frequently.

When writing a formula in Microsoft Excel, you can press the F4 key on your 
keyboard to switch between relative and absolute cell references. This is an easy 
way to quickly insert an absolute reference.

To create and copy a Formula Using Absolute References

In our example, we'll use the 7.5% sales tax rate in cell E1 to calculate the sales tax for 
all items in column D. We'll need to use the absolute cell reference $E$1 in our formula. 
Because each formula is using the same tax rate, we want that reference to remain constant 
when the formula is copied and filled to other cells in column D.
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Select the cell that will contain the formula. In our example, we'll select cell D3.

Enter the formula to calculate the desired value. In our example, we'll type

=(B3*C3)*$E$1.

Press Enter on your keyboard. The formula will calculate, and the result will display in the 
cell.

Locate the fill handle in the lower-right corner of the desired cell. In our example, we'll 
locate the fill handle for cell D3.

Formatting Values

Create and build a custom numeric format to show your numbers as percentages, currency, 
dates, and more.

Select the numeric data.

Select More in the Number group.

Select Custom.

In the Type list, select an existing format, or type a new one in the box.

To add text to your number format:

Type what you want in quotation marks.

Add a space to separate the number and text.

Select OK

Labels and Cells’

A label is text that identifies the purpose of a cell or text box or that displays descriptive text, 
such as titles, captions, or brief instructions. In addition, a label can display a descriptive 
picture.

Label (Form control)          Label (ActiveX control)           Text Box (ActiveX control)

	     	               
Use a label for flexible placement of instructions, to emphasize text, and when merged cells 



Computer Application/Grade 9
160

or a specific cell location is not a practical solution.

A cell or text box is a rectangular box in which you can view, enter, or edit text or data 
that is bound to a cell. A text box can also be a static text field that presents read-only 
information. Use a text box as an alternative to entering text in a cell, when you want to 
display an object that floats freely. You can also use a text box to display or view text that 
is independent of row and column boundaries, preserving the layout of a grid or table of 
data on the worksheet.

Add a Label (Form control)

If the Developer tab is not available, display it.

1.	 Display the Developer tab

2.	 Click the File tab, click Options, and click Customize Ribbon.

3.	 Under Main Tabs, select the Developer check box, and then click OK.

4.	 On the Developer tab, in the Controls group, click Insert and then, under

5.	 Form Controls, click Label .

6.	 Click the worksheet location where you want the upper-left corner of the label to 
appear.

To specify the control properties, right-click the control,   and   then click Format 
Control.

1.	 Add a label (ActiveX control)

2.	 If the Developer tab is not available, display it.

3.	 Display the Developer tab

4.	 Click the File tab, click Options, and click Customize Ribbon.

5.	 Under Main Tabs , select the Developer check box, and then click OK.

6.	 On the Developer tab, in the Controls group,	click Insert and then, under ActiveX 
Controls, click Label .
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1.	 Click the worksheet location where you want the upper-left corner of the label to 
appear.

2.	 To edit the ActiveX control, make sure that you are in design mode. On the Developer 
tab, in the Controls group, turn on Design Mode .

3.	 Click the worksheet location where you want the upper-left corner of the label to 
appear.

To specify the control properties, on the Developer tab, in the Controls group, click 
Properties .

Add Charts

A simple chart in Excel can say more than a sheet full of numbers. As you'll see, creating 
charts is very easy.

Create a Chart

To create a line chart, execute the following steps.	

1.	 Select the range A1:D7.

On the Insert tab, in the Charts group, click the Line symbol
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2.	 Click Line with Markers.

Result

Note: enter a title by clicking on Chart Title. For example, Wildlife Population.

Change Chart Type

You can easily change to a different type of chart at any time.

1.	 Select the chart.

2.	 On the Design tab, in the Type group, click Change Chart Type.
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3.	 On the left side, click Column.

4.	 Click OK.

Result

Data Filter

Filter your Excel data if you only want to display records that meet certain criteria.

1.	 Click any single cell inside a data set.

2.	 On the Data tab, in the Sort & Filter group, click Filter.

To remove the filter, on the Data tab, in the Sort & Filter group, click Clear. To 
remove the filter and the arrows, click Filter.
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Sort Data

Sorting data is an integral part of data analysis. You might want to arrange a list of names 
in alphabetical order, compile a list of product inventory levels from highest to lowest, or 
order rows by colours or icons. Sorting data helps you quickly visualize and understand 
your data better, organize and find the data that you want, and ultimately make more 
effective decisions.

You can sort data by text (A to Z or Z to A), numbers (smallest to largest or largest to 
smallest), and dates and times (oldest to newest and newest to oldest) in one or more 
columns. You can also sort by a custom list you create (such as Large, Medium, and Small) 
or by format, including cell colour, font colour, or icon set.

Sort Text

1.	 Select a cell in the column you want to sort.

2.	 On the Data tab, in the Sort & Filter group, do one of the following:

•	  To quick sort in ascending order, click      (Sort A to Z).

•	 To quick sort in descending order, click  (Sort Z to A). Working with special 
features of spreadsheet

When spreadsheet software first became available for computers in the early 1980s, 
it was known as a "killer application" because people began to buy computers just 
so they could work with spreadsheets. Today, spreadsheet software is practically a 
required part of any collection of office software, and it remains as useful now as it 
was in the beginning.

Visual Design

Spreadsheets allow you to lay figures out on a grid, calculating and manipulating them 
visually. Often, this may result in you being able to process the information more quickly. On 
a spreadsheet, you may also notice errors or omissions that you would not have otherwise.

Automatic Calculations

Spreadsheet software gives you the ability to enter mathematical formulas ranging from 
simple arithmetic to complex statistics.

Dynamic Updates

In addition to the standard method of entering data in a spreadsheet -- typing numbers in 
cells -- you can also create a cell with a value generated dynamically based on other cells.
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Data Analysis

Spreadsheet software gives you the ability to analyze your data in ways other than simply 
looking at grids and lines. Most spreadsheet software can automatically create graphs and 
charts from your data, giving you different ways of comparing and analyzing information. 
These visual representations can also be printed and emailed, or exported into slide shows 
for presentations.

Formulas and Functions

A formula is an expression which calculates the value of a cell. Functions are predefined 
formulas and are already available in Excel.

For example, cell A3 below contains a formula which adds the value of cell A2 to the value 
of cell A1.

For example, cell A3 below contains the SUM function which calculates the sum of the 
range A1:A2.

Enter a Formula

To enter a formula, execute the following steps.

1.	 Select a cell.

2.	 To let Excel, know that you want to enter a formula, type an equal sign (=).

3.	 For example, type the formula A1+A2.
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Tip: instead of typing A1 and A2, simply select cell A1 and cell A2.

4.	 Change the value of cell A1 to 3.

Excel automatically recalculates the value of cell A3. This is one of Excel's most 
powerful features.

Edit a Formula

When you select a cell, Excel shows the value or formula of the cell in the formula bar.

To edit a formula, click in the formula bar and change the formula.

Press Enter.
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Operator Precedence

Excel uses a default order in which calculations occur. If a part of the formula is in 
parentheses, that part will be calculated first. It then performs multiplication or division 
calculations. Once this is complete, Excel will add and subtract the remainder of your 
formula. See the example below.

First, Excel performs multiplication (A1 * A2). Next, Excel adds the value of cell A3 to 
this result.

Another example,

First, Excel calculates the part in parentheses (A2+A3). Next, it multiplies this result by the 
value of cell A1.

Copy/Paste a Formula

When you copy a formula, Excel automatically adjusts the cell references for each new cell 
the formula is copied to. To understand this, execute the following steps.

1.	 Enter the formula shown below into cell A4.
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2.	 Select cell A4, right click, and then click Copy (or press CTRL + c)...

...next, select cell B4, right click, and then click Paste under 'Paste Options:' (or press 
CTRL + v).

2.	 You can also drag the formula to cell B4. Select cell A4, click on the lower right 
corner of cell A4 and drag it across to cell B4. This is much easier and gives the exact 
same result!

Result. The formula in cell B4 references the values in column B.

Insert a Function

Every function has the same structure. For example, SUM(A1:A4). The name of this 
function is SUM. The part between the brackets (arguments) means we give Excel the 
range A1:A4 as input. This function adds the values in cells A1, A2, A3 and A4. It is not 
easy to remember which functions and which arguments to use for each task. Fortunately, 
the Insert Function feature in Excel helps you with this.
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To insert a function, execute the following steps.

1.	 Select a cell.

2.	 Click the Insert Function button.

The 'Insert Function' dialog box appears.

3.	 Search for a function or select a function from a category. For example, choose 
COUNTIF from the Statistical category.

4.	 Click OK.

The 'Function Arguments' dialog box appears.

5.	 Click in the Range box and select the range A1:C2.

6.	 Click in the Criteria box and type >5.

7.	 Click OK.
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Result. The COUNTIF function counts the number of cells that are greater than 5.

Note: instead of using the Insert Function feature, simply type =COUNTIF (A1:C2,">5"). 
When you arrive at: =COUNTIF( instead of typing A1:C2, simply select the range A1:C2.

5.3	 Presentation software Present Program Basics
Presentation software (sometimes called "presentation graphics") is a category of 
application program used to create sequences of words and pictures that tell a story or 
help support a speech or public presentation of information. Presentation software can 
be divided into business presentation software and more general multimedia authoring 
tools, with some products having characteristics of both. Business presentation 
software emphasizes ease- and quickness-of-learning and use. Multimedia authoring 
software enables you to create a more sophisticated presentation that includes audio 
and video sequences. Business presentation software usually enables you to include 
images and sometimes audio and video developed with other tools.

Some very popular presentation software, such as Microsoft's Power point and Lotus's 
Freelance Graphics, are sold stand-alone or can come as part of office- oriented 
suites or packages of software. Other popular products include Adobe Persuasion, 
Astound, Asymetrix Compel, Corel Presentations, and Harvard Graphics. Among the 
most popular multimedia authoring tools are Macromedia Director and Asymetrix's 
Multimedia Toolbook. These authoring tools also include presentation capability as 
well. Most if not all of these products come in both PC and Mac versions.

Recently, a new presentation tool has arrived: your web browser and the tools for 
creating Web pages, such as Microsoft's FrontPage and Adobe's PageMill. The 
ubiquity of these tools and the browser as a playback device make this a popular 
approach, especially when a presentation can combine HTML pages on the hard disk 
with links to outside sites (if you have a live Internet connection).

5.3.1	Power Point Software
Everyone agrees that Microsoft PowerPoint is so popular and useful tools in the 20th 
century. It is not the best free presentation tool (In fact it’s not free at all).
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PowerPoint is a part of Microsoft office Package which allows to create, edit and 
display presentation in an interesting and effective way.

The PowerPoint Interface

To begin a presentation, open PowerPoint (Click Start, All Programs, Microsoft PowerPoint). 
PowerPoint opens as shown in Figure

a)	 Title bar

b)	 PowerPoint window control buttons

c)	 Presentation close button

d)	 Menu bar

e)	 Standard toolbar

f)	 Formatting toolbar

g)	 Task pane

h)	 Slide pane

i)	 Notes pane

j)	 Outline tab

k)	 Slides tab

l)	 View buttons
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m)	 Status bar

n)	 Splitter bar

Create a Presentation Format Slides

A PowerPoint has two methods for creating a slide presentation:

•	 Choose a theme template

•	 Create a blank presentation (This method is covered in Unit 3)

•	 PowerPoint software has built in and free online pre-designed templates that contain 
various colour schemes and pre-arranged elements in a slide, eg. text and graphics. 
Select a template and PowerPoint will format the entire presentation according to 
that template.

•	 Steps to choose a theme template:

•	 Open PowerPoint.

•	 At the PowerPoint window, click the File tab, then click New.

•	 The Available Templates and Themes screen will appear, click on an available 
template or download a free template from the office.com online templates.

•	 Once you have selected the desired template, it will be displayed in normal view. 
New slides can be added as needed.

•	 A theme template can be added to a presentation before, during or after you have 
added the presentation content.
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•	 To apply various templates to a presentation, click the Design tab, then click on the 
desired template in the themes group.

Create a New Slide

Whether you are using a pre-made theme template or working from your own design, it is 
very easy to insert a new slide.

In the slide pane click on the slide where you would like the new slide to appear below.

1.	 Click on the New Slide button located on the Home tab in the Slides group

2.	 The new slide should appear below the selected slide. If you want to add a new slide 
between two, select the first of the two slides and click New Slide.

3.	 Notice the New Slide button contains a New Slide button arrow. Click on the arrow 
to view different slide layouts. Another way to change the slide layout is by clicking 
on the Layout button located in the Slides group. The slide layout option determines 
the position of the objects on a slide. Simply click on the layout you want to use and 
it will appear in the slide

Special Features of Presentation Programs

1.	 Insert Slide Feature: Allows you to inset slide anywhere in the presentation, at the 
beginning, middle or end.

2.	 Deletion of Inserted slides: Any slide of the presentation can be removed.

3.	 Allows cut and paste slides in any order.

4.	 Allows duplication content or slide

5.	 Allows you to display the presentation designed in a slide show system. (View Slide 
Feature)

6.	 Allows animations and/or sounds manipulations on objects in the slide.

7.	 Simple Find and Replace, and text editor features.

Full Featured Presentation Software Need More Features than that above

1.	 Good font specifications - Allows you to change and use different font faces, styles, 
and effects

2.	 Additional features for slide: footnotes, cross references, advanced navigation 
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system, headers, footers

3.	 Good layout management system: Presets or Customized layout designing

4.	 Macros - for add interactive features

5.	 Spell checkers and dictionary support

Transition

Transitions are a type of animations in between slides. You can view the Transitions pane 
to view all possible transition effects you can use. These are ideal when you want to have 
a noticeable transition between two slides, as you'll find in some examples later in this 
tutorial.

The transition pane, with transition effects you can choose.

Animation

You can view your options in the Animations pane. These are often used as action effects 
while you're presenting your slide. For example, an animation can be used to highlight a 
particular element on your slide.

The animation pane, with different animations you can choose once you select an element 
on your slide. Your animations are controlled by using the animation pane. If you would 
like to learn a little bit more about the animation pane in PowerPoint. Discover how and 
when to add animation to PowerPoint. Without further ado, let's dive into these helpful 
PowerPoint animation tips and tricks.

Custom Animation

Custom animation in PowerPoint 2007 is used to animate pictures, graphics and charts. 
Many presenters like to add animation to make their presentations more dynamic. There 
are four types of animations that can be applied: an entrance effect, emphasis effect, an 
exit effect, and a motion path effect. Each of these effects have numerous animation styles 
available to choose from.
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Entrance Effect

The entrance effect tells PowerPoint how the item will appear in the presentation. By 
default, all images, graphs and other graphic items simply appear in the slide. However, by 
applying an entrance effect, the user can control not only how the item appears, but also 
when. This allows the presenter to display graphical items before, during or after discussing 
the slide.

Emphasis Effect

Sometimes presenters like to have an image change once it is in the slide. These changes 
can include having the object grow, shrink, fade, change colours, change fonts, become 
transparent or blink. This gives the benefit of emphasizing a point while speaking. For 
example, you can use the emphasis effect as you talk about each bar in a bar chart.

Exit Effect

The exit effect is essentially how an animation leaves the screen. Presenters often use exit 
effects in conjunction with entrance effects to have an item disappear in tandem as another 
object is appearing. Some exit effects can be subtle, like simply disappearing, while other 
effects can be more exciting, like spiraling out or bouncing off the screen.

Motion Path Effect

The motion path effect allows a presenter to create movement in a presentation. Motion 
paths are used to move images across the screen. Some examples include moving text 
boxes to the middle of the screen while speaking and then move them back to the original 
position, separating pieces of a pie chart, or even having a picture zoom across the screen. 
There are more than 65 different motion paths available to choose from or a presenter can 
create a custom motion path.

How to Apply a Custom Animation?
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Custom Animation Task Pane

1.	 On the "Animations" tab, click the "Custom Animation" button.

2.	 Click the "Add Effect" button.

3.	 To make the text or object enter the slide show presentation with an effect, select an 
"Entrance Effect."

4.	 To add an effect to text or an object that is on the slide, select an "Emphasis Effect."

5.	 To add an effect to text or an object that makes it leave the slide at some point, select 
an "Exit Effect."

6.	 To add an effect that makes an object move in a specified pattern, select a "Motion 
Path Effect."

7.	 To reorder the animations, click the "Reorder" buttons.

8.	 To preview the animation, click the "Play" button.

Work with Tables

In PowerPoint, tables are useful for organizing and presenting data. To use tables in your 
slide show, you'll need to know how to insert them, apply table styles, and format them.

To Insert a Blank Table

1.	 On the Insert tab, click the Table command.

2.	 Hover your mouse over the diagram squares to select the number of columns and 
rows in the table.

3.	 Click your mouse. The table will appear on the slide.

4.	 You can now place the insertion point anywhere in the table to add text.

To make sure your table looks good with the slide layout, you can also insert a table 
using the placeholder. Click the Insert Table icon in the placeholder, then enter the 
desired number of rows and columns.

To Move a Table

1.	 Place the cursor over the edge of the table. The cursor will turn into a cross with 
arrows  .
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2.	 Click and drag the table to the desired location.

3.	 Release the mouse button to drop the table in the new location.

Graphics or Pictures and Clip Arts

On each slide you create in your presentation, you have information you want to communicate 
with the audience. You can do this with text and illustrations, such as pictures and clip art.

You will learn how to insert a picture and clip art, as well as how to modify both types of 
illustrations.

Pictures and clip art can be inserted from the Ribbon, as well as by using the commands 
that appear in certain placeholders. In both methods, the image is centered in the middle of 
any selected slide placeholders.

To Insert a Picture from the Ribbon

•	 Select the Insert tab.

•	 Click the Insert Picture command in the Illustrations group. The Insert Picture dialog 
box will appear.

•	 Locate and select the picture you want to use.



Computer Application/Grade 9
178

•	 Click Insert, and it will appear on the slide.

To Insert a Picture from a Placeholder Command

•	 Click the Insert Picture command in the placeholder. The Insert Picture dialog box 
will appear.

•	 Locate and select the picture you want to use.

•	 Click Insert, and it will appear on the slide.

Word Art

There are many features and commands you can use in PowerPoint to create visually 
appealing slides. Two of these features are WordArt and shapes. WordArt allows you to 
create stylized text with textures, shadows, and outlines. It can be applied to text on any 
slide. Additionally, in PowerPoint you can insert a variety of shapes such as lines, arrows, 
callouts, stars, and basic shapes, including rectangles and circles.

Working with WordArt

To apply a WordArt Style

•	 Select the text you want to modify. The Format tab will appear.

•	 Select the Format tab.

•	 Move your cursor over a WordArt style in the WordArt Styles group to see a live 
preview of the style on the slide.
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•	 Click the More drop-down arrow to see all possible WordArt styles.

•	 Click an option to select it.

Charts

A chart is a tool you can use to communicate your data graphically. Displaying charts in 
PowerPoint allows your audience to see the meaning behind the numbers, and it makes 
showing comparisons and trends much easier. In this lesson, you will learn how to insert 
charts and modify them so they communicate information effectively.

In many ways, charts are an ideal way to present information in PowerPoint 2010. They 
give you an illustration of your data. A chart can help you show your audience what your 
data means and why it is important. Plus, they can add visual interest to slide shows that 
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are otherwise filled with text. To use charts effectively, you'll need to know how to insert 
and modify them.

Types of Charts

Click the arrows in the slideshow below to view examples of some of the types of charts 
available in PowerPoint.

PowerPoint has a variety of chart types, each with its own advantages. Click the arrows to 
see some of the different types of charts available in PowerPoint.
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Identifying the Parts of a Chart

Click the buttons in the interactive below to learn about the different parts of a chart.

Inserting Charts

PowerPoint uses an Excel worksheet as a placeholder for entering chart data. Therefore, 
when you insert or edit a chart in PowerPoint, an Excel window will automatically open.

To Insert a Chart

1.	 Select the Insert tab.

2.	 Click the Insert Chart command in the Illustrations Group. The Insert Chart dialog 
box will appear.

3.	 Select a category from the left pane of the dialog box, and review the charts that 
appear in the center. If you are unsure about which chart best fits your needs, review 
the interactive on the previous page.
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4.	 Select the desired chart.

5.	 Click OK. An Excel window will open with a placeholder for your data.

If a slide layout has a content placeholder, you can also click the Insert Chart 
command to insert new chart.

To Enter Chart Data

The data that appears in the Excel spreadsheet is placeholder source data that you will 
replace with your own information. The Excel source data is used to create the PowerPoint 
chart.

Enter your data into the Excel spreadsheet.
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Data Integration

The main reason you want integration between Power Point and Excel surely is the ability 
to update Tables or/and Charts you are using in a PPT presentation for which the data 
source is in an Excel workbook. You gain in efficiency because the data or chart you have 
on PPT presentation will refresh automatically every time you have new input in the data 
source in Excel.

That’s a same as PPT/Excel has pretty good linking options. Below some of favorite ones.

1.	 Paste Special

•	 Copy your selected range from excel (table i.e.)

•	 Go to PPT and select Paste → Paste special
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•	 This allows you to copy an exact range to your PPT which will update when you 
update the excel values

•	 In order to allow the mirroring select “Paste link”

•	 Test this by editing the excel spreadsheet values.

•	 You can use the feature to create a support excel file which you edit and the beautiful 
report ppt you will craft will automatically update the figures to charts/highlights 
you want in the ppt

•	 If you reopen the PowerPoint presentation, the application will show warning to 
update the links. If you press YES, it will fetch the most recent numbers (in case you 
have for example restarted the pc), if no it keeps the most recent values.

2.	 This is just one of the many ways to do this, as this allows you to select a specific 
range and you can double click the sheet in PPT to be taken to the Excel application. 
With the Embed function it creates a mini-excel inside the PPT.

3.	 If your excel has a lot of VBA or otherwise heavy, you might consider creating a 
sheet that captures the selected ranges as snapshots first and then use the technique 
described above to copy + paste special the photos to your PPT.
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Exercise

Choose the correct answer from the given alternatives.
1.	 A program which helps to create written document and lets you go back and make 

corrections as necessary..............

a. Home row keys		  b. tool bar

c. Folder		  d. word processor

2.	 …….is not a valid data type in MS Excel.

a. Number	 b. Character	 c. Label	 d. Date/Time

3.	 What is MS Excel?

a. Spreadsheet        	 b. Database management

c. Presentation		  d. Workbook

4.	 Which of the following is not a feature of PowerPoint?

a. Printing transparencies

b. Printing the speaker’s notes along with slide images

c. Linking a slide transition with a laser pointer

d. Drawing with a pen

5.	 Which key on the keyword can be used to view slide show?

a. F1	 b. F2	 c. F5	 d. F10

6.	 In a spreadsheet, letters are used to represent………

a. columns	 b. Blocks	 c. Rows	 d. Cells

7.	 ………. help us to see patterns.

a. Charts	 b. Graphs	 c. Spreadsheets	 d. Calculations

8.	 Title bar in MS-Excel displays name of the…..

a. Worksheet	 b. Workbook	 c. Formula	 d. Location

9.	 In a computer, Graphics representation of data is named as..............

a. Chart	 b. Graphics	 c. Picture	 d. Figure
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10.	 Which of the following is not a part of a spreadsheet?

a. Row number		  b. Column number

c. Column letter		  d. Cell address

Write short answer to the following questions.
1.	 Write any two-word processing software.

2.	 Which company released Excel programs?

3.	 Which symbol is used to begin formula in MS Excel?

4.	 How many types of data sorting are used in Excel?

5.	 What is the extension of Excel worksheet?

6.	 Write any two presentation software.

7.	 Which function key is used to view presentation?

8.	 What is word processor?

9.	 What is MS Word? Write its features.

10.	 What is meant by formatting document?

11.	 What is spreadsheet? Write two examples.

12.	 What is MS Excel? Write its features.

13.	 What is formula? Write true rule for using formula.

14.	 What is meant by sorting data?

15.	 How can you insert the formula in excel for manipulating data?

16.	 What is chart? List the common chart types.

17.	 List any four features of power point.

18.	 What is meant by formatting the presentation?

Write long answer to the following questions.
1.	 What is word processor? Write the purpose and importance of word processing.

2.	 Why is MS Excel popular and user friendly spreadsheets software? Give you 
views.

3.	 What is presentation? Why is presentation very important in education?

4.	 Why are MS-word, Excel and PowerPoint are considered as powerful tools for 
development of the documents and database?
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Project Work
Microsoft Office 

1.	 To be familiar with layouts, page margins, page orientation, page size, paragraph 
spacing, etc.

2.	 To be familiarize with font, font size, font style, font colour, alignment, numbering 
format, bold, underline, italicize, paragraph, paragraph spacing, etc.

3.	 Insert a picture from Clip Art and the Design Gallery, tables, insert ready-made 
shapes, smart art graphic, charts, etc.

4.	 Create and manage paragraph, organize the information in tables.

5.	 Insert and modify the charts.

Microsoft Excel
Practical 1 
Using the data given, get the sum of all the figures within the range.

A B C D E F G H G

1 Mon Tue Wed Thur Fri TOTAL AVERAGE PERCENT

2 Breakfast 3,560 3,186 2,952 3,395 3,436

3 Lunch 20,163 21,416 19,912 19,681 18,628

4 Bar 9,873 12,172 12,642 12,711 18,846

5 Snacks 2,405 3,544 2,694 3,120 3,712

6 TOTALS

Practical 2
From the data given in the table below, create a Pie Chart, Bar graph, histogram, line graph 
to show the distribution of the total amount amongst the various salesmen.

A B C D E F
1 ABC Company Sales Performance Report
2
3 Salesman Qtr1 Qtr2 Qtr3 Qtr4 Total
4 Albert 148 156 171 140 615
5 Carl 122 131 153 118 524
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6 Cornell 211 243 246 250 950
7 Edwin 129 150 92 218 589
8 Francis 311 270 247 322 1,150

Practical 3
The following is a simple payroll:

A B C D E F G H I
1 Name Hours

Worked

Hourly

Rate

Basic

Pay

Gross

Pay

Tax

Deductions

NSSF

Contributions

Allowances Net

Pay
2 John 8 200
3 Peter 12 450
4 Sam 22 300
5 Njogu 30 286
6 Mary 16 220
7 Sally 45 468
8 Jane 15 150
9 Tina 3 280
10
11

Required

Write formulae using cell names for the following expressions. State where the formula is 
placed.

(i).	 Basic Pay = Hours Worked * Hourly Rate.

(ii).	 Allowances are allocated at 10% of the Basic Pay. (iii). Gross Pay = Basic Pay + 
Allowances.

(iv).	 Tax Deduction is calculated at 20% of the Gross Pay.

(v).	 Net Pay = Gross Pay – Tax Deductions.

Practical 4
1.	 Develop the mark sheet of the terminal examinations and calculate the total, percentage 

of the students following the standard format of your school and curriculum.

2.	 Create an excel worksheet for generation of balance sheet, bills, ledger and so on. 

Microsoft Powerpoint
1.	 To be familiarize with PowerPoint windows features such as quick access toolbar, 

title bar, file tab, Thumbnail Slide. Title Placeholder, Subtitle Placeholder, Status bar, 
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Ribbon, Collapse, Work Area View Options, etc.

2.	 To be familiarize with design theme, Text, add ne slide, editing techniques, view 
modes for editing, edit bulleted list, add pictures, slide masters, 

3.	 To be familiarize with edit slide master, format slide, replace font, format text, format 
placeholder, change bullets, change theme, modify theme, add footer, etc.

4.	 To be familiarize with Transition and Animation (Slide Transition, Text Animation,) 
Slide illustrations and Shapes (graphics, sound, and motions), create shapes, slide 
show (Lunch slide show, navigation slide show),etc. 

5.	 Follow the above fundamental skills and get topic from your teacher and make a 
presentation slide. 
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6.1	 Introduction of Computer Network Data Communication
The process of transferring data or information between among computers is called 
data communications.

Telecommunication

Telecommunication refers to all types of data transmission like characters, numerical, 
photos, audios and videos etc. using electronic or light emitting media.

6.1.1	Computer Network
A computer network is a logical or physical inter connection between two or more 
computers in such a way that people could communicate with each other. It is used 
to provide users with the access to share resources. These shared resources include 
data files, application software and hardware.

Components of Computer Network

	Computer

	Transmission media

	Network software.

	Protocols.

	Networking cables. (Transmission media)

Advantages of Computer Network

	It ensures resources data software and hardware can be shared.

	It provides faster & cheaper communication and data transmission.

	It provides as the tools for e-mail, teleconferencing, video conferencing for 
communication.

	Flexible working condition.

	Office automation can be made very effective and well managed.

Unit 6 Computer Network and Topologies
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Disadvantages of Computer Network

	High installation and administrative cost

	Attack on the privacy of the people

	Computer virus spread most easily through network.

	Technologically is very complicated.

	If the server is out of order, then all workstations are hang up.

	Well trained technical support is required.

6.2	 Modes of Transmissions
The manner in which data are transmitted from one location to another is called data 
transmission mode. There are two ways or modes for data transmitting from one 
location to another. These are:

1.	 Simplex Mode: Simplex is one-way data transmission that takes place only 
from sender to receiver. An example of this would be a television that allows 
the signal to pass in only one direction. Computer network connections do not 
use simplex.

2.	 Duplex Mode: Duplex is two-way data transmission that takes place both 
directions over a communication channel. Computer uses duplex channel. For 
example, if computer A and computer B are connected together and then both 
computer can share data or information. From computer A to computer B or 
computer B to computer A.

Types of Duplex Mode

i)	 Half Duplex: Half duplex is two-way data transmission that takes place in 
only one direction at a time

ii)	 Full Duplex: Full duplex is two-way data transmission that takes place in both 
directions at a time.
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6.3	 Communication Channels
The media that are used to transfer data between the computers in the networks are 
called transmission media or communication channels. There are two types of media 
used in the network. They are:

1.	 Wired or cable media (guided media)

2.	 Wireless media (unguided media)

6.3.1	Wired or Cables (Guided Media)
Cables are the most common transmission media. Two or more devices are connected 
directly using cables. Three types of cables in computer networking they are :

1.	 Twisted Pair Cable

	 Twisted copper cables are used only for lower bandwidth. It consists of two 
isolated strands of copper wire twisted around each other. There are two types 
of twisted pair cables they are as follows:

2.	 UTP (Unshielded Twisted Pair)

	 UTP cables does not have metal shield except plastic coating. It contains 
number of twisted pairs of wires with a simple plastic casing. It is commonly 
used for LAN and Telephony. It is cheaper and easier to work with, but do not 
offer high bandwidth and good protection from interferences. It can support 
data transmission rates from 10 to 100 mbps.

3.	 STP (Shielded Twisted Pair)

	 STP is similar to UTP but it is shielded with metal sheath along with plastic 
coating. It offers high bandwidth and good protection from interferences. It is 
cheaper than fiber optic cable. It can support data transmission rates from 10 
to 500 mbps

Twisted pair cable
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4.	 Co- axial Cable

	 A co-axial cable carries higher bandwidth than twisted pair, it is easy to connect. 
It does not bend readily. This cable consists of one or more small cables in a 
protective covering. It offers very high data transfer rate and can be placed 
underground and laid on the floors of lakes and oceans.

5.	 Fiber Optic Cable

	 Fiber optic cable is a thin filament of glass fiber wrapped in a protective jacket. 
It consists of strands of glass like thread, each about the diameter of a human 
hair. It offers high-speed data transmission rate because data travel as high-
speed pulses of light.

6.3.2	Wireless (Unguided Media)
Wireless (Unguided Media) is used to transfer data with in a large geographical 
areas or globally without the use of interconnecting wires or cables. It uses other 
components such as radio signals, microwaves, or infrared to connect network.

Types of Wireless Communication

1.	 Microwave Systems: Microwave signals are similar to radio and television signals 
and are used to transmit data through the space without the use of cable. It provides 
high-speed data transmission. These signals cannot bend or pass obstacles like hills 
and tall buildings, so very high towers are used to mount the signals. The transmission 
is limited about 30 miles. Chain of towers is required to transmit the microwave 
signals in a long distance

2.	 Satellite Communication: Both microwaves signals and telephone signals can be 
relayed to a earth station for transmission to a communication satellite. The earth 
station consists of a satellite dish that functions as an antenna a communication 
equipment to transmit and receive data from satellite passing overhead. It is not 
disturbed by hills and tall buildings and visible from any point. So sender and 
receiver easily communicate with each other using antenna by aiming the satellite. It 
is very expensive for placing satellite along the earth orbit.

6.3.3	Serial and Parallel Communication
•	 Data can be transmitted between a sender and a receiver in two main ways: serial 

and parallel.

•	 Serial communication is the method of transferring one bit at a time through a 
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medium.

•	 Parallel communication is the method of transferring blocks, eg: BYTEs, of data 
at the same time.

Comparison Chart
BASIS FOR 

COMPARISON
SERIAL TRANSMISSION PARALLEL 

TRANSMISSION
Meaning Data flows in bi-direction, bit 

by bit
Multiple lines are used to send 
data i.e. 8 bits or 1 byte at a 
time

Cost Economical Expensive

Bits transferred at 1 
clock pulse

1 bit 8 bits or 1 byte

Speed Slow Fast

Applications Used for long distance 
communication. Eg, 
Computer to computer

Short distance. Eg, computer to 
printer

6.4	 Modem
The word "modem" is a contraction of the words modulator-demodulator. A modem 
is typically used to send digital data over a phone line.

The sending modem modulates the data into a signal that is compatible with the 
phone line, and the receiving modem demodulates the signal back into digital data. 
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Wireless modems convert digital data into radio signals and back.

A modem is a network device that both modulates and demodulates analog carrier 
signals (called sine waves) for encoding and decoding digital information for 
processing. Modems accomplish both of these tasks simultaneously and, for this 
reason, the term modem is a combination of “modulate” and “demodulate.”

6.5	 Types of Network
On the basis of size, physical and geographical division, computer network can be 
categorized into three types. They are:

6.5.1	Local Area Network (LAN)

The way of connecting two or more computers in a very limited area (about 100 to 
300 meters) or within a same building or a group of adjacent building is called LAN. 
It enables very high speed communication through wire connection or wireless 
connection some times. Small organizations prefer it because of less expensive and 
faster communication.

6.5.2	Metropolitan Area Network (MAN)

The way of connecting computers inside a metropolitan area is called MAN. The 
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area may be a part of city, whole part of city, district, zone or country. Radio wave 
is used to transmit the data for communication between the workstation and server 
in the system. Many different systems of networking and computing are brought 
together to form a MAN.

6.5.3	Wide Area Network (WAN)
The connection of computers of networks covering more distance or the world by the 
help of wave, frequency and satellite is called WAN. Different types of LAN and 
MAN are connected to form a WAN. It covers more area but it is slower than LAN 
and MAN. Examples - satellite communication, internet etc.

MAN
6.5.4	 Internet

The internet is worldwide collection of computer networks and gateways that use 
TCP/IP suite of protocols to communicate with one another using telephone lines 
modems or satellites. Internet is network of networks. At the heart of the internet is 
a backbone of high speed data communication lines between major nodes or host 
computers, consisting of thousands of commercial governmental, educational and 
other computer system, that route data and messages.

6.5.5	Topologies
Network topology is the interconnected pattern of network elements. A network 
topology may be physical, mapping hardware configuration, or logical, mapping the 
path that the data must take in order to travel around the network.

Types of Network Topology

Network Topology is the schematic description of a network arrangement, connecting 
various nodes (sender and receiver) through lines of connection.
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6.5.5.1	BUS Topology
Bus topology is a network type in which every computer and network device is 
connected to single cable. When it has exactly two endpoints, then it is called 
Linear Bus topology.

Advantages of Bus Topology

1.	 It is cost effective.

2.	 Cable required is least compared to other network topology.

3.	 It is used in small networks.

4.	 It is easy to understand.

5.	 It is easy to expand joining two cables together.

Disadvantages of Bus Topology

1.	 When cables fail whole network fails.

2.	 If network traffic is heavy or nodes are more, the performance of the network 
decreases.

3.	 Cable has a limited length.

4.	 It is slower than the ring topology.

6.5.5.2	RING Topology
It is called ring topology because it forms a ring as each computer is connected to 
another computer, with the last one connected to the first. Exactly two neighbors for 
each device.
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Advantages of Ring Topology

1.	 Transmitting network is not affected by high traffic or by adding more nodes, as only 
the nodes having tokens can transmit data.

2.	 Cheap to install and expand

Disadvantages of Ring Topology

1.	 Troubleshooting is difficult in ring topology.

2.	 Adding or deleting the computers disturbs the network activity.

3.	 Failure of one computer disturbs the whole network.

6.5.5.3	STAR Topology
In this type of topology all the computers are connected to a single hub through a 
cable. This hub is the central node and all others nodes are connected to the central 
node.

Advantages of Star Topology

1.	 Fast performance with few nodes and low network traffic

2.	 Hub can be upgraded easily

3.	 Easy to troubleshoot

4.	 Easy to setup and modify

5.	 Only that node is affected which has failed, rest of the nodes can work  smoothly.

Disadvantages of Star Topology

1.	 Cost of installation is high.

2.	 Expensive to use.

3.	 If the hub fails, the whole network stops because all the nodes depend on the hub.

4.	 Performance is based on the hub that depends on its capacity
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6.5.5.4 MESH Topology
It is a point-to-point connection to other nodes or devices. All the network nodes 
are connected to each other. Mesh has n(n-1)/2 physical channels to link n devices.

Advantages of Mesh Topology

1.	 Each connection can carry its own data load.

2.	 It is robust.

3.	 Fault is diagnosed easily.

4.	 It provides security and privacy.

Disadvantages of Mesh Topology

1.	 Installation and configuration is difficult.

2.	 Cabling cost is more.

3.	 Bulk wiring is required.

6.5.5.5 TREE Topology
It has a root node and all other nodes are connected to it forming a hierarchy. It is 
also called hierarchical topology. It should at least have three levels to the hierarchy.

Advantages of Tree Topology

1.	 Extension of bus and star topologies

2.	 Expansion of nodes is possible and easy.

3.	 Easily managed and maintained

4.	 Error detection is easily done.
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Disadvantages of Tree Topology

•	 Heavily cabled

•	 Costly

•	 If more nodes are added, maintenance is difficult.

•	 If central hub fails, network fails.

4.6.	 Different Network Component
1.	 MODEM: Modem is a device that directly converts digital signal from 

a computer or other digital devices into analog form for transmission over 
analog link i.e telephone line and vice versa. MODEM stands for Modulation 
and Demodulation. There are two types of modem used in computer they are 
as follows:

a.	 Internal modem

b.	 External modem.

2.	 NIC: It is a Network Interface Card, which connects each computer to the 
wiring to the network. A NIC is a circuit board that fits in one of the computer’s 
expansion slots. It provides a port on the back of the computer to connect in 
the network.

3.	 Hub: Hubs are connectivity devices, which contain multiple ports for 
connecting to network components. Hubs connect the computers in a star 
topology. It lies between server and clients computers.

4.	 Connector: Bridge and Gateway are the two different connectors, which play 
role to link between two network systems.

a.	 Bridge: Bridge connects networks using same communications protocols or 
similar networks so that information can be passed from one to the other.

b.	 Gateway: Gateway connects networks using different communications 
protocols or dissimilar networks so that information can be passed from one 
to the other.

5.	 Switch: A device that is capable of forwarding packets directly to the ports 
associated with particular network addresses. Hubs and switches are almost 
same but switch is new technology and intelligent compare to hub.

6.	 Repeater: A device used on communications circuits that decrees distortion 
by amplifying or regenerating a signals so that it can be transmitted onward in 
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its original strength and form as they pass through a network cable.

7.	 Protocols: Protocols are the set of rules and formats for sending and receiving 
data. It works as guidelines to govern the exchange between equipment. There 
are different types of protocols that we can use. Some of popular protocols are 
TCP/IP, HTTP, FTP, IPX/SPX.

8.	 Router: A router is a device that is used to connect different LAN in the 
network. It receives transmitted messages and forwards them their correct 
destinations over most efficient available route.

NOS: The operating System which can support network environment, is called Network 
Operating System. For example, Windows XP, 2000, server, unix, linux, Novel 
Netware etc.

Types of Network Architecture

1.	 Client Server

This is old model of computer network. In this kind of network model one main 
computer equipped with very powerful processor, large memory and network 
operating system works as a main computer or service provider. Other computers 
connected with server, which are also called workstation or node or terminals can 
use the hardware and software resources of server computer. There are different 
types of server such as file server, print server, network server or email server.

Advantages of Client Server Network

•	 It works with any size or physical layout of LAN.

•	 It does not tend to slow down with heavy use.

•	 The network can be expanded to any size as we wish.

•	 It provides very high level security

•	 It reduces software installation time and cost to all computers.

Disadvantages of Client Server Network

•	 It is very difficult to setup and well trained technicians are required to handle and 
setup.

•	 It is expensive compared to peer to peer network.

•	 All software and operating systems are installed in server computer so that  other 
client computer has to depend on it.
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2.	 Peer to Peer

It is also called workgroups. Because all computers in the network have equal 
responsibilities. All computers in the network have access to at least one or more 
computers. It mostly used in LAN and every organization, research centers such as 
banks, travel agencies, airlines educational institutions etc.

Advantages of Peer to Peer Network

•	 It is easy to setup.

•	 Users in each computer can determine the resources to be shared among other 
computers.

•	 Any required software can be installed on individual computers; they don’t have 
to depend on the server.

•	 It is suitable at home, office, banks and small organization.

•	 It is cheaper compared to client server network.
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Disadvantages of Peer to Peer Network

•	 It is slow because of heavy load.

•	 It is suitable for limited area such as school offices and small organization.

•	 The network expansion is limited and cannot be expanded as per wish.

•	 It has limited security level.

Some Terminologies 

Band width: The amount of data which is sent through a data-transmitting medium, such 
as a computer network, telephone line, or coaxial cable, in a given amount of time is called 
band width.

Bits: In computer processing and storage, a bit is the smallest unit of information handled 
by a computer and is represented physically by an element such as a single pulse sent 
through a circuit or a small spot on a magnetic disk capable of storing either a 1 or a 0.

Modulation: The process of changing some characteristics (amplitude, frequency or phase) 
of carrier wave in accordance with the intensity of the signal is known as modulation.

6.7	 Use of Communication in daily life
1.	 It is an Exchange of Ideas

	 Communication is the process through which an exchange of information 
takes place. It is the sharing of information, ideas, concepts and messages.

2.	 Two Parties are Involved in it

	 In communication, the exchange of information takes place between two or 
more persons. This implies that there are minimum two people involved in the 
communication process at any given time.

	 The one who initiates the exchange is the sender of the message (speaker/
writer) and the one who receives and interprets it is the receiver of the message 
(listener/reader).

3.	 It is a Two-way Process

	 Communication is a two-way process of exchanging ideas or information. 
One person alone cannot carry out communication. When you communicate, 
there has to be a receiver or an audience that would reciprocate. Then only 
your communication can be complete.
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	 Thus, communication is a process of transmitting and receiving verbal and 
non- verbal messages. It is considered effective only when it achieves the 
desired reaction or response from the receiver. The response may be positive 
or negative. In case of absence of any response, communication is incomplete.

	 Thus, communication is effective only when a concise and clear message 
is delivered well, received successfully, understood fully, and responded to 
promptly.
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Exercise

Choose the correct answer from the given alternatives.
1.	 Physical or logical arrangements of network is ………

a. Topology	 b. Routing	 c. Networking	 d. Control

2.	 Data communication system spanning states, countries, or the whole world is….

a. LAN	 b. WAN	 c. MAN	 d. PAN

3.	 WAN Stands for……….

a. World area network	 b. Wide area network

c. Web area network	 d. Web access network

4.	 …….. topology requires a multipoint connection.

a. Star	 b. Mesh	 c. Ring	 d. Bus

5.	 Example of analog modulation techniques.................

a. Frequently type modulation FM	 b. Amplitude type modulation AM

c. Both a and b		  d. None

6.	 The ……is the physical path by which a message travels from sender to receiver

a. Protocol		  b. Message

c. Transmission medium	 d. Sender

7.	 The ……. is the information (data) to be communicated.

a. Protocol	 b. Message	 c. Medium	 d. Sender

8.	 WANs are configured using the……..or the…….topology.

a. Bus, Tree	 b. Mesh, Ring	 c. Ring, Hybrid	 d. Mesh, Tree

9.	 The Tree structure starts with a ….. node.

a. Prime	 b. Chief	 c. Beginner	 d. Header

10.	 Mesh topology is highly reliable..............

a. Than other network topologies	 b. Ring topology
c. Star topology		  d. Bus topology
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Write short answer to the following questions. 
1.	 Define Metropolitan Area Network.

2.	 Which is the fastest media in which data are transmitted according to the speed of 
light?

3.	 List components of data communication.

4.	 Write example of LAN, MAN and WAN.

5.	 Differentiate between simplex and duplex mode of communication.

6.	 Define LAN and WAN.

7.	 What are advantages of computer networking?

8.	 Differentiate between star and ring topology.

9.	 Draw Bus topology and explain.

10.	 Explain the use of communication in our daily life.

11.	 What is data transmission mode?

12.	 What is Merits of Ring topology?

13.	 Which Network topology is suitable for your town? Why?

14.	 Why wire based networks more secure than wireless?

15.	 Why is Dull duplex mode communication is considered as best mode?

16.	  Why is MODEM required in computer networks?

17.	 Explain the use of communication in our daily life.

Write long answer to the following questions.
1.	 Explain different services provided by computer networks.

2.	 Explain different types of topologies with their merits and demerits.

3.	 Define computer network? Explain the types of computer networks. 

Project Work
1.	 Install and Configure Windows NT operating system in a PC. 

2.	 Construct network by connecting one or two computer with a Windows NT Server. 

3.	 Disassemble PC. Access and Change BIOS settings Learn the various types of 
cabling: Straight Through Cable, Cross Cable and Rollover Cable.
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7.1	 Introduction of Internet
The internet is worldwide collection of computer networks and gateways that use 
TCP/IP suite of protocols to communicate with one another using telephone lines 
modems or satellites. Internet is network of networks. At the heart of the internet is 
a backbone of high speed data communication lines between major nodes or host 
computers, consisting of thousands of commercial governmental, educational and 
other computer system, that route data and messages.

Equipment Used in Internet/Components Required to use Internet

•	 A set of computer

•	 A modem and regular telephone line or broadband internet connection.

•	 An account in ISP to access the internet host.

•	 Communication software for example: Internet Explorer,	Netscape Navigator, 
Mozilla Firefox, Opera, Google Chrome etc.

7.1.1 Use of Internet
Some of the common services provided by the internet are

•	 Electronic mail (E-Mail)

•	 Information sharing and resources.

•	 Business communication

•	 Advertising

•	 Online shopping

•	 Stock trading

•	 Discussion and chat

•	 E-banking

•	 Virtual library

Unit 7Internet and Electronic mail (Email)
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1.	 E-Mail: E-mail stands for electronic mail. It is most widely used feature on the 
internet. Sending and receiving messages electronically through the internet 
is called E-mail. We can exchange any message with the people around the 
world by using e-mail. It is very easy and quick means of communication 
available in the computer world. We can write an e-mail message in an mail 
program like Eudora, Outlook Express, Netscape Navigator etc. and several 
web base program like Yahoomail, Hotmail, Gmail and Zapakmail.

	 E-mail address: An email address is a unique identifier that is used to send 
and receive electronic messages over the internet. Every address has two parts 
that are separated by an “@” symbol. Each E-mail address is identified by 
a unique name is called E- mail address. For example sarthak@yahoo.com, 
swrikrit@fewanet.com.np, etc. It has five parts they are as follows:

•	 sarthak/swrikrit : User’s name

•	 @ (At the rate) : A separator symbol

•	 yahoo, fewanet : ISP address or domain name

•	 .com or .edu or .net : commercial or educational groups

•	 .np : Country code

Advantages of Using E-mail

•	 It is t h e  cheapest and fastest means of communication compared to our 
conventional postal mail.

•	 It is more reliable than postal mail.

•	 E-mail can be accessed from any part of the world and at any time.

•	 Information can be shared globally.

•	 We can send photos, songs, video clips and other file with e-mail attachments.

•	 A single mail can be sent to multiple people at a time.

7.2	 Protocol 
In information technology, a protocol is the special set of rules that end points in 
a telecommunication connection use when they communicate. Protocols specify 
interactions between the communicating entities.
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Bottom of Form

Protocols exist at several levels in a telecommunication connection. For example, 
there are protocols for the data interchange at the hardware device level and protocols 
for data interchange at the application program level. In the standard model known as 
Open Systems Interconnection (OSI), there are one or more protocols at each layer in the 
telecommunication exchange that both ends of the exchange must recognize and observe. 
Protocols are often described in an industry or international standard.

7.2.1	Transmission Control Protocol (TCP/IP)
TCP (Transmission Control Protocol) is a standard that defines how to establish 
and maintain a network conversation via which application programs can exchange 
data. TCP works with the Internet Protocol (IP), which defines how computers send 
packets of data to each other. Together, TCP and IP are the basic rules defining 
the Internet. TCP is defined by the Internet Engineering Task Force (IETF) in the 
Request for Comment (RFC) standards document number 793.

7.2.2	Hypertext Transfer Protocol (HTTP)
HTTP (Hypertext Transfer Protocol) is the set of rules for transferring files (text, 
graphic images, sound, video, and other multimedia files) on the World Wide Web. 
As soon as a Web user opens their Web browser, the user is indirectly making use 
of HTTP. HTTP is an application protocol that runs on top of the TCP/IP suite of 
protocols (the foundation protocols for the Internet).

7.2.3	File Transfer Protocol (FTP)
File Transfer Protocol (FTP) is a standard Internet protocol for transmitting files 
between computers on the Internet over TCP/IP connections.

7.2.4	Terminal Network (Telnet)
Telnet is a protocol used on the Internet or local area network to provide a bidirectional   
interactive   text-oriented   communication   facility   using   a virtual terminal 
connection. User data is interspersed in-band with Telnet control information in an 
8-bit byte oriented data connection over the Transmission Control Protocol (TCP)

7.2.5	Simple Mail Transfer Protocol (SMTP)
SMTP (Simple Mail Transfer Protocol) is a TCP/IP protocol used in sending and 
receiving e-mail. However, since it is limited in its ability to queue messages at the 
receiving end, it is usually used with one of two other protocols, POP3 or IMAP, that 
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let the user save messages in a server mailbox and download them periodically from 
the server.

7.2.6	POP (Post Office Protocol)
	 POP is short for Post Office Protocol, a protocol used to retrieve e-mail from a 

mail server. Most e-mail applications (sometimes called an e-mail client) use 
the POP protocol, although some can use the newer IMAP (Internet Message 
Access Protocol).

7.3	 The Web
The World Wide Web (WWW), also called the Web, is an information space where 
documents and other web resources are identified by Uniform Resource

Locators (URLs), interlinked by hypertext links, and accessible via the Internet. 
English scientist Tim Berners-Lee invented the World Wide Web in 1989. He wrote 
the first web browser in 1990 while employed at CERN in Switzerland.

Advantages of www

•	 A link in a web document can be used to open other documents.

•	 Web pages can contain pictures, buttons and even links to sound files in 
addition to text, thus allowing multimedia applications.

•	 Sophisticated web document allows users to interact with applications through 
dialog boxes and forms.

Web Server

Web server is a site on which the web pages are kept. It is a server computer that responds 
to requests from web browsers to relative resources.

Browser

Browser is client software that allows the users to display and interact with the web page. 
For example: Internet Explorer, Netscape Navigator, Mozilla Firefox or Opera etc.

Web Pages

Web page is a collection of information that is stored in website. The www consists of 
huge collection of documents with related website called webpage. Web page provides vast 
collection of information of related websites.
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Website

Website is a location of the web pages created by any organizations, universities and 
government agencies to provide information regarding them like: http://www.bbc.co.uk/
nepali, http://www.nepalnews.com etc. Each website has its own address that is also called 
internet address.

Domain Name System (DNS)

The domain name system (DNS) is the way that internet domain names are located and 
translated into internet protocol (IP) addresses. The domain name system maps the name 
people use to locate a website to the IP address that a computer uses to locate a website. For 
example, if someone types TechTarget.com into a web browser, a server behind the scenes 
will map that name to the IP address 206.19.49.149. It is a name of specific internet area 
controlled by any organization, company or government.

Home Page

The home page is the first hypertext document regarding the web address displayed when a 
user connects to any web server.

Uniform Resource Locator (URL)

A uniform resource locator (URL) is the address of a resource on the Internet. A URL 
indicates the location of a resource as well as the protocol used to access it.

A URL contains the following information:

•	 The protocol used to access the resource

•	 The location of the server (whether by IP address or domain name)

•	 The port number on the server (optional)

•	 The location of the resource in the directory structure of the server

•	 A fragment identifier (optional)

Also known as a Universal Resource Locator (URL) or Web address. A URL is a type of 
uniform resource identifier (URI). In common practice, the term URI isn't used, or is used 
synonymously with URL, even though this is technically incorrect.

ISP ( Internet Service Provider)

A company that provides individuals or companies access to the Internet and the World 
Wide Web is called ISP. An internet service provider provides internet to the users. ISPs 
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can provide this access through multiple means, including dial-up, DSL, cable, wireless 
and fiber-optic connections.

Firewall

Software or hardware that limits the certain kinds of access to a computer from the internal 
network or external network. In other words, a firewall is a network security device that 
monitors incoming and outgoing network traffic and decides whether to allow or block 
specific traffic based on a defined set of security rules.

7.4	 Search Engine
Search engines are programs that search documents for specified keywords and 
returns a list of the documents where the keywords were found. A search engine is 
really a general class of programs; however, the term is often used to specifically 
describe systems like Google, Bing and Yahoo! Search that enable users to search for 
documents on the World Wide Web.

Web Search Engines

Typically, Web search engines work by sending out a spider to fetch as many documents 
as possible. Another program, called an indexer, then reads these documents and creates 
an index based on the words contained in each document. Each search engine uses a 
proprietary algorithm to create its indices such that, ideally, only meaningful results are 
returned for each query.
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Exercise

Choose the correct answer from the given alternatives.
1.	 What is the internet?

a. Programming language

b. Networking connecting all over the world

c. Computer program to transfer data 

d. All of these

2.	 What does e-mail stand for?

a. Electrical mail		  b. Electronic messaging service 

c. Electronic mail		  d. All of these

3.	 What does FTP stand for?

a. Folder Text Protocol	 b .File Transfer  Push

c. Fixed Terminology placement	 d. File Transfer Protocol

4.	 The World Wide Web (www) was invented by……..

a. Steve Jobs		  b. Tim Berners Lee

c.Ray Tomliners		  d.ALL of these

5.	 The address of a website is also known as...............

a. Location	 b. Mail id	 c. URL	 d.None of these

6.	 What does “S” in HTTPS stand for?

a. Selected	 b. Secure	 c. Software	 d. System

7.	 Which of the following is correct email address?

a. username@website@com	 b. username.website.com

c. username.website@com	 d. username@website.com

8.	 What does ISP stands for?

a. Internet security platform	 b. Internet service provider

c. Internet service processor	 d. None of these
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9.	 Which folder contains junk emails?

a. Inbox	 b. Unwanted	 c. Spam	 d. None of these

10.	 What does IP stand for?

a. Internet Process		  b. Instant processing

c. Internet Protocol		 d. Information program

Write short answer to the following questions. 
1.	 What is meant by E-mail?

2.	 Give two-two examples of web browser and search engine.

3.	 List the advantages of internet.

4.	 Define URL with its part.

5.	 Write the names four search engine names.

6.	 Explain DNS and ISP.

7.	 Why is domain name is required?

8.	 What is web browser?

9.	 Differentiate between web page and web site.

10.	 What is called network of network?

11.	 Mention advantages of e-mails.

12.	 List services of internet.

Write long answer to the following questions.
1.	 Differentiate between e-mail and e- fax. Define protocol. Explain different protocol.

2.	 List out the services provided by the internet. Explain briefly.

3.	 How does Internet make the communication simple and cheap? Describe in your 
own words.

Project Work
1.	 Browse Internet using Search Engines like Google. com, Yahoo.com and ask.com for 

files, pictures, power point presentations etc. Downloading files, EBooks, EContent 
from Internet. 

2.	 Register for new Email address with any free Email provider and send Email using 
Internet to your friends, parents, teachers etc. 
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3.	 Configure the network for an Internet server. 

4.	 Add / Remove devices using Hardware Wizard. Add and Manage User Profile, Set 
permission to the users in Windows NT .
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